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Vorwort

EndNote ist ein Literaturverwaltungsprogramm, das Forschern 
und Wissenschaftlern eine einfache Unterstützung von der 
Recherche bis zur Publikation bietet. Es ist seit vielen Jahren 
international in der Wirtschaft und Wissenschaft etabliert. Durch 
seine Verbreitung ist es eine ideale Plattform für den Informati-
onsaustausch und für die Zusammenarbeit. 

Die Idee zu einem Handbuch „Informationsmanagement mit 
EndNote“ entstand aus den umfangreichen Schulungsaktivitäten 
der Universitätsbibliothek Heidelberg. Einführungen in EndNote 
sind dort schon seit Jahren ein fester Bestandteil des modularen 
Schulungsangebots zur Vermittlung von Informationskompetenz. 
Die Firma Adept Scientific GmbH griff diese Idee auf und unter-
stützte die Realisierung dieses Handbuchs sowohl finanziell als 
auch durch Einbringung ihrer eigenen umfangreichen Schu-
lungs- und Betreuungserfahrungen. 

Die Grundlage und Bezugspunkte für die Konzeption dieses 
Handbuchs bilden konkrete Situationen von Studierenden oder 
Wissenschaftlern, also Fragen der Informationsbeschaffung, 
-verwaltung und -weiternutzung. Darauf abgestimmt erfolgt die 
Darstellung der technischen Funktionen  von EndNote. Die 
Darstellung der EndNote-Funktionen folgt nicht einem EDV-tech-
nischen Schema, sondern einem pragmatischen, didaktisch 
orientierten Konzept. Entsprechend diesem Ansatz werden hier 
auch nicht alle technischen Funktionsdetails vorgestellt. Statt-
dessen wird an entsprechenden Stellen auf die englischspra-
chige EndNote-Dokumentation verwiesen. 

Ein wesentliches Merkmal des hier realisierten Konzepts ist die 
Integration von ergänzenden Screen Videos und Hyperlinks, die 
in der Online-Version zusätzliche Nutzungsoptionen eröffnen. 
Insbesondere die Screen Videos erleichtern das Verständnis der 
Handlungsschritte bei der Nutzung einzelner EndNote-Funkti-
onen. 

Dieses Handbuch ist das Ergebnis einer intensiven Kooperation 
der hier als Autoren fungierenden Personen. Aber ohne die inten-
sive Mitarbeit insbesondere von Christiane Hirschberg und der 
Unterstützung von Birgit Bauer, Falko Schumacher, Tobias 
Praetsch, Martina Trognitz und Perke Fiedler wäre die Fertigstel-
lung dieses Handbuchs nicht möglich gewesen. 

Ilja Kalinin
Benno Homann 
Mathias Krummheuer
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Einleitung

In dieser Einleitung wird an die neuen Anforderungen beim 
Studieren angeknüpft. Darauf basierend werden die Merkmale 
und Potentiale des Informationsmanagements skizziert und ein 
Überblick über den Nutzen von EndNote für ein effizientes Infor-
mationsmanagement sowie die Konzeption des Buches 
gegeben.

Informationsvielfalt als Herausforderung des wissen-
schaftlichen Arbeitens

Das Studium bietet viel Interessantes und viel Neues. Endlich 
darf man sich intensiver mit den Erkenntnissen und Methoden 
eines Faches befassen. Die Literaturlisten in den Einführungs-
veranstaltungen sind beeindruckend umfangreich. Die Hoch-
schulbibliotheken bieten viel mehr als die bisher genutzten 
Schul- oder Stadtbibliotheken. Auch viele bisher nicht bekannte 
Informationsangebote im Internet, vor allem Online-Zeitschriften 
und E-Books, können nun genutzt werden. Der Studentenaus-
weis und die Bibliothekskennungen sind der Schlüssel zu einer 
neuen schier unbegrenzten Informationsfülle. 

Das Angebot muss jedoch bewältigt werden. Eine Orientierung 
bieten die Literaturlisten der Dozenten. Schon allein das Finden 
und die Nutzung der angegebenen Literatur kann schwierig sein, 
denn die Bibliotheksgebäude sind riesig, der Bibliothekskatalog 
anders als Google, die Bücher oder Zeitschriften häufig ausge-
liehen, der Zugang zu Online-Dokumenten mit Passwörtern 
versperrt und die Zeit knapp. Hinzu kommt, dass die Literatur 
auch noch gelesen und in irgendeiner Weise der Inhalt erfasst 
werden soll. Kopien und das Ausdrucken von PDF-Dateien sind 
erst mal eine Beruhigung; Zeit wird sich noch finden zum Lesen; 
ein paar Notizen sind ja auch schon gemacht und in Word 
erfasst. Doch die Zeit läuft davon, eine Situation, die folgende 
Grafik veranschaulicht.
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Nicht nur die Masse, auch die Art der Informationen und die 
Anforderungen der Dozenten ändern sich. Der Hinweis auf einen 
Spiegelartikel oder eine Seite im Internet, die mit Google 
gefunden wurde, reicht plötzlich nicht mehr aus. Erwartet wird die 
Nutzung wissenschaftlicher Publikationen mit systematischen 
Angaben über genutzte Literatur oder sonstige Quellen. 

Bei Hausarbeiten wird erwartet, dass die ausgewertete Literatur 
nach bestimmten Zitierregeln und vor allem korrekt angegeben 
wird. Häufig entstehen allerdings Fehler beim Abschreiben oder 
Übertragen der Literaturzitate, was schnell zu einer schlechteren 
Note führen kann. Ärgerlich ist auch, dass fast jedes Fach und 
teilweise jeder Dozent eine andere Zitierweise wünscht. Muss die 
Literaturliste am Ende eines Dokumentes in Microsoft Word 
jedes Mal überarbeitet werden, ist das absolut ärgerlich und zeit-
aufwändig. Hier bietet EndNote eine einfache Lösung an.

Informationsmanagement als Grundlage wissen-
schaftlichen Arbeitens 

Das ständig steigende und sich immer wieder ändernde Informa-
tionsangebot und daraus resultierende Probleme lassen sich 
über ein gutes Informationsmanagement bewältigen. Gutes 
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Informationsmanagement zeichnet sich dadurch aus, dass die 
vielzähligen Informationsangebote möglichst effizient für ein 
konkretes Ziel, z.B. für die Erstellung eines Referats, einer 
wissenschaftlichen Publikation oder die Literaturerfassung in 
einer Forschungsgruppe genutzt werden. 

Gerade durch das steigende Angebot an elektronischen Publika-
tionen, die über das Internet verfügbar sind, und die hoch entwi-
ckelten Recherchefunktionen von Datenbanken und Katalogen 
können wissenschaftliche Informationen systematischer und 
schneller gesucht und vor allem auch effizienter weitergenutzt 
werden.

In allen Studienfächern hat sich das Informationsangebot durch 
die neuen Informations- und Kommunikationstechnologien in 
den letzten Jahren grundlegend verändert. Die Suche nach Infor-
mationen ist auf den ersten Blick sehr viel einfacher als früher, 
aber eine einfache Recherche mit Google allein genügt nicht den 
Anforderungen wissenschaftlichen Arbeitens. Zufallsergebnisse, 
wie sie Google bietet, müssen durch systematische Recherchen 
in Bibliothekskatalogen und einer zunehmenden Zahl unter-
schiedlicher allgemein- und fachwissenschaftlicher Datenbanken 
ergänzt werden.

Die wissenschaftlichen Informationssysteme, zu denen Kataloge 
und bibliografische Fachdatenbanken zählen, ermöglichen auf 
Grund ihrer differenzierten Suchmöglichkeiten z.B. nach 
Autoren, Titeln, Jahr und zusätzlichen wissenschaftlich 
fundierten Metainformationen, z.B. Schlagwörtern, Notationen, 
eine umfassende und gleichzeitig thematisch präzise 
Recherche. Nicht geeignete Informationen oder Dokumente 
lassen sich dabei schnell ausklammern und die relevanten Infor-
mationen können einfach für die Weiterarbeit, z.B. den Zugriff auf 
ein Online-Dokument, weitere Recherchen oder die Erfassung in 
einer eigenen Datenbank genutzt werden. 

Effektives Informationsmanagement erfordert dabei umfassende 
Kenntnisse und Fähigkeiten, wie z.B. 

• Überblick über die unterschiedlichen wissenschaftlichen Infor-
mationsangebote, z.B. bei den Datenbanken über das biblio-
thekarische Datenbankportal DBIS,

• Kenntnisse über die zusätzlichen Rechercheinstrumente in 
wissenschaftlichen Datenbanken, z.B. die Verknüpfung von 
Recherchebegriffen mit Operatoren,

• Fähigkeiten zur Bewertung und damit auch zur Selektion von 
Informationen auf Grund von Schlagwörtern in bibliografi-
schen Angaben eines Katalogs,
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• Fähigkeit zur Gliederung von Informationen nach eigenen 
oder gruppenspezifischen Anforderungen durch eigene 
Schlagwörter oder Sachgruppen,

• Fähigkeit zur Nachnutzung von gefundenen Informationen 
bzw. Daten für wissenschaftliche Arbeiten und den Austausch 
in Arbeitsgruppen.

EndNote unterstützt dich bei den oben aufgeführten Aufgaben. 
Im folgende Video ist zu sehen, wie bspw. Daten automatisch 
aus einem Katalog in EndNote übernommen und dann in einem 
Word-Dokument eingefügt und zitiert werden. Das Literaturver-
zeichnis wird automatisch nach Vorgabe bestimmter Autoren-
richtlinien  erstellt.

Die Vorteile liegen auf der Hand:

1) Schnelle Übernahme von Daten

2) Ergänzung und Strukturierung der Daten in EndNote

3) Zitation in einem Word-Dokument und automatisches 
Erstellen eines Literaturverzeichnisses.

Siehe selbst:

Einleitungsvideo: Überblick über Literaturverwaltung mit EndNote – eine Beispielan-

wendung

Informationsmanagement ist so gesehen ein Komplex methodi-
scher Fähigkeiten und Kenntnisse zur effizienten Bewältigung 
von großen Informationsmengen. Es umfasst sowohl die 
Nachnutzung fremder Daten, z.B. aus Katalogen, als auch die 
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Erstellung und Nutzung eigener Daten, die bei der Auswertung 
von Dokumenten oder Publikationen entstanden sind. Ziel eines 
Informationsmanagements ist es, einen schnellen Zugriff auf 
Dokumente und eine effiziente Weiternutzung von Informationen 
zu gewährleisten.

EndNote als Arbeitsinstrument für ein effizientes 
Informationsmanagement

Das Informationsmanagement lässt sich beträchtlich durch das 
Literaturverwaltungsprogramm EndNote erleichtern. Ursprüng-
lich sollte EndNote primär das Zitieren nach unterschiedlichen 
Zitieranforderungen bei der Erstellung wissenschaftlicher 
Arbeiten erleichtern. Daraus resultiert das umfangreiche 
Angebot unterschiedlicher Zitierstile aber auch einfacher 
Möglichkeiten der Anpassung an spezielle Anforderungen, z.B. 
Ausgabe des Titels in Großbuchstaben. 

Im Laufe der letzten 15 Jahre wurde das Funktionsspektrum von 
EndNote jedoch beträchtlich erweitert, wie aus der folgenden 
Grafik zu ersehen ist:

Der gestiegene Funktionsumfang erleichtert das wissenschaft-
liche Arbeiten beträchtlich und bietet zusätzliche Möglichkeiten 
zur individuellen aber auch gruppenbezogenen Strukturierung 
bzw. Organisation von Informationen, auf die auch in den nach-
folgenden Kapiteln eingegangen wird:

• Die Erfassung von Literaturdaten wird durch die verschie-
denen Möglichkeiten der Übernahme von recherchierten 
Daten aus bibliografischen Datenbanken erleichtert. Viele 
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wissenschaftliche Datenbanken und Kataloge können direkt 
aus EndNote heraus genutzt und die Ergebnisse sofort abge-
speichert werden. Natürlich lassen sich Literaturdaten auch 
weiterhin manuell eingeben.

• Die Organisation bzw. Strukturierung erfasster Informationen 
wird durch Gruppierungs- und inhaltliche Erschließungsfunkti-
onen beträchtlich erleichtert. Gerade bei umfangreichen 
Forschungs- und Publikationsvorhaben wird so der Überblick 
über die erfassten und ausgewerteten Informationen gewähr-
leistet, indem nach Arbeitsthemen, Informationsart, Arbeits-
stand aber auch nach Veranstaltungsthemen untergliedert 
werden kann.

• Die Verwaltung von elektronischen Dokumenten oder der 
Zugriff auf Online-Dokumenten lässt sich sehr leicht in 
EndNote integrieren und bietet insbesondere Forschungs-
gruppen Arbeitserleichterungen. 

• Für die Weiternutzung von Literaturdaten bietet EndNote 
umfangreiche Exportschnittstellen, die vor allem die Zusam-
menführung von Daten in Projekten erleichtert.

• Die Erstellung von wissenschaftlichen Publikationen oder 
auch Arbeiten im Rahmen des Studiums wird über EndNote 
sehr erleichtert. Durch die direkte Integration von EndNote in 
Textverarbeitungsprogramme, wie Microsoft Word, Open 
Office oder Pages, können Literaturangaben mit einem Klick in 
einen Text übernommen und nach unterschiedlichen Zitieran-
forderungen angezeigt bzw. ausgegeben werden.

Dieses Handbuch soll sowohl dem Studierenden zu Beginn des 
Studiums als auch dem Wissenschaftler den Zugang zu EndNote 
erleichtern, indem von bestimmten Situationen bzw. Anforde-
rungen ausgegangen wird. Ein Studierender wird sich zu Beginn 
seines Studiums – jedenfalls bei den derzeitigen Curricula – mit 
Lehrbüchern begnügen und nur selten eigene Literatur ermitteln 
müssen. Hier ist es wichtig, dass die genutzten Bücher richtig 
erfasst werden und ein Überblick bei den vielen Veranstaltungs-
themen gewahrt wird. Damit befassen sich die Kapitel 1 bis 4. In 
den höheren Semestern und bei Forschungsprojekten ist die 
Erschließung neuer Literatur und der Datenaustausch sowie die 
Beachtung spezifischer Zitierregeln und die Verwaltung von elek-
tronischen Dokumenten wichtig. Damit befassen sich die Kapitel 
5 bis 9. 

In den ersten vier Kapiteln wird an Probleme bzw. Situationen 
von Studienanfängern angeknüpft. So befasst sich das erste 
Kapitel mit der Erfassung von Literaturangaben in EndNote, 
wobei auch grundlegende Kenntnisse über unterschiedliche Lite-
ratur-/Dokumenttypen vermittelt werden. Im zweiten Kapitel 
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werden die Möglichkeiten des Datenimports aus Katalogen und 
damit eine Möglichkeit der einfacheren Erfassung von Literatur-
daten aufgezeigt, die insbesondere für Studierende in den ersten 
Semestern viel Zeit erspart. Die einfache Erfassung von Litera-
turnachweisen führt natürlich zu einem Anstieg der Datenmenge. 
Um hier einen Überblick zu bewahren, bietet EndNote einfache 
Möglichkeiten zur Strukturierung bzw. Verwaltung auch nach 
inhaltlichen Merkmalen, die im dritten Kapitel vorgestellt werden. 
Das vierte Kapitel befasst sich dann mit der Erstellung von 
wissenschaftlichen Texten, bei denen genutzte Literatur nach 
vorgegebenen Zitierstilen und -methoden anzugeben ist. Hier 
bietet EndNote durch seine Integration in Textverarbeitungspro-
gramme große Erleichterungen und einen immensen Zeitgewinn 
auch schon zu Beginn des Studiums. 

Die letzten fünf Kapitel sind primär für Studierende am Ende des 
Studiums und Wissenschaftler gedacht. So befasst sich das 
Kapitel 5 mit der Nutzung von bibliografischen Datenbanken, in 
denen wissenschaftliche Aufsätze nachgewiesen werden. Insbe-
sondere im fortgeschrittenen Studium oder in Forschungspro-
jekten sind thematische Recherchen wichtig, um umfassend, 
zuverlässig und möglichst präzise, also ohne unnötige Nieten, 
wichtige Publikationen zu einem Thema zu finden. In fast allen 
Fächern wächst das Spektrum des Datenbankangebots. Hier 
bietet EndNote umfangreiche Möglichkeiten der Recherche und 
der einfachen Übernahme ermittelter Literatur. In den anschlie-
ßenden Kapiteln 6 und 7 werden die Möglichkeiten zur Änderung 
von Zitierstilen und nützliche Instrumente zur Literaturverwaltung 
in Forschungsgruppen vorgestellt. So befasst sich Kapitel 7 mit 
der Möglichkeit, Volltexte aus EndNote heraus zu recherchieren, 
zu erfassen und zu verwalten. Insbesondere in Forschungs-
gruppen ist es wichtig, Daten auszutauschen oder spezifische 
Zitieranforderungen zu erfüllen. In diesem Zusammenhang wird 
in Kapitel 8 und 9 auch auf die Möglichkeiten der Austausche von 
lokalen EndNote-Daten mit EndNote Web eingegangen.
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Kapitel 1 – Literatur erfassen

LERNZIELE In diesem Kapitel lernst du,

 Unterschiedliche Dokumenttypen zu unterscheiden

 Die Programmoberfläche von EndNote kennen und die 
Grundfunktionen zu verwenden

 Vorhandene Referenztypen in EndNote zu nutzen

 Eigene Referenzen zum Verständnis der Arbeitsweise von 
EndNote und zur Behebung von Fehlern manuell zu erfassen

Situation

Zu Beginn deines Studiums werden dir in fast jeder Veranstal-
tung umfangreiche Literaturlisten ausgehändigt. Dadurch wirst 
du gleichzeitig mit mehreren Problemen konfrontiert: Wie kann 
man diese Literatur möglichst einfach finden und nutzen? 

Sinnvoll ist es, sie elektronisch am PC nochmals zu erfassen und 
sich dort Notizen beim Lesen zu machen. Teilweise wird dieselbe 
Literatur aber in mehreren Seminaren angegeben. Wie lassen 
sich hier Doppelarbeiten vermeiden? 

Manche Literaturangaben sind unverständlich, weil mehrere 
Autoren oder Titel angegeben sind. Was ist das denn nun? Ein 
Buch oder ein Artikel in einer Zeitschrift? 

EndNote hilft dir, alle diese Probleme zu bewältigen. Durch die 
Arbeit mit EndNote erwirbst du grundlegende Kenntnisse über 
die im wissenschaftlichen Bereich genutzten Dokumenttypen 
oder Literaturarten. Deren Kenntnis erleichtert es dir, Prioritäten 
zur Auswahl der Literatur zur Einarbeitung in ein Veranstaltungs-
thema zu setzen. Wenn du die wichtigsten Dokumenttypen 
kennst, wird es dir leichtfallen, EndNote für die elektronische 
Erfassung von Literatur zu nutzen und damit den Grundstock für 
ein effizientes Studium aufzubauen. Denn einmal erfasste Lite-
ratur, die du mit Kommentaren ergänzt, kannst du ja während 
deines ganzen Studiums und auch noch im späteren Beruf 
nutzen.

Das folgende Kapitel soll dich für unterschiedliche Arten von 
Information sensibilisieren. Du lernst, den Nutzen bestimmter 
Dokumenttypen für dein Studium zu bewerten. Auf diese Weise 
gestaltest du den Prozess der Informationsfindung bewusst und 
zielgerichtet.
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Dokumenttypen unterscheiden
Während des Studiums kommen unterschiedliche Dokument-
typen, auch Literaturarten oder Publikationstypen genannt, zum 
Einsatz. Einige Dokumenttypen kennst du sicherlich schon: z.B. 
Zeitschriften, Zeitungen oder Bücher. Letztere lassen sich 
wiederum unterscheiden, etwa in Monografien oder Aufsatz-
sammlungen/Sammelbände. Je nach dem, was du studierst und 
in welcher Phase des Studiums du dich befindest, werden 
bestimmte Dokumenttypen besonders häufig verwendet.

Merke: Die Kenntnis der Dokumenttypen ist wichtig, um nach 
unterschiedlichen Arten von Informationen gezielt recherchieren 
und diese richtig zitieren zu können. Jeder Dokumenttyp verlangt 
nämlich nach einer bestimmten Zitierweise. Ein guter Überblick 
über die in deiner akademischen Disziplin üblichen Dokument-
typen hilft dir außerdem, dich in deinem Studienfach besser 
zurechtzufinden.

Lexika und Handbücher Lexika und Handbücher eignen sich gut, um sich einen Überblick 
über ein Thema zu verschaffen, unbekannte Begriffe zu klären 
oder weiterführende Literaturhinweise zu erhalten. Lexika 
zeichnen sich durch hohe wissenschaftliche Qualität aus. 

Es gibt allgemeine (z.B. Brockhaus) und fachspezifische Lexika 
(z.B. Oxford Handbooks in Political Science oder Kleines Lexikon 
der Politik). Letztere sind besonders nützlich für die Erarbeitung 
der Begrifflichkeiten eines Fachs und für die Einarbeitung in ein 
neues Thema. 

Übung: 

Wir haben für dich auf den folgenden Seiten eine exemplari-
sche Zusammenstellung politikwissenschaftlich relevanter 
Dokumenttypen erstellt und mit kurzen Erläuterungen 
versehen. Falls du ein anderes Fach studierst, kannst du dir 
parallel dazu überlegen, ob der jeweilige Dokumenttyp auch 
für deine Disziplin wichtig ist. Notiere dir außerdem Dokument-
typen, die in der Liste nicht auftauchen, die jedoch für dein 
Fach relevant sind. 



Kapitel 1 – Literatur erfassen

19

Tipp: Mindestens zwei Lexika oder Handbücher nutzen, weil 
jeder Autor ausgehend von seiner Perspektive einen anderen 
Schwerpunkt setzt oder mehr oder weniger ausführlich ist.

Lehrbücher Lehrbücher führen systematisch und didaktisch aufbereitet in ein 
Fach oder einen Teilbereich des Fachs ein.

Monografien Anders als in Lehrbüchern, wird in einer Monografie nicht eine 
komplette Teildisziplin behandelt, sondern eine spezifische 
Fragestellung oder ein spezielles Thema. Monografien sind 
besonders bei der Bearbeitung spezieller Themen zu empfehlen. 

Beispiele: 

• Schmidt, Manfred G.: Demokratietheorien. Eine Einführung

• Beyme, Klaus von: Das politische System der Bundesrepu-
blik Deutschland

• Patzelt, Werner J.: Einführung in die Politikwissenschaft

Beispiele: 

• Hacke, Christian: Die Außenpolitik der Bundesrepublik 
Deutschland

• Braun, Dietmar: Theorien rationalen Handelns in der Politik-
wissenschaft

• Rawls, John: Eine Theorie der Gerechtigkeit
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Aufsatzsammlung Aufsatzsammlungen (auch Sammelwerk/Sammelband) erkennt 
man daran, dass sie einen oder mehrere Herausgeber haben. 
Wie der Name schon sagt, sind es Sammlungen von Aufsätzen 
unterschiedlicher Autoren. Der Vorteil von Aufsatzsammlungen 
liegt daher auch in der Präsentation eines Themas aus unter-
schiedlichen Blickwinkeln.

Wissenschaftliche 
Zeitschriften

Wissenschaftliche Zeitschriften enthalten aktuelle Forschungser-
gebnisse und auch häufig Buchbesprechungen. Die darin abge-
druckten Artikel sind von hoher wissenschaftlicher Qualität.

Achtung: Da die Zeitschriftenartikel oft sehr spezifischen Frage-
stellungen nachgehen, eignen sie sich nicht so gut dazu, sich 
einen Überblick zu einem Thema zu verschaffen. 

Beispiele: 

• Schmidt, Manfred G. (Hrsg.): Regieren in der Bundesrepu-
blik Deutschland. Innen- und Außenpolitik seit 1949

• Croissant, Aurel (Hrsg.): Wohlfahrtsstaatliche Politik in 
jungen Demokratien 

Beispiele: 

Zeitschrift für Politik, Zeitschrift für Außen- und Sicherheitspo-
litik
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E-Journals E-Journals erscheinen entweder parallel zur gedruckten 
Ausgabe einer Zeitschrift oder ausschließlich elektronisch. Der 
Vorteil von E-Journals liegt darin, dass sie den sofortigen Zugriff 
auf die elektronischen Volltexte der Artikel bieten. Viele E-Jour-
nals sind nur durch einen Lizenzvertrag mit der Universität 
zugänglich. Hier gibt es Unterschiede zwischen den Universi-
täten. 

Aufsätze Aufsätze werden vor allem in wissenschaftlichen Zeitschriften, 
Aufsatzsammlungen/Sammelbänden und E-Journals veröffent-
licht. Aufsätze geben aktuelle Forschungsergebnisse wieder, 
weshalb sie oft sehr spezifische Fragestellungen haben. Einen 
besonderen Informationswert haben die so genannten Reviews: 
Diese Aufsätze berichten aus der Perspektive des jeweiligen 
Autors über aktuelle Publikationen und Forschungsergebnisse 
zu einem Thema und geben so einen Überblick über den aktu-
ellen Forschungsstand. 

Zeitungen und 
Zeitschriften

Zeitungen und Zeitschriften können für wissenschaftliche 
Arbeiten eine wichtige Quelle sein, um die politische, wirtschaft-
liche oder gesellschaftliche Relevanz eines Themas aufzu-
zeigen. Abhängig vom Niveau und dem Adressatenkreis finden 
sich insbesondere in überregionalen Zeitungen und Zeitschriften 
auch Hintergrundinformationen und expertenbasierte Analysen, 
die als Ansatzpunkt für vertiefende wissenschaftliche Recher-
chen dienen können.
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Tipp: Universitätsbibliotheken bieten oft einen Onlinezugriff auf 
Archive zahlreicher Zeitungen und Zeitschriften an.

Fakten In die Kategorie Fakten fallen beispielsweise Parlamentsproto-
kolle, Statistiken und Verträge. Sie sind oft sehr aktuell und 
liefern wichtige Primärdaten für die wissenschaftliche Arbeit, wie 
etwa das Statistische Bundesamt Deutschland (http://
www.destatis.de) 

Strategisches Literaturmanagement 
Studierende, die erst am Beginn ihres Studiums stehen, arbeiten 
in dieser Phase meist mit Lehr- und Handbüchern, Lexika und 
Nachschlagewerken. Sie eignen sich sehr gut dazu, um sich 
einen Überblick über das Fach, dessen Vokabular, Theorien und 
Methoden zu verschaffen. Diese Dokumenttypen behandeln die 
Themen allgemeiner und setzen nicht so viel Fachwissen voraus, 
wie z.B. Artikel in wissenschaftlichen Zeitschriften.

In den meisten Fächern stellen Professoren oft Einführungslite-
ratur vor oder teilen entsprechende Literaturempfehlungen aus. 
Außerdem findest du in Universitäts- und Institutsbibliotheken 
häufig Semesterapparate und natürlich Regale mit Lexika, Hand- 
und Lehrbüchern. Erkundige dich am besten, wo es in deiner 
Bibliothek entsprechende Bereiche gibt und welche Schulungen 
angeboten werden. Dabei ist dir die Auskunft der Bibliothek 
gerne behilflich.

Man kann viel Zeit sparen, indem man die verwendete Literatur 
von Beginn des Studiums an an einem zentralen Ort sammelt 
und verwaltet – deiner EndNote-Datenbank. Dort können auch 
Notizen und Dokumente (Volltexte, PDF-Dokumente, URLs, 
Bilder etc.) abgelegt werden. Auf diese Weise muss man sich 
nicht immer wieder auf Literatursuche begeben oder alte Haus-
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arbeiten ausgraben, um bereits verwendete und wieder benötigte 
Quellen ausfindig zu machen.

Installation
Installations- und Konfigurationsanleitungen für Windows und 
Mac findest du auf der Seite http://www.endnote.de/InstWin bzw. 
http://www.endnote.de/InstMac. 

Installationshinweise findest du außerdem im Anhang unter 
Custom Installation auf Seite 199. Die aktuellsten Installations- 
und Konfigurationsanleitungen findest du immer unter den oben 
angegebenen Links.

Neue Datenbank erstellen
Du kannst EndNote starten, indem du auf die Verknüpfung auf 
deinem Desktop klickst oder das Programm über Start > 
Programme > EndNote aufrufst. Nun erscheint ein Dialog-
fenster, in dem du auswählen kannst, ob du eine neue EndNote-
Datenbank (EndNote-Library) erstellen oder eine vorhandene 
öffnen möchtest.

Beim ersten Start von EndNote wird außerdem ein Fenster für 
die Anmeldung bei EndNote Web angezeigt. Du kannst dieses 
Fenster über Abbrechen wegklicken und die Installation von 
EndNote Web zu einem späteren Zeitpunkt nachholen. Informa-
tionen und Anleitungen zu EndNote Web findest du in Kapitel 9 
ab Seite 185.

Was ist eine Datenbank?
Eine Datenbank besteht technisch betrachtet aus Datensätzen, 
die sich aus mehreren festgelegten Datenbankfeldern zusam-
mensetzen. Jeder Datensatz beschreibt eine Publikation (z.B. 
ein Buch, einen Aufsatz etc.) anhand von festgelegten Merk-
malen, die in unterschiedliche Datenbankfelder eingetragen 
werden. Es gibt Datenbankfelder für Autor, Titel, Jahr usw. 

Die EndNote-Datenbank ist in zwei Elementen unterteilt: einer 
.enl-Datei („enl“ steht für EndNote Library) und einem darunter 
liegenden gleichnamigen Verzeichnis (.Data-Ordner). Beide 
dürfen nicht gelöscht werden und müssen immer zusammenge-
halten werden (z.B. beim Kopieren oder Verschieben). Bei der 
Erstellung einer neuen Datenbank werden automatisch beide 
Elemente generiert. (Informationen zu Datenbanken findest du in 
Kapitel 5 ab Seite 97 und zum Austausch von EndNote-Daten-
banken in Kapitel 8 ab Seite 171.)
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Solange du noch keine Datenbank geöffnet oder erstellt hast, 
öffnet sich das unten abgebildete „Getting Started“-Fenster.

Sobald du eine erste Datenbank erstellt hast, taucht dieses 
Fenster nicht mehr auf. Nutze die Befehle File > New... oder File 
> Open > Open Library..., um eine neue Datenbank zu erstellen 
oder eine vorhandene zu öffnen.
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Programmoberfläche von EndNote

In der Abbildung siehst du die Hauptbereiche von EndNote.

Auf der linken Seite die Navigation mit vorgegebenen, nicht 
veränderbaren Gruppen (All References, Unfiled und Trash) und 
von dir erstellten Gruppen (z.B. Eocene, Fossils) sowie einen 
Schnellzugriff auf Online-Recherchen in den von dir ausge-
wählten Online-Datenbanken (Online Search) und einen Zugriff 
auf EndNote Web.

Merke: Die Programmoberfläche, insbesondere der linke Navi-
gationsbereich, kann sich geringfügig unterscheiden, je nach 
dem, in welchem Anzeigemodus du dich befindest. In den 
folgenden Abschnitten wird im Local Library Mode gearbeitet. Die 
anderen Modi werden in Kapitel 5 im Abschnitt Recherche in 
Online-Datenbanken aus EndNote heraus ab Seite 112 themati-
siert. 

Im unteren Bereich kannst du zwischen drei Funktionen wech-
seln:

• Vorschau (Preview) zeigt die markierte Referenz entspre-
chend dem gewählten Zitierstil an. Der Zitierstil lässt sich 
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dabei im Drop-Down-Menü oberhalb des Navigationsbereichs 
ändern.

• Suchmaske (Search) für die gesamte geöffnete EndNote-
Datenbank (All References) oder einzelne Gruppen (z.B. My 
Groups) sowie Rechercheanfragen an Online-Datenbanken 
(Online Search).

• Schnelleditor (Quick Edit), mit dessen Hilfe du den jeweils 
markierten Titel korrigieren oder ergänzen kannst, ohne ihn 
per Doppelklick öffnen zu müssen.

In der Mitte siehst du deine EndNote-Datenbank mit der aufge-
nommenen Literatur, im Weiteren Referenzen genannt. Jede 
Zeile repräsentiert eine Referenz, z.B. ein Buch, einen Artikel, 
usw. Referenzen lassen sich etwa nach Autor (Author) oder Zeit-
schrift (Journal) alphabetisch oder nach Jahr (Year) durch Klick 
auf den jeweiligen Spaltenkopf auf- oder absteigend sortieren. 

Neue Referenz erstellen
Nach dem Öffnen oder Anlegen einer neuen Datenbank kannst 
du über References > New Reference neue Referenzen 
erstellen.

Es öffnet sich die Eingabemaske, in die du die „Rohdaten“ der 
aufzunehmenden Referenz in vorgegebene Felder eingeben 
musst. „Rohdaten‟ meint, dass in EndNote nur die Daten vorge-
halten werden, die sich verändern. Beispielsweise das Einfügen 
eines Punktes am Ende des Titels ist nicht notwendig, da 
EndNote diesen automatisch durch die Formatierungsanwei-
sungen der Output Styles setzt. Ein Fragezeichen hingegen soll-
test du natürlich eingeben! 

Die wichtigsten Regeln und mögliche Fehlerquellen bei der 
Eingabe dieser „Rohdaten“ erklären wir dir anhand der einzelnen 
Eingabekategorien (z.B. Autor, Publikationsort etc.).
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Merke: Um fehlerhafte oder uneinheitliche Literaturverweise 
(z.B. in Microsoft Word) zu vermeiden, musst du dich bei der 
Eingabe von Rohdaten in EndNote an vorgegebene Regeln 
halten, z.B. dürfen nach einer Eingabe grundsätzlich keine Zeile-
numbrüche (Absatzmarken) in einem Datenbankfeld enthalten 
sein. Jedoch müssen im Autorenfeld mehrere Autoren jeweils in 
einer einzelnen Zeile geschrieben werden, mehr dazu in den 
folgenden Abschnitten. EndNote gibt die eingetragenen Daten 
nach eigens voreingestellten Zitierregeln aus und erstellt daraus 
einen Literaturverweis. Sollte also die Ausgabe eines Literatur-
verweises in Microsoft Word mal nicht korrekt sein, dann über-
prüfe zuerst, ob du die Rohdaten in EndNote korrekt eingetragen 
hast.

Referenztypen 
(Reference Types)

In EndNote lassen sich die bereits erwähnten und viele zusätz-
liche Dokumenttypen (z.B. Lehrbuch, Monografie) sowie andere 
Informationsquellen verwalten. EndNote bietet dafür standard-
mäßig eine Reihe von Dokumenttypen – in EndNote heißen sie 
Reference Types – an. Wenn du in EndNote einen Titel 
aufnehmen möchtest, musst du ihn immer einem bestimmten 
Typ zuordnen. Im Folgenden siehst du die deutschsprachigen 
Entsprechungen der Referenztypen (Reference Types).

Wichtige Referenztypen (Reference Types):

Buch Book

Beitrag in einem Sammelband/
Aufsatzsammlung

Book Section

Wörterbuch, Verzeichnis Dictionary



Kapitel 1 – Literatur erfassen

28

Weitere Reference Types findest du im Anhang unter Zusätzliche 
Reference Types auf Seite 201.

EndNote weist neuen Referenzen einen Referenztyp zu, der 
gegebenenfalls zu ändern ist und über das Dropdown-Menü 
eingestellt werden kann. Standardmäßig ist der Referenztyp 
„Journal Article“ eingestellt. Je nachdem, welchen Referenztyp 
du auswählst, erscheinen unterschiedliche Eingabefelder. Dies 
kannst du an der Gegenüberstellung vom „Book“- und 
„Newspaper Article“-Referenzeingabefenster nachvollziehen. 

Die Auswahl des Referenztyps ist daher der erste Schritt bei der 
Erstellung einer neuen Referenz. Sie ist auch deshalb wichtig, 
weil davon die spätere Ausgabe der Datenbankfeldinhalte in 

Sammelband/Aufsatzsamm-
lung (= von einem Hrsg. 
editiertes Werk)

Edited Book

Enzyklopädie, Lexikon Encyclopedia

Allgemeiner Publikationstyp Generic

Artikel in einer Fachzeitschrift Journal Article

Webseite Web Page

Wichtige Referenztypen (Reference Types):
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einem Textverarbeitungsprogramm abhängt. So wird ein Buch 
anders zitiert als ein Aufsatz in einer Zeitschrift. Bei einer Zeit-
schrift muss neben dem Aufsatztitel auch der Zeitschriftentitel 
angegeben werden. Solltest du dir unsicher sein, wie du 
bestimmte Literaturarten zitieren sollst, dann frage in deiner 
Bibliothek nach; dort befinden sich die Informationsexperten.

Tipp: Falls du den benötigten Referenztyp in der voreingestellten 
Liste nicht findest, hast du mehrere Möglichkeiten:

• Überlege dir, ob der verwendete Dokumenttyp nicht wie ein 
anderer, in der Referenztypenliste vorhandene Dokumenttyp 
zitiert wird und nutze dann diesen.

• Verwende den voreingestellten Referenztyp „Generic‟. Er 
umfasst alle Datenbankfelder.

Author Autoren und Herausgeber werden in der Form: 
Nachname, Vorname 
eingegeben. Der Nachname wird also mit einem Komma vom 
Vornamen getrennt. Willst du mehr als einen Autor eingeben, 
dann drücke die Eingabetaste und gib in der zweiten Zeile den 
nächsten Autor ein:

Beispiel für alternative Schreibweisen des Vor- und Nach-
namens:

Alternativ dazu lassen sich Autoren auch in der Form: 
Vorname Nachname 
eintragen, d.h. ohne irgendwelche Satzzeichen. Empfehlenswert 
ist jedoch die erstgenannte Eingabeform. Achte immer darauf, 
nur einen Autor pro Zeile einzugeben! Wenn kein Komma im 
Autorennamen eingegeben wird, geht EndNote davon aus, dass 
das letzte Wort der Nachname ist und kürzt ggf. den oder die 
Vornamen ab.

EndNote merkt sich die bereits eingegebenen Autoren (aber 
auch Zeitschriften und Schlagwörter). Sobald du im entspre-
chenden Eingabefeld etwas eingibst, werden bereits eingetra-
gene Namen vorgeschlagen.

Nach Möglichkeit solltest du Vornamen des Autors ganz 
ausschreiben. Später kannst du in den Zitierregeln einstellen, ob 
die Vornamen als Initialen abgekürzt im Literaturverzeichnis 
ausgegeben werden sollen oder nicht. Sollten dir die Vornamen 
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nicht bekannt sein, dann achte darauf, dass die Initialen vonein-
ander entweder durch eine Leerstelle oder einen Punkt getrennt 
werden, da EndNote aus den beiden Initialen sonst einen 
Vornamen macht.

Namen mit einem Namenspräfix (z.B. von, de, van u.a.) werden 
folgendermaßen eingegeben:

Ist der Autor bzw. Urheber einer Publikation eine Organisation, 
gilt die Regel: Nach dem ausgeschriebenen Namen der Organi-
sation muss ein Komma gesetzt werden.

Sollte die Organisation in ihrem Namen ein Komma haben, dann 
muss an dieses Komma ein zweites angefügt werden. 

Zum Verständnis: Der Platz nach dem zweiten Komma ist für den 
Vornamen reserviert; dieser Platz bleibt im konkreten Beispiel 
leer. Alles, was nach dem zweiten Komma eingegeben wird, wird 
so ausgegeben, wie es eingegeben wurde.

Title Den Buch- oder Aufsatztitel gibst du im „Title“-Feld ein. Achte 
darauf, am Ende des Titels keine Leerzeichen oder Punkte 
einzutippen. Sollte der Titel zu lang für die Eingabezeile sein, 
dann verwende nicht die Eingabetaste, sondern überlasse 
EndNote die automatische Zeilenübertragung. Andernfalls wird 
der Zeilenumbruch auch im Literaturverzeichnis bzw. in der 
Fußnote eines Word-Dokuments angezeigt. Obwohl EndNote 
die Groß-/Kleinschreibung von Titeln innerhalb der Zitierstil-
einstellungen regelt, ist es empfehlenswert, den Titel in der 
selben Schreibweise wie in der Literaturquelle zu übernehmen.
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Merke: Falls du eine Referenz nicht manuell anlegst, sondern 
automatisch importierst, solltest du trotzdem prüfen, ob alle 
Angaben korrekt sind und den richtigen Datenbankfeldern zuge-
ordnet wurden.

Year und Date Das Erscheinungsjahr wird im Datenbankfeld „Year“ in der Form 
2010 angegeben.

Bei Onlinedokumenten wird neben den üblichen Angaben zum 
Autor und Titel der Zusatz „gesehen am“ erwartet. Für diese 
Zusatzinformation existiert in EndNote das Datenbankfeld 
„Date“, in dem du das Datum in einer beliebigen Form eingeben 
kannst.

Pages Zitiert man einen Artikel aus einer wissenschaftlichen Zeitschrift, 
gibt man im Literaturverzeichnis die Seiten an, auf denen der 
jeweilige Artikel veröffentlicht wurde. Selbiges gilt oft auch für 
zitierte Kapitel oder Passagen einer Monografie. In EndNote 
existiert für die Eingabe dieser Information das Datenbankfeld 
„Pages“. Die Form der Seiteneingabe ist „1442-1449“ oder 
„1442-9“. Nur bei dieser Schreibweise kann die Ausgabe der 
Seitenangabe in einem Textverarbeitungsprogramm nachträg-
lich über EndNote-Einstellungen je nach Bedarf für alle Refe-
renzen geändert werden, z.B. in 1442-49 (siehe auch Kapitel 6 
ab Seite 123).

Edition Das Datenbankfeld „Edition“ beinhaltet die Information über die 
Ausgabe des jeweiligen Buches. In diesem Feld kannst du eine 
Form wählen, so wie sie im Textverarbeitungsprogramm ausge-
geben werden soll. Achte auf die einheitliche Eingabe bzw. 
Import dieser Information (Achte auf die Zeichensetzung!). Im 
Zitierstileditor kannst du später einstellen, was an die Ausgaben-
nummer angehängt werden soll, z.B. 1. Ausg. oder 1. Edition. 

City Bei der Eingabe mehrerer Publikationsorte im Datenbankfeld 
„City“ musst du darauf achten, die Städte einheitlich voneinander 
zu trennen, z.B. Berlin; München; Hamburg

Im Gegensatz zum Autoren- und Herausgeberfeld müssen die 
Städte in einer Zeile geschrieben werden.

File Attachments EndNote bietet eine komfortable Funktion, um PDF-Dokumente 
zu verwalten. Alle PDF-Dokumente werden in ein spezielles 
Unterverzeichnis von EndNote gespeichert. Dadurch behältst du 
immer den Überblick über deine Dokumente und kannst schnell 
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eine Datensicherung durchführen oder die Daten an einem 
anderen Ort speichern. 

Falls du ein Dokument hast, das du an die Referenz anhängen 
möchtest, benötigst du das „File Attachments“-Feld. In dieses 
Feld wird eine Verknüpfung zu einer Datei auf deiner Festplatte 
gesetzt. Um eine Datei anzuhängen, genügt es, per Drag&Drop 
die Datei auf die jeweilige Referenz zu ziehen. Das Büroklam-
mersymbol signalisiert, dass die Referenz mit einer Datei 
verknüpft ist.

Wenn der Pfad zur Datei korrekt ist und die Datei existiert, kann 
die Datei über den Button Open File in der EndNote-Symboll-
eiste geöffnet werden. 

Für mehr Informationen zu Dateianhängen siehe Kapitel 7 > 
Elektronische Dokumente verwalten auf Seite 159.

Bedeutung korrekter 
Datenerfassung

Indem du einzelne Informationen in die dafür vorgesehenen 
Datenbankfelder einträgst, ermöglichst du EndNote die anschlie-
ßende Zusammenstellung dieser Angaben gemäß dem von dir 
ausgewählten Zitierstil. Bei der Eingabe bibliografischer Informa-
tionen in einzelne Datenbankfelder muss in der Regel nicht auf 
Zitierstilvorgaben oder Zeichensetzungsregeln geachtet werden. 
Beispielsweise musst du keine Anführungszeichen um den Titel 
herum setzen, die Zeitschriftentitel kursiv schreiben oder bei der 
Auflage die Abkürzung “Aufl.” mitschreiben. Gib nur die 
Rohdaten ein und überlasse das Formatieren EndNote. 

Merke: Es gibt jedoch, wie du in den vorigen Abschnitten 
gesehen hast, einige Ausnahmen von der Zeichenssetzungs-
regel. Das betrifft besonders die Felder Author, Editor und 
Edition. Eine Auflistung findest du im Anhang unter Datenbank-
felder und entsprechende Syntaxregeln auf Seite 202.

Wenn du mit dem Eintragen neuer Referenzen oder der Ergän-
zung vorhandener Referenzen fertig bist, kannst du die Eingabe-
maske schließen. Es erscheint ein Fenster mit der Auswahlmög-
lichkeit, ob die Daten gespeichert werden sollen. Man kann darin 
die Einstellung vornehmen, dass alle Änderungen beim 
Schließen des Referenzeingabefensters automatisch gespei-
chert werden sollen. Alle Änderungen an der Datenbank werden 
automatisch gespeichert, ohne dass man extra auf „Speichern‟ 
oder „Speichern unter...‟ klicken muss.
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Im folgenden Video 1.1 wird dir gezeigt, wie man eine neue 
Datenbank anlegt und zwei neue Referenzen (Buch und ein Zeit-
schriftenaufsatz) erfasst.

Video 1.1: Erstellung einer EndNote-Datenbank und Eingabe von Referenzen

ZUSAMMENFASSUNG In diesem Kapitel hast du gelernt,

 Unterschiedliche Dokumenttypen zu unterscheiden 

 Die Grundfunktionen von EndNote zu verwenden 

 Vorhandene Referenztypen in EndNote zu nutzen 

Übung: 

Erstelle eine neue EndNote-Datenbank.

Erstelle neue Referenzen aus folgenden Literaturverweisen. 
Nutze den Zitierstil (Output Style) „Author-Date“. 
Achte darauf, den richtigen Referenztyp zu wählen! 

• Rosa, H. (1994). “Ideengeschichte und Gesellschaftsthe-
orie: Der Beitrag der 'Cambridge School' zur Metatheorie.“ 
Politische Vierteljahresschrift 35(2): 197-223.

• Hildebrandt, Max, 2002: Die Rolle des Fettstoffwechsels für 
geistige Kreativität. Hubert, Martin. Ein neuer Blick auf die 
Ernährung. Göttingen; Bern; Wien: Hogrefe. 118-123.

• Bundeszentrale für politische Bildung, (2008). Die Europäi-
sche Union. Bonn

• Barnett, M. and Duvall, R. (2005). “Power in international 
politics.“ International Organization 59(1): 39-75.
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 Über die manuelle Erfassung eigener Referenzen die Arbeits-
weise von EndNote zu verstehen und Möglichkeiten zur 
Fehlerbehebung zu nutzen
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Kapitel 2 –  Kataloge benutzen

LERNZIELE In diesem Kapitel lernst du,

 Lexika und Nachschlagewerke sinnvoll einzusetzen

 Den Unterschied zwischen Titelstichwort und Schlagwort und 
ihren Nutzen für die thematische Literaturrecherche kennen

 Bibliothekskataloge nach ihren Merkmalen und Typen zu 
unterscheiden

 Buchangaben aus Online-Katalogen der Universitätsbiblio-
theken und überregionalen Katalogen in EndNote zu impor-
tieren

 Metakataloge wie die Virtual Library der Max-Planck-Gesell-
schaft in Kombination mit EndNote zu nutzen

Situation

Du hast jetzt erfolgreich einige Literaturangaben in EndNote 
erfasst. Zu Recht fragst du dich natürlich, ob es nicht eine 
Möglichkeit gibt, die Literaturdaten, die du manuell erfasst hast, 
auch automatisch in deine EndNote-Datei zu übernehmen.

Genau hier bietet dir EndNote weitere Erleichterungen, denn du 
kannst aus vielen Katalogen die Literaturangaben einfach durch 
die jeweils angebotenen Exportoptionen oder technische Schnitt-
stellen übernehmen und so bei der Erfassung viel Zeit sparen. So 
kannst du bei lokalen Bibliothekskatalogen die Signaturen meist 
automatisch übernehmen und musst sie nicht von Hand nach-
tragen. Späteres Recherchieren nach der Signatur erübrigt sich 
dadurch. Auch kannst du mit zusätzlichen Kenntnissen über die 
Recherchemöglichkeiten von Katalogen dein Studium erleichtern 
und verbessern. Häufig enthalten die Literaturangaben in Kata-
logen auch noch inhaltliche Angaben, wie Schlagwörter, Inhalts-
verzeichnisse oder Links zu Volltexten. Diese werden automa-
tisch in EndNote übernommen. 

Durch die vielen Rechercheoptionen kann es sein, dass du 
zusätzliche Literatur zu deinem Seminar findest, die du vielleicht 
leichter verstehst, als die vom Dozenten angegebene Literatur. 
Und vielleicht kannst du deinen Dozenten mit dem Hinweis auf 
eine neuere Auflage oder ein ganz neues Buch zum Thema 
eines Seminars überraschen. Hilfreich ist es deshalb, wenn du 
ein paar grundlegende Kenntnisse über Kataloge und dort ange-
botene Recherchemöglichkeiten kennst. 
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Neben dem lokalen Katalog können auch überregionale und 
Metakataloge nützlich sein, denn manchmal musst du dir Lite-
ratur, die nicht vor Ort vorhanden ist, von anderen Bibliotheken 
über Fernleihe oder Dokumentlieferdienste wie Subito 
beschaffen. Aus diesem Grund ist es hilfreich, wenn du zumin-
dest einen Überblick über unterschiedliche Katalogarten und 
ihren Nutzen hast. 

Was ist ein Katalog?
Ein Katalog ist ein Verzeichnis der Medien, die eine Bibliothek 
zur Nutzung bereitstellt, z.B. Bücher, Zeitschriften, E-Journals. 
Zusätzlich erhält man die Information, wo und wie diese Medien 
benutzt werden können.

Bibliothekskataloge sind heute meist in elektronischer Form als 
Online-Kataloge über das Internet recherchierbar. Erfasst 
werden Bücher, Zeitschriften und andere Medien mit ihrem Titel. 
Aufsätze werden in der Regel nicht nachgewiesen. Für Recher-
chen nach Aufsätzen gibt es so genannte „bibliografische Daten-
banken‟, dazu mehr in Kapitel 5 ab Seite 97.

Ältere Kataloge können auch in Form von gedruckten Katalogen, 
Image- oder Mikrofiche-Katalogen vorliegen. Erkundige dich am 
besten auf der Homepage deiner Universitätsbibliothek oder 
beim bibliothekarischen Auskunftspersonal über das Katalogan-
gebot!

Lokale, (über-)regionale Bibliothekskataloge und Meta-
kataloge

Man unterscheidet lokale, regionale und überregionale Biblio-
thekskataloge sowie Metakataloge.

Lokale Kataloge (z.B. 
Katalog der Heidelberger 
Universitätsbibliothek)

In einem lokalen Bibliothekskatalog findest du Medien einer oder 
mehrerer Bibliotheken eines Ortes, z.B. der Universitäts- und 
Institutsbibliotheken in Heidelberg. In einem lokalen Bibliotheks-
katalog erfährst du den Standort und die Verfügbarkeit des 
Mediums. Lokale Kataloge bieten Ausleihfunktionen wie Bestel-
lung, Verlängerung, Vormerkung oder Fernleihe aus anderen 
Bibliotheken an.

Nutzen: Besonders nützlich sind: Überprüfen der lokalen Verfüg-
barkeit eines Mediums, optimale Nutzung von Schlagwörtern, da 
einheitliche Schlagwortvergabe durch die Bibliothek, Kontofunk-
tionen, Fernleihe, Export von bibliografischen Informationen in 
EndNote.
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Nachteile: Recherche beschränkt sich auf lokalen Bestand.

(über-)regionale 
Kataloge (z.B. SWB oder 
GBV)

Um eine möglichst umfassende Literaturversorgung zu gewähr-
leisten, organisieren sich einzelne Bibliotheken in so genannten 
Bibliotheksverbünden, so zum Beispiel der Südwestdeutsche 
Bibliotheksverbund (SWB: http://swb.bsz-bw.de), zu dem die 
Bestände der Bibliotheken in Baden-Württemberg, südl. Rhein-
land-Pfalz, Saarland und Sachsen gehören (siehe Grafik).

Ein weiterer überregionaler Verbund ist der Gemeinsame Biblio-
theksverbund (GBV: http://www.gbv.de). In ihm sind die Biblio-
theken der Länder Bremen, Hamburg, Mecklenburg-Vorpom-
mern, Niedersachsen, Sachsen-Anhalt, Schleswig-Holstein, 
Thüringen und der Stiftung Preußischer Kulturbesitz zusammen-
gefasst (siehe Grafik).

Eine Übersicht aller Bibliotheksverbünde findest du unter 
folgendem Link: http://www.gbv.de/vgm/links/links_0218 .

Nutzen: Überprüfen der regionalen Verfügbarkeit eines 
Mediums, z.B. in benachbarten Bibliotheken, Einbindung in 
EndNote für einen Direktimport möglich.

Metakataloge (z.B. vLib) Ein Metakatalog ist die „Virtual Library‟ (vLib: http://vlib.mpg.de) 
der Max-Planck-Gesellschaft. Er ermöglicht eine kombinierte 
Suche in mehreren nationalen und internationalen Katalogen, 
z.B. dem Katalog der Library of Congress in den USA. Über vLib 
lassen sich nationale Bibliotheksverbünde wie die bereits 
erwähnten SWB und GBV durchsuchen. vLib bietet eine gleich-
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zeitige Recherche in allen diesen Katalogen an. Das erspart dir 
Einzelrecherchen im jeweiligen Katalog bzw. Bibliotheksver-
bund. 

Neben vLib gibt es auch den Karlsruher Virtuellen Katalog (KVK: 
http://www.ubka.uni-karlsruhe.de/kvk.html). KVK bietet neben 
allen deutschen Verbundkatalogen auch eine größere Auswahl 
von internationalen Bibliotheken an. Außerdem schließt KVK 
auch Buchhandelskataloge ein, so zum Beispiel das deutsch- 
und englischsprachige Angebot von Amazon.de oder den 
Bestand vom Zentralen Verzeichnis Antiquarischer Bücher 
(ZVAB: http://www.zvab.com). Der Nachteil von KVK gegenüber 
vLib besteht darin, dass ein Export in EndNote nicht direkt über 
den Metakatalog möglich ist. Man ist im Fall des KVK darauf 
angewiesen, dass die jeweilige Bibliothek oder der Bibliotheks-
verbund die Export-Funktion anbietet.

Nutzen: Besonders nützlich sind: Nationale und internationale 
Recherche, gleichzeitiges Durchsuchen mehrerer Kataloge über 
eine Suchanfrage, je nach Katalog Exportmöglichkeit in 
EndNote.

Nachteile: Die Schlagwortsuche ist zwar möglich, sie ist aber 
ungenau, da unterschiedliche Vorgaben für die Vergabe von 
Schlagwörtern existieren. Einige Metakataloge (z.B. KVK) lassen 
keinen Export zu.
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Merke: Da die jeweiligen Kataloge die bibliografischen Angaben 
teilweise unterschiedlichen Datenbankfeldern zuweisen und 
Schlagwörter zum Teil nach unterschiedlichen Regeln oder Spra-
chen vergeben werden können, ist eine gleichzeitige bzw. paral-
lele Suche mittels Metakatalogen nicht ausreichend, um eine 
wirklich lückenlose Recherche durchzuführen.

Thematische Recherche in Katalogen
Bücher oder Zeitschriften werden von den Bibliotheken nicht nur 
nach formalen Kriterien wie Autor, Titel oder Jahr in die Kataloge 
aufgenommen, sondern auch nach inhaltlichen, wie etwa den 
Schlagwörtern. Folgende Übersicht erklärt dir, welche Folgen 
das für die Suche hat:

Titelstichwörter Bei der Verwendung von Titelstichwörtern in der Suchmaske 
eines Online-Katalogs wird nur nach Medien gesucht, die exakt 
diese Begriffe in ihrem Titel enthalten. Wählt der Autor beispiels-
weise einen eher abstrakten Titel zu seinem Thema, wirst du so 
nicht in der Lage sein, entsprechende Literatur zu finden.

Die Suche nach Titelstichwörtern empfiehlt sich, wenn der Buch-
titel (zumindest teilweise) bekannt ist.

Schlagwörter Durch ein oder mehrere Schlagwort bzw. -wörter wird der Inhalt 
eines Mediums beschrieben – unabhängig von Titel und 
Sprache. Schlagwörter sind normiert; sie werden von einem 
Fachwissenschaftler vergeben, der den Inhalt sichtet und dann 
für alle Publikationen mit vergleichbarem Inhalt dieselben 
Begriffe als Schlagwörter verwendet. Nur die inhaltliche Suche 
nach Schlagwörtern ist umfassend und präzise. 

Tipp: Du solltest von Anfang an die aufgenommenen Einträge in 
deiner EndNote-Datenbank verschlagworten. Empfehlenswert 
ist eine Übernahme der in den Katalogen verwendeten Schlag-
wörter. Jedoch solltest du auf einheitliche Verwendung der 
Schlagwörter achten, mehr dazu in Kapitel 3 ab Seite 51.

Lexikonarbeit als Recherchehilfe
Die Lexikonarbeit bildet die Grundlage für deine weiteren thema-
tischen Recherchen. Sie ist nicht nur wichtig, um bis dato unbe-
kannte Begriffe zu klären und Schlagwörter bzw. Synonyme für 
die Online-Recherche zu finden. Mit der Lexikonarbeit gewinnst 
du darüber hinaus Einsichten in verschiedene Perspektiven, aus 
denen man einen Forschungsgegenstand betrachten kann. 
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Daher empfiehlt es sich auch, gleich mehrere Lexika zu nutzen.

Zum wissenschaftlichen Arbeiten gehört es, selbstständig rele-
vante Literatur finden zu können. Insbesondere zu Beginn des 
Studiums fragt man sich allerdings, was denn eigentlich „rele-
vant‟ ist? 

Wenn man seine erste Hausarbeit schreiben soll, wird man meist 
mit dem Problem konfrontiert, sich in ein bisher unbekanntes 
Thema einarbeiten zu müssen. Manche begeben sich dabei 
erstmal auf Google-Suche oder vertiefen sich gleich in viel zu 
spezielle wissenschaftliche Artikel. Für jemanden, der am Beginn 
seines Studiums steht, sind beide Informationsquellen nicht zu 
empfehlen, da die Google-Suche sehr zeitraubend und unprä-
zise ist, wenn man nicht gerade weiß, nach welchem Autor oder 
Titel man sucht. Artikel aus wissenschaftlichen Zeitschriften sind 
wiederum zu speziell und können eher Verwirrung schaffen, 
wenn man sich im jeweiligen Bereich seiner akademischen Diszi-
plin noch nicht sicher auskennt. Eine bessere Lösung bietet der 
Einstieg über Lexika und Nachschlagewerke, dies aus folgenden 
Gründen:

Am Anfang kann es sein, dass du nicht genügend Informationen 
hast, um das Thema deiner Hausarbeit bzw. deines Referats zu 
bearbeiten. Es kann auch sein, dass dir nicht bewusst ist, mit 
welcher Art Fragen sich eine Disziplin beschäftigt. In beiden 
Fällen können Lexika (aber auch Lehrbücher und Nachschlage-
werke) helfen, den Forschungsgegenstand besser zu verstehen 
und ein adäquates Thema zu finden.

Import von Treffern aus lokalen Online-Katalogen
Im ersten Kapitel hast du gelernt, neue Referenzen in EndNote 
zu erstellen. Nun kannst du sehen, wie Buchangaben aus einem 
lokalen Online-Katalog (z.B. dem Katalog der Universitätsbiblio-
thek Heidelberg, HEIDI: http://www.ub.uni-heidelberg.de/helios/
kataloge/heidi.html) exportiert und in EndNote importiert werden.
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Vom Prinzip her ist die Abfolge der Arbeitsschritte in Bibliotheks-
katalogen immer gleich:

1) Eingabe der Suche

2) Sichten und ggf. Einschränken der Suchtreffer

3) Selektion bspw. durch Hinzufügen in eine Merkliste

4) Export in ein für EndNote lesbares Format (typischerweise 
EndNote-Import-Format ENW, RIS)

Im Anschluss siehst du den Export am Beispiel des Online-Kata-
logs der Universitätsbibliothek Heidelberg.

Export aus dem Katalog 
für die Bibliotheken der 
Universität Heidelberg

Im Online-Katalog der Universitätsbibliothek Heidelberg klickt 
man auf das Diskettensymbol, um einen Treffer für den Export 
vorzumerken. 

Um zur Exportauswahl zu gelangen, klickt man auf „Merkliste“
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Ein wichtiger Schritt ist die Auswahl des geeigneten Formats. 
Wähle nach Möglichkeit die Formate *.ENW (EndNote) oder 
*.RIS, damit die exportierten ENW- bzw. RIS-Dateien automa-
tisch mit EndNote geöffnet und in die ausgewählte EndNote-
Datenbank importiert werden können.

Es öffnet sich ein Fenster, aus dem du die heruntergeladene 
Datei mit EndNote öffnen kannst. Falls EndNote nicht gleich 
angezeigt wird, kannst du über das Dropdown-Menü EndNote als 
Zielprogramm anwählen. 
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Die Datensätze werden nun in EndNote importiert und unter 
Imported Reference(s) angezeigt.

Import von Treffern aus (über-)regionalen Katalogen
Bibliografische Angaben werden in der Regel im RIS-Format 
exportiert, d.h. die Datei hat die Endung *.ris. Über einen Doppel-
klick auf die heruntergeladene Datei werden die in der Datei 
enthaltenen Angaben in die in EndNote zuvor geöffnete 
EndNote-Datenbank importiert. Empfehlenswert ist jedoch die 
Verwendung des Import-Buttons in EndNote. Im Importmenü 
kannst du auf diese Weise doppelten Einträgen vorbeugen. 
Doppelte Einträge solltest du vermeiden, um Zeit bei später 
gegebenenfalls anfallenden Korrekturen zu sparen, etwa wenn 
du in einem Word-Dokument einen Aufsatz über mehrere, 
doppelt vorhandene Einträge zitierst und dann feststellst, dass 
der Titel oder Autor falsch geschrieben wurden. 

Merke: Das Exportformat einer Datei benötigt in EndNote die 
Auswahl des entsprechenden Importformats, z.B. Exportformat: 
*.ris => Importformat: Reference Manager (RIS)

Export aus dem 
Gemeinsamen 
Verbundkatalog

Hier siehst du eine Anleitung zum Export aus dem Gemeinsamen 
Verbundkatalog (GVK: http://gso.gbv.de) des Gemeinsamen 
Bibliotheksverbunds (GBV).

Um die Literaturangaben zu exportieren, öffnest du die Vollan-
zeige des passenden Suchtreffers, indem du auf den Titel klickst.

In der Vollanzeige klickst du auf Speichern/Drucken.
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Als Format wählst du Literaturverwaltung: EndNote aus und 
klickst dann auf Speichern. Daraufhin wird eine *.txt-Datei auf 
deinem Rechner gespeichert. 

Öffne nun die EndNote-Datenbank, in die der Suchtreffer impor-
tiert werden soll. Wähle unter File > Import > File... die herunter-
geladene Textdatei aus. 



Kapitel 2 – Kataloge benutzen

45

Wähle als Import Option den Menüpunkt EndNote Import aus. 
Das ist wichtig, weil du die Angaben im Katalog in diesem Format 
exportiert hast.

Um doppelte Einträge von vornherein zu vermeiden, wählst du 
unter Duplicates den Menüpunkt Discard Duplicates aus. 
(Weitere Informationen zur Dublettenkontrolle findest du in 
Kapitel 3 > EndNote-Datenbank auf doppelte Einträge hin durch-
suchen ab Seite 63) 



Kapitel 2 – Kataloge benutzen

46

Sobald du auf Import klickst, werden die bibliografischen 
Angaben importiert. 

Du siehst sie in der temporären Gruppe Imported References. 
Das ist die beste Gelegenheit, um die Importe auf korrekte 
Zuordnung zu einem Referenztyp, den entsprechenden Daten-
bankfeldern und korrekte Übernahme von Sonderzeichen zu 
prüfen. 

Im folgenden Video 2.1 kannst du den Import von recherchierten 
Daten aus dem GBV nachvollziehen.

Video 2.1: Export aus dem Gemeinsamen Verbundkatalog

Import von Treffern aus Metakatalogen
Der bereits erwähnte Metakatalog vLib (http://vlib.mpg.de), mit 
dem eine gleichzeitige Suche in zahlreichen Bibliotheksver-
bünden und sonstigen Katalogen möglich ist, erlaubt ebenfalls 
einen Export in EndNote. Es kann die Möglichkeit des „Direct 
Export‟ genutzt werden.
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Export aus der Max 
Planck Virtual Library 
(vLib)

Der erste Schritt besteht darin, passende Suchtreffer zur Merk-
liste (My Basket) hinzuzufügen. Klicke dazu auf das Pluszeichen 
rechts vom Titel. Klicke dann auf My Basket, um zur Merkliste zu 
gelangen.

Setze neben den Treffern, die du exportieren möchtest, einen 
Haken und klicke dann auf Save/Send Records.

Klicke im nachfolgenden Fenster auf Save.

Wähle unter Record format den Menüpunkt Citation Manager 
(RIS) aus und klicke dann auf Save.
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Es öffnet sich nun ein Fenster, in dem du festlegen kannst, mit 
welchem Programm die exportierte Datei geöffnet werden soll. 
Wähle EndNote aus und klicke dann auf OK. 

Die Datensätze werden nun in EndNote importiert und unter 
Imported References angezeigt. Um doppelte Einträge zu 
vermeiden, solltest du eine Dublettenprüfung durchführen. (Mehr 
dazu in Kapitel 3 > EndNote-Datenbank auf doppelte Einträge 
hin durchsuchen auf Seite 63)

Im folgenden Video 2.2 kannst du den Import von recherchierten 
Daten aus vLib nachvollziehen.
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Video 2.2: Direct Export von Treffern aus einem Metakatalog im RIS-Format nach 

EndNote am Beispiel von vLib

Lokale und andere Online-Kataloge können sich unterscheiden. 
Erkundige dich am besten auf der Homepage des jeweiligen 
Katalogs, welche Exportmöglichkeiten angeboten werden!

Merke: Folgende Punkte solltest du bei jedem Export beachten:

1) Als Exportformat nach Möglichkeit „RIS‟ auswählen.

2) Importierte Angaben immer auf Korrektheit prüfen: Wurde der 
Referenztyp richtig zugeordnet? Stehen die bibliografischen 
Angaben (Autor, Titel, Schlagwort) im richtigen Feld? Achte 
dabei auch auf die Einhaltung der Regeln für die einzelnen 
Datenbankfelder (siehe Kapitel 1 ab Seite 17).

Tipp: Nutze nach Möglichkeit die Importfunktion wie am Beispiel 
des Imports aus dem GBV gezeigt, weil dadurch doppelte 
Einträge von vornherein vermieden werden können.  
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ZUSAMMENFASSUNG In diesem Kapitel hast du gelernt,

 Lexika und Nachschlagewerke sinnvoll einzusetzen

 Titelstichworte und Schlagwörter zu unterscheiden und für die 
thematische Literaturrecherche zu nutzen 

 Buchangaben aus Online-Katalogen von Universitätsbiblio-
theken und überregionalen Katalogen in EndNote zu impor-
tieren

 Metakataloge wie die Virtual Library der Max-Planck-Gesell-
schaft in Kombination mit EndNote zu nutzen

Übung: 

1) Führe eine inhaltliche Suche nach den Schlagwörtern „Lehr-
buch‟ und „Anglistik‟ (für Medizin: „Diabetes mellitus‟) in 
einem lokalen Online-Katalog deiner Universitätsbibliothek 
durch (z.B. in HEIDI (http://www.ub.uni-heidelberg.de)). 
Exportiere 2-3 Treffer in deine EndNote-Datenbank.

2) Wiederhole die Suche im Metakatalog vLib (http://
vlib.mpg.de) unter Einbeziehung mehrerer Bibliotheksver-
bünde. Achte darauf, mehrere Schlagwörter gegebenenfalls 
mit „UND‟ zu verknüpfen. Wähle aus der Trefferliste 2-3 
Referenzen aus und exportiere diese in deine EndNote-
Datenbank.
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Kapitel 3 – Literaturangaben verwalten

LERNZIELE In diesem Kapitel lernst du,

 MindMaps mit Schlagwörtern als eine Art Landkarte für deine 
Literatursammlung zu nutzen

 Die Keyword- und Groups-Funktion von EndNote zur Struktu-
rierung deiner Literatursammlung zu verwenden

 Mehrere Referenzen in EndNote in einem Schritt zu editieren

 Doppelte Einträge automatisch entfernen zu lassen

Situation

Die Begeisterung über die einfachen Möglichkeiten, Literatur-
daten aus den Katalogen zu übernehmen, hat dazu geführt, dass 
deine EndNote-Datenbank inzwischen beträchtlich ange-
wachsen ist. Sehr leicht kommt man allein schon in einem 
Semester auf 200 Literaturangaben. Nun bist du mit einem 
neuen Problem konfrontiert, das jeder Wissenschaftler hat: den 
Überblick behalten. 

Schwierig wird das, wenn du die Literaturangaben während des 
gesamten Studiums auf diese Weise sammelst und die Menge 
immer stärker ansteigt. EndNote bietet dir die Möglichkeit, die 
erfassten Titel nach Autor, Titel oder Jahr geordnet anzuzeigen. 
Aber bei 10 Seminaren in zwei Fächern ist eine solche formale 
Sortierung nicht ausreichend. Du benötigst eine Ordnung, die 
sich auf deine Fächer, die Seminarthemen oder sogar die 
Themen mehrerer Hausarbeiten bezieht. 

Hier erleichtern dir die Gruppierungs- und Schlagwortfunktionen 
die Arbeit.

Referenzen in Gruppen ordnen
Gruppen sind eine hilfreiche Funktion zur Strukturierung deiner 
EndNote-Datenbank. Wenn du zu verschiedenen Themen und 
Fächern Referenzen erfasst, brauchst du nicht mehrere 
EndNote-Datenbanken, sondern nur eine, in der du die Refe-
renzen mit Hilfe der Gruppenfunktionen ordnen kannst. Du 
kannst einzelne Obergruppen (z.B. Studienfächer) erstellen und 
ihnen Untergruppen (z.B. Lehrveranstaltungen) zuordnen.

Um Referenzen zu ordnen, gibt es drei Arten von Gruppen: 
Custom Groups, Smart Groups und Combo Groups. Du erkennst 
sie am jeweiligen Icon vor dem Gruppennamen. 
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Custom Groups Einer Custom Group werden per Drag&Drop oder mit rechter 
Maustaste > Add References to... Referenzen zugeordnet. 

Die Zuordnung geschieht manuell. Dabei wird keine Referenz 
kopiert, sondern es werden nur Gruppenzugehörigkeiten einer 
Referenz hinzugefügt. Aus diesem Grund führt ein Löschen einer 
Referenz aus einer Gruppe auch nur zum Löschen der Gruppen-
zugehörigkeit, aber nicht zum Löschen der Referenz aus der 
Datenbank.

Welcher Gruppe eine Referenz zugehört, kannst Du im Kontext-
menü (rechte Maustaste auf die Referenz) unter dem Befehl 
Record Summary sehen.
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Die Gruppe „Unfiled‟ zeigt die Referenzen an, die noch keiner 
„Custom Group‟ zugeordnet wurden. Mit einem Rechtsklick auf 
diese Gruppe werden die Referenzen, die sich in Smart Groups 
befinden, mit berücksichtigt.

Du kannst eine Referenz mehreren Gruppen zuordnen, was 
beispielsweise dann wichtig ist, wenn du in zwei Seminaren 
dieselbe Publikation benötigst.

Custom Groups eignen sich, um einfach und schnell Literatur zu 
unterschiedlichen Referaten, Hausarbeiten oder Fächern zu 
ordnen und gezielt für die Erstellung eines Literaturverzeich-
nisses zu verwenden. 

Smart Groups Im Gegensatz zur Custom Group können einer Smart Group 
keine Referenzen manuell zugeordnet werden. 

Hinter einer Smart Group steht eine Suchanfrage an die Daten-
bank, die sich ständig automatisch aktualisiert. 

Es kann hier bspw. nach Autorennamen, Schlagwörtern oder 
Titelstichworten gesucht werden. Trifft eine Suche zu, werden die 
Ergebnisse in der Gruppe dargestellt.

Da es sich also um eine Suchanfrage handelt, arbeitet man direkt 
mit der Referenz und nicht mit einer Gruppenzugehörigkeit. Folg-
lich wird die Referenz beim Löschen aus einer Smart Group 
direkt gelöscht und in den Papierkorb (Trash) verschoben.

Smart Groups eignen sich für ein fortgeschrittenes Informations-
management, etwa bei Dissertationen oder für Forschungs-
gruppen. Weitere Informationen zu Smart Groups erfährst du in 
Kapitel 7 ab Seite 147.

Combo Groups Bei dieser Gruppenart handelt es sich um eine Kombination von 
bereits existierenden Gruppen in einer Gruppe. Praktisch ist 
diese Gruppenform dann, wenn du zu viele Gruppen hast und 
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diese in einer Gruppe zusammenfassen oder Schnittmengen 
bilden möchtest.

Combo Groups eignen sich für fortgeschrittenes Informationsma-
nagement im Rahmen von Forschungsprojekten. 

Merke: Wenn du aus einer Smart Group oder einer Combo 
Group eine Referenz löschst, dann landet sie in der Gruppe 
Trash und wird beim Schließen der Datenbank endgültig 
gelöscht. 
Löschst du eine Referenz aus einer Custom Group, dann wird 
nur die Zugehörigkeit der Referenz zu dieser Gruppe gelöscht; 
die Referenz bleibt unter All References erhalten.

Obergruppen bilden und 
Gruppenzuordnung 
ändern

Du kannst eigene Gruppen entweder unter der vorgegebenen 
Obergruppe „My Groups“ erstellen oder eine neue Obergruppe 
(Group Set) für weitere Gruppen anlegen. Ein neues Group Set 
legst du an, indem du über einen Rechtsklick in der linken Spalte 
der EndNote-Programmoberfläche auf Create Group Set klickst 
und eine Gruppenbezeichnung eingibst. Wenn du zwei Fächer 
studierst, wie zum Beispiel Politikwissenschaft und Anglistik, 
dann kannst du ein Group Set für Politikwissenschaft und eines 
für Anglistik anlegen. 

Innerhalb des Group Sets kannst du für einzelne Lehrveranstal-
tungen (z.B. Vergleichende Regierungslehre, Internationale 
Beziehungen usw.) oder Themen (Shakespeare, Semantik des 
Englischen, Soziolinguistik usw.) Gruppen bilden und ihnen Lite-
ratur zuordnen.

Gruppen lassen sich per Drag&Drop zwischen den Group Sets 
verschieben. Du kannst sie auch umbenennen oder löschen.

Im folgenden Video 3.1 kannst du nachvollziehen, wie unter-
schiedliche Gruppen gebildet und ihnen Referenzen zugeordnet 
werden.
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Video 3.1: Referenzen in Gruppen ordnen

Begriffsnetze bilden
In Kapitel 2 hast du erfahren, dass Referenzen nicht nur formal 
nach Autor oder Titel beschrieben werden können, sondern auch 
inhaltlich mit Hilfe von einheitlich vergebenen Schlagwörtern. 
Schlagwörter verleihen deiner EndNote-Datenbank bei richtiger 
Anwendung somit eine innere Struktur, die du auch für eine 
gezielte thematische Suche nutzen kannst. Um den Überblick 
über die von dir angedachten Begriffe und ihre Beziehung unter-
einander zu behalten, ist es sinnvoll, die Begriffe miteinander zu 
verknüpfen, ein sogenanntes Begriffsnetz aufzubauen. 

Ein Begriffsnetz ist vergleichbar mit einer Landkarte, auf der 
bestimmte größere und kleinere Ortschaften und Städte markiert 
und miteinander über Straßen verbunden sind. Bei einem 
Begriffsnetz sind diese Ortschaften und Städte allerdings peri-
phere oder zentrale Begriffe eines bestimmten Themas. Diese 
Begriffe können mit anderen Begriffen „benachbart‟ oder über 
Umwege verbunden sein.
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Insbesondere wenn du dich in ein neues Thema einarbeitest, ist 
die Erstellung einer solchen „Landkarte‟ hilfreich. Auf diese 
Weise konstruierst du eine eigene Lernwelt. Es werden nicht nur 
wichtige Begriffe ausgekundschaftet und platziert, sondern auch 
Zusammenhänge erkannt. Gerade diese Vernetzung des 
Wissens verleiht dem sonst nur auswendig Gelernten einen Sinn 
und darüber hinaus eine kreative Dynamik, die für das wissen-
schaftliche Arbeiten enorm wichtig sind.

Wenn du ein Begriffsnetz aufbaust, solltest du neben den 
Begriffen, die du in Lexika oder Nachschlagewerken gefunden 
hast, insbesondere auch eigene (synonyme) Begriffe 
verwenden, mit denen du selbst etwas assoziieren kannst. Auf 
diese Weise wird es für dich einerseits leichter sein, dein Thema 
zu begreifen; andererseits wird die spätere Suche nach Literatur 
in deiner EndNote-Datenbank intuitiver.

Begriffsnetze lassen sich am besten mit so genannter MindMap-
ping-Software erstellen, z.B. mit MindManager von Mindjet (http:/
/mindmanager.adeptscience.de).

Dieses in einem Mindmapping-Programm erstellte Begriffsnetz 
lässt sich als Basis für ein standardisiertes Begriffssystem 
(Keywords) in EndNote nutzen.

Schlagwörter (Keywords) in EndNote
In EndNote werden die inhaltlichen Beziehungen zwischen den 
Referenzen über gemeinsame Keywords hergestellt. Bei einer 
neu aufgenommenen Referenz solltest du darauf achten, dass 
themenverwandte Referenzen immer das selbe Schlagwort 
erhalten. Mit dem selben Schlagwort kannst du so themenver-
wandte Referenzen finden, obwohl sie ganz unterschiedliche 
Titel haben. 

Im folgenden Screenshot siehst du Schlagwortfelder von zwei 
Referenzen mit unterschiedlichen Titeln, die sich thematisch 
überschneiden.

Merke: Schlagwörter werden in das Keywords-Datenbankfeld 
eingegeben. Die Schlagwörter werden mit Semikolon oder 
Absatzmarke getrennt.
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Empfehlenswert ist eine Kombination aus Mindmapping und 
Keywords, d.h. die gleichzeitige visuelle Verarbeitung der in 
EndNote verwendeten Schlagwörter in einer Mindmap. Die 
Verschlagwortung der einzelnen Referenzen muss aber zusätz-
lich durchgeführt werden.

Mit einer Mindmap behältst du immer den Überblick über Zusam-
menhänge und das verwendete Vokabular. Du kannst neue 
Referenzen noch schneller verschlagworten und begehst nicht 
den Fehler, plötzlich andere Schlagwörter zu vergeben. Deine 
persönliche „Lernwelt‟ bleibt übersichtlich und klar strukturiert. 
Mehr zum Export von Schlagwörtern aus einer MindMap in 
EndNote findest du in Kapitel 7 ab Seite 147. 

Term Lists In diesem Zusammenhang empfiehlt es sich, auf Term Lists 
zurückzugreifen. Term Lists sind automatisch generierte Listen 
mit Daten bestimmter Felder, die neben Schlagwörtern auch für 
Autoren und Zeitschriftentitel relevant sind. Sie dienen:

• als Vorschlagslisten bei der Eingabe und Suche,

• als Grundlage für ein kontrolliertes Vokabular (Keywords, 
Authors, Journals),

• zur Vermeidung von Tippfehlern bei der Eingabe,

• zur Vereinheitlichung der Ausgabe von Zeitschriftentiteln und 
ihren Synonymen (Titelabkürzungen und ausgeschriebene 
Zeitschriftentitel).

Sobald du in EndNote eine Referenz beispielsweise mit einem 
neuen Schlagwort versehen hast, wird dieses Schlagwort der 
Keyword Term List hinzugefügt. Du findest die Term List unter 
Tools > Open Term Lists. Wenn du auf das entsprechende 
Datenbankfeld (Authors, Journals oder Keywords) klickst, öffnet 
sich ein Fenster, in dem du die Term List editieren kannst. 
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Du kannst entweder neue Begriffe erstellen, vorhandene 
editieren oder löschen.

Term Lists sind auch deshalb nützlich, weil sie dir bei der 
Eingabe von Begriffen (Autoren, Schlagwörtern oder Zeit-
schriftentiteln) Vorschläge anhand der in der Liste aufgenom-
menen Begriffe machen.
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Solltest du nur einige wenige neue Begriffe in eine Term List 
einfügen wollen, empfiehlt es sich, diese in der Mindmap zu 
kopieren und im „Term Lists“-Fenster über Rechtsklick > Paste
einzufügen. 
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Merke: Änderungen der Term List wirken sich nicht auf einzelne 
Referenzen aus, d.h. einzelne Referenzen behalten etwa ihre 
Schlagwörter bzw. Autoren oder Zeitschriftentitel auch dann bei, 
wenn du den entsprechenden Eintrag aus der Term List entfernt 
oder ihn verändert hast. Wie du verfahren solltest, um alle Refe-
renzen in einem Schritt zu editieren, siehst du im nächsten 
Abschnitt.

Mehr Informationen zum Umgang und zur Pflege von Term Lists 
erfährst du in Kapitel 7 und wenn du in EndNote auf Help > 
Contents > Inhalt > Term Lists klickst. 

Schlagwörter ändern
Beim Schreiben einer wissenschaftlichen Arbeit wirst du oft mit 
der Situation konfrontiert, dass eine stärkere Differenzierung von 
Begriffen nötig ist. So kann es beispielsweise zunächst ausrei-
chend gewesen sein, Literatur zum Thema „politische Parteien“ 
mit dem Schlagwort „Parteien“ zu versehen. In einer fortgeschrit-
tenen Arbeitsphase muss man dann Begriffe wie „Massenpartei“, 
„Kaderpartei“ und „professionelle Wählerpartei“ als Unterkatego-
rien von politischen Parteien einführen, wenn sich einzelne Publi-
kationen explizit mit diesen Unterkategorien beschäftigen und 
man auch in seinen Studien diese Differenzierung gerne 
vornehmen möchte.

Damit geht einher, dass man bestimmten Referenzen neue 
Schlagwörter vergeben muss. Dazu musst du in EndNote nicht 
jede einzelne Referenz ändern, sondern du kannst ausge-
wählten Referenzen auf einmal das gewünschte Schlagwort 
zuweisen. Dabei wird das neue Schlagwort an bereits vorhan-
dene Schlagwörter angehängt. 

Schlagwort ersetzen 
(Change Text)

Falls du irgendwann ein Schlagwort aus deiner „Lernwelt‟ und 
konsequenterweise aus deiner EndNote-Datenbank entfernen 
oder aber umbenennen möchtest, steht dafür in EndNote eine 
entsprechende Funktion zur Verfügung.

Merke: Globale Änderungen, wie durch die Funktionen Change 
Text und Change and move field gelten immer für alle ange-
zeigten Referenzen einer Gruppe. Wenn du also ein bestimmtes 
Schlagwort bei allen Referenzen ändern möchtest, musst du 
vorher All References anwählen. Falls du nur die Schlagwörter 
einer bestimmten Gruppe ändern möchtest, musst du die jewei-
lige Gruppe markieren. Falls du ausgewählte Referenzen ändern 
möchtest, musst du mit gedrückter Strg-Taste die Referenzen 
markieren und über Rechtsklick > Show Selected References
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wählen, um dir nur die ausgewählten Referenzen anzeigen zu 
lassen.

Schritt 1

Unter Edit > Change Text... wählst du das Feld Keywords aus.

Schritt 2

Unter Search for gibst du an, welcher Begriff geändert werden 
soll. Unter Change the text to gibst du einen neuen Begriff ein, 
der den zu ändernden Begriff ersetzen soll. Achte auch hier 
darauf, mehrere Begriffe mit einem Semikolon oder durch einen 
Zeilenumbruch voneinander zu trennen. Nutze dazu das Drop-
down-Menü Insert Special. Falls du den Platz leer lässt, wird 
das Schlagwort gelöscht. Wenn du nun auf Change klickst, 
werden die Änderungen wirksam.

Auf diese Weise lassen sich übrigens nicht nur Schlagwörter 
ändern, sondern die Inhalte aller Felder.

Schlagwörter 
hinzufügen

Wie du Referenzen mit neuen Schlagwörtern versehen kannst, 
siehst du in der folgenden Anleitung:

Schritt 1

Gruppe auswählen oder Referenzen mit gedrückter Strg-Taste
markieren und mit der rechten Maustaste Show Selected Refe-
rences auswählen.
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Schritt 2

Unter Tools > Change and Move Fields... auswählen. 

Schritt 3

Im Reiter Change Fields das Datenbankfeld auswählen, in das 
ein Begriff hinzugefügt werden soll. Insert after field's text
auswählen und in das Eingabefeld einen am Anfang und am 
Ende mit Semikolon getrennten Begriff eingeben. Neue 
Keywords müssen mit Semikolon von evtl. vorhandenen 
Keywords abgetrennt werden. Auf OK klicken.
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EndNote-Datenbank auf doppelte Einträge hin durchsu-
chen

Manchmal kann es passieren, dass du ein und denselben Buch- 
oder Aufsatztitel mehrmals in deine EndNote-Datenbank impor-
tierst. Um die Datenbank von Redundanzen frei zu halten, gibt es 
in EndNote die Dublettenkontrolle.

Um die Datenbank auf doppelte Einträge zu prüfen, klicke zuerst 
auf All References, um gleich die gesamte Datenbank durchsu-
chen zu lassen. Klicke dann in der oberen Menüleiste auf Refe-
rences > Find Duplicates.
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EndNote startet die Dublettenkontrolle und gibt dir Rückmeldung, 
ob doppelte Einträge gefunden wurden. Ein Datensatz wird als 
Dublette erkannt, wenn Autor, Jahr, Titel und Referenztyp mit 
einem in der Datenbank bereits enthaltenen Datensatz überein-
stimmen. Unter Edit > Preferences kannst Du unter dem Punkt 
Duplicates diese Kriterien verändern. 

Dubletten werden nicht erkannt, wenn sie bei den Titelangaben 
abweichen, was bei unterschiedlichen Quellen passieren kann 
(z.B. wird bei einer Quelle im Titel der Titelzusatz angegeben und 
bei der anderen nicht). Orientiere dich in diesem Fall auf Autor-
namen und Titelanfang in der Übersicht deiner Referenzen, um 
Dubletten zu finden und zu löschen. Sollte EndNote einen 
doppelten Eintrag finden, bekommst du die Möglichkeit, einen 
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der beiden Einträge zu behalten; der doppelte Eintrag wird 
daraufhin automatisch in den Papierkorb verschoben. Einen 
Hinweis auf das „Alter‟ der jeweiligen Referenz bietet dir die 
Record Number (#) und der Datumsstempel unter Added to 
Library und Last Updated.

Nicht immer ist es jedoch sinnvoll, die zuletzt hinzugefügte Refe-
renz zu löschen. Es kann sein, dass du gerade diese Referenz 
um zusätzliche Schlagwörter ergänzt und/oder in Word zitiert 
hast. Würdest du sie löschen, gingen sowohl die Schlagwörter 
als auch die Verknüpfung zwischen dem Word-Dokument und 
der jeweiligen Referenz verloren. Es gilt nämlich folgendes:

1) Beim Einfügen in ein Worddokument wird eine Verknüpfung 
zwischen Datensatz und Word-Dokument aufgebaut.

2) Zum Aktualisieren und ggf. zum Korrigieren ist es notwendig, 
den zitierten Datensatz in der Datenbank zu haben.

3) Daraus folgt, dass man grundsätzlich keine Datensätze in der 
Datenbank löschen sollte, die man schon zitiert hat.

Wenn du am Zitat in Microsoft Word etwas änderst und die benö-
tigte Information nicht aus den Metadaten innerhalb des jewei-
ligen Word-Dokuments (mehr zur „Traveling Library“ in Kapitel 8 
> Referenzen aus Word-Dokumenten in eine EndNote-Daten-
bank importieren ab Seite 173) geholt werden kann, stellt das 
Programm eine Verknüpfung zur nicht gelöschten Dublette her, 
ändert also auch die zugehörige „Record Number“.

Vergleiche die beiden Referenzen genau und überprüfe im 
Word-Dokument anhand der „Record Number“, auf welche Refe-
renz verwiesen wird. Diese findest du, wenn du mit der Maus 
über das Zitat drüberfährst. Mehr zur Arbeit mit Microsoft Word in 
Kapitel 4 ab Seite 71.
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Merke: Doppelte Einträge kannst du schon bei der Übernahme 
in deine EndNote-Datenbank vermeiden, wenn du bibliografi-
sche Angaben mittles Textdateien, die du vorher aus Katalogen 
oder Online-Datenbanken exportierst, über die Import-Funktion 
in EndNote einfügst. Dabei musst du im Import-Menü die Option 
Discard Duplicates auswählen. (siehe Screenshots in Kapitel 2 
> Import von Treffern aus (über-)regionalen Katalogen ab 
Seite 43)

Mehr Informationen zur Dublettenkontrolle und Vermeidung 
doppelter Einträge findest du auf den Hilfeseiten in EndNote 
unter Help > Contents > Inhalt > Searching and Sorting in 
EndNote > Finding Duplicate References.

Referenzen in der Datenbank finden
Es gibt zwei Möglichkeiten, mit denen du deine EndNote-Daten-
bank durchsuchen kannst. 

Schnellsuche (Quick 
Search)

Die Schnellsuche (Quick Search) in der Symbolleiste durchsucht 
die gesamte Datenbank und alle Felder nach dem eingegebenen 
Suchbegriff, wobei auch Wörter gefunden werden, die diese 
Zeichenfolge enthalten, aber mit dem gesuchten Begriff nicht 
übereinstimmen. Suchst du beispielsweise nach „Hund“, erhältst 
du unter anderem auch Treffer, in denen der Begriff „Jahrhun-
dert“ vorkommt. Es werden beispielsweise auch die Referenzen 
angezeigt, die den Suchbegriff in ihrer Kurzzusammenfassung 
(Abstract) oder in den Notizen (Notes) stehen haben. Die 
Schnellsuche ist dann sinnvoll, wenn du genau weißt, was du 
suchst, z.B. wenn du eindeutige Schlagwörter vergeben hast.

Suchmaske (Search) Für eine differenziertere Suche ist in EndNote eine Suchmaske 
integriert, mit der die Recherche nach Begriffen in bestimmten 
Datenbankfeldern möglich ist. 

Diese Suche ist immer empfehlenswert, da sie alle Möglichkeiten 
wie die Quick Search (any field) und darüber hinaus noch mehr 
anbietet.

1) Die Term Lists sind eine sehr wichtige Hilfe bei der schnellen 
Suche nach Begriffen. Auch bei 10 Referenzen bietet dir die 
Nutzung der Term Lists einen Zugriff auf die vergebenen 
Keywords oder die existierenden Autoren. Allein aus diesem 



Kapitel 3 – Literaturangaben verwalten

67

Grund ist die Suche über diese Suchmaske immer zu 
empfehlen.

2) Es können Smart Groups per Klick erstellt werden! (Options 
> Convert to Smart Group)

3) Es kann u.a. im Inhalt von PDFs gesucht werden (Suchkrite-
rium: Any Field + PDF oder PDF).

Es kann zum Beispiel nach einem bestimmten Schlagwort 
(Keyword) oder einer Zeitschrift (Journal) gesucht werden. 
Möglich ist auch eine kombinierte Recherche nach Schlagwort 
und Zeitschriftentitel, z.B. „Textanalyse‟ und „Journal of English 
Linguistics‟. Es werden dann nur diejenigen Referenzen ange-
zeigt, die als Schlagwort „Textanalyse‟ und als Zeitschriftentitel 
„Journal of English Linguistics‟ aufweisen. Bei der Suche kann 
die „Term List“ des jeweiligen Datenbankfelds (Term Lists sind 
für folgende Datenbankfelder vorhanden: Author, Journal und 
Keywords) hilfreich sein, um recherchierbare Begriffe schnell zu 
finden. Um diese aufzurufen, musst du das jeweilige Datenbank-
feld in der Suchmaske auswählen und den Cursor in das Einga-
befeld setzen. Über die Tastenkombination Strg+1 wird die Term 
List eingeblendet.

Außerdem kannst du im Feld last updated und etwa dem 
Operator greater than suchen, um Referenzen anzeigen zu 
lassen, die nach einem bestimmten Datum verändert wurden.
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Merke: Bei Eingabe mehrerer Suchbegriffe in einer Zeile der 
Suchmaske findet eine Phrasensuche statt, d.h. es wird nach der 
genauen Wortfolge gesucht. So wird der Titel „Verfassung und 
Verfassungsvertrag. Konstitutionelle Entwicklungsstufen in den 
USA und der EU“ nicht gefunden, wenn man im Titel nach 
„Verfassung USA“ sucht. Stattdessen müssen die beiden Such-
begriffe in zwei Suchzeilen aufgeteilt und mit AND verknüpft 
werden.

Boolesche Operatoren nutzen
Nutze für eine präzise Suche in der EndNote-Datenbank die 
Booleschen Operatoren AND, OR und NOT. 

AND-Verknüpfung Beide Begriffe (A und B) müssen vorkommen.

z.B.: „Partei“ + „Organisation“

OR-Verknüpfung Mindestens einer der Begriffe muss vorkommen.

z.B.: „Partei“ oder „Organisation“
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NOT-Verknüpfung Nur Begriff A, nicht Begriff B muss vorkommen.

z.B.: „Partei“ und nicht „Organisation“

Im folgenden Video 3.2 siehst du, wie man in EndNote eine 
Recherche nach erfasster Literatur (Referenzen) über die Such-
maske durchführt.

Video 3.2: Referenzen in der Datenbank finden

ZUSAMMENFASSUNG In diesem Kapitel hast du gelernt,

 MindMaps mit Schlagwörtern als eine Art Landkarte für deine 
Literatursammlung zu nutzen

Übung: 

1) Erstelle in deiner EndNote-Datenbank einen neuen Group 
Set mit dem Namen „Hausarbeit Anglistik‟

2) Erstelle zwei Custom Groups mit den Namen „Theorie‟ und 
„Primärquellen‟ unter dem vorher erstellten Group Set und 
ordne ihnen einige Referenzen zu.
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 Die Keyword- und Groups-Funktion von EndNote zur Struktu-
rierung deiner Literatursammlung zu verwenden

 Mehrere Referenzen in EndNote in einem Schritt zu editieren

 Doppelte Einträge automatisch entfernen zu lassen
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Kapitel 4 – Literatur zitieren

LERNZIELE In diesem Kapitel lernst du,

 Was eine wissenschaftliche Arbeit ausmacht

 Was Zitiermethoden und Zitierstile in EndNote sind

 Zwischen statischen und dynamischen Literaturverzeich-
nissen zu unterscheiden

 Literaturverzeichnisse in unterschiedlichen Formaten aus 
EndNote zu exportieren oder zu drucken

 EndNote in Kombination mit Microsoft Word zu verwenden

Situation

Nun hast du die Literatur erfasst und ausgewertet und möchtest 
endlich die Hausarbeit bzw. das Referat schreiben. Deine 
Dozenten erwarten von dir, dass du deine Ausführungen mit 
Quellenangaben im Text oder in einer Fußnote sowie einem 
einheitlichen Literaturverzeichnis am Ende belegst. Ärgerlich ist, 
dass häufig im gleichen Fach unterschiedliche Anforderungen 
bzw. ein anderer Zitierstil verlangt werden. 

Genau hier liegt aber eine Hauptstärke von EndNote. Hier musst 
du dir keine Gedanken machen, ob der richtige Zitierstil einge-
halten wird. Du erfragst den benötigten Zitierstil, stellst diesen ein 
und alles andere macht EndNote für dich. Du kannst dich auf den 
Inhalt bzw. den Text deiner Arbeit konzentrieren, das Literatur-
verzeichnis wird automatisch korrekt angelegt. 

Allerdings ist es trotzdem wichtig, dass du die grundlegenden 
Methoden und Stilrichtungen des Zitierens kennst, damit du die 
passenden Zitierstile schneller findest und effizient nutzt.

Was ist eine wissenschaftliche Arbeit?
Eine wissenschaftliche Arbeit ist ein systematisch gegliederter 
Text, in dem ein Wissenschaftler das Ergebnis seiner eigenstän-
digen Forschung darstellt. Die Ergebnisse der Arbeit sind dabei 
für jeden anderen objektiv nachvollziehbar oder wiederholbar. 
Das bedeutet, dass Informationsquellen offengelegt, empirische 
Untersuchungen so beschrieben werden, dass sie reproduziert 
werden können. Wer eine wissenschaftliche Arbeit liest, kann 
stets erkennen, aufgrund welcher Fakten und Forschungsergeb-
nisse der Autor zu seinen Schlussfolgerungen gekommen ist und 
auf welche anderen Wissenschaftler er sich beruft.
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Wozu wissenschaftlich zitieren?
Das wissenschaftliche Zitieren dient dem Schutz des geistigen 
Eigentums bzw. vor dem Plagiat. Durch ein wörtliches oder sinn-
gemäßes Zitat soll der Urheber bzw. die Quelle einer Information 
nachvollziehbar angegeben werden. Damit wird weiterhin belegt, 
dass man sich mit dem Thema umfassend beschäftigt und die 
relevanten Quellen zur Kenntnis genommen hat. Der Leser muss 
nachprüfen können, woher die Aussagen stammen und ob sie 
inhaltlich richtig übernommen wurden. Diese Informationen sind 
ein wichtiger Bestandteil für die Kooperation zwischen den 
Wissenschaftlern. Zitate sind Belegstellen beim Argumentieren 
und beim Interpretieren.

Zitiermethoden und Zitierstile in EndNote

Zitiermethoden Bestimmt bist du schon unterschiedlichen Zitiermethoden 
begegnet. Es werden im Allgemeinen drei Zitiermethoden unter-
schieden: Nachweis von Quellen im Fließtext, über ein 
Nummernsystem und mittels Fußnoten.

Fließtext: Dies ist ein Beispiel (Meier 1956). (+ vollständige 
Quellenangabe im alphabetischen Literaturverzeichnis)

Nummernsystem: Dies ist ein Beispiel [43]. (+ vollständige 
Quellenangabe im nummerierten Literaturverzeichnis)

Fußnoten: Dies ist ein Beispiel³. (+ vollständige Quellenangabe 
in der Fußnote)

Die ersten zwei Methoden sind insofern vergleichbar, als bei 
beiden der Verweis auf die Quelle direkt im Text erfolgt. Der 
Quellennachweis in Fußnoten unterscheidet sich nur dadurch, 
dass hierbei im Text lediglich eine hochgestellte Zahl erscheint, 
die auf eine Fußnote verweist, in der die Literaturangabe 
gemacht wird. In Abhängigkeit vom Zitierstil (Output Style) wird 
ein Literaturverzeichnis erstellt oder es erfolgt eine Beschrän-
kung auf die Angaben in den Fußnoten.

Zitierstile (Output Styles) Neben den Zitiermethoden existieren auch Zitierstile; sie sind 
den Zitiermethoden untergeordnet. Sie sind eine Art Schablone, 
die festlegt, wie die Reihenfolge der einzelnen Elemente (Daten-
bankfelder und ihrer Inhalte) und die Zeichensetzung zwischen 
diesen Elementen in der Quellenangabe (im Text, in der Fußnote 
oder im Literaturverzeichnis) ist:

z.B. Swan, Michael (2005): Practical English Usage. Oxford.
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oder:

Swan, Michael: Practical English Usage. Oxford University 
Press, 2005.

Außerdem legt ein Zitierstil fest, ob mehrere Autoren gegebenen-
falls mit „et al.‟ abgekürzt oder statt des deutschen „Hrsg.‟ 
(Herausgeber) das englische „Ed.‟ (Editor) verwendet werden 
sollen.

In EndNote wird eine Vielzahl von Zitierstilen mitgeliefert. Hier ist 
ein kleiner Überblick der Zitierstile ausgehend von der jeweiligen 
Zitiermethode:

Welche Zitiermethode 
und welchen Zitierstil 
soll man wählen?

Welche Zitiermethode und welchen Zitierstil du verwenden soll-
test, hängt einerseits von deinem Studienfach und andererseits 
von den Vorgaben deines Professors ab. Es empfiehlt sich, die 
selbstständigen Veröffentlichungen des Professors, also seine 
Monografien, im Hinblick auf den verwendeten Zitierstil zu 
konsultieren. Wenn du einen Artikel für eine wissenschaftliche 
Zeitschrift verfasst, dann richtet sich der Zitierstil nach den Zitier-
vorschriften dieser Zeitschrift. An manchen Instituten gilt allge-
mein der Zitierstil einer bestimmten Zeitschrift.

Diese Zitierrichtlinien, auch Autorenrichtlinien genannt, deckt 
EndNote mit den sogenannten Output Styles ab. 

Mit EndNote werden über 4.500 Output Styles für die wichtigsten 
Styles mitgeliefert. Ist ein Style nicht vorhanden, kann er 
entweder selbst erstellt oder beim Hersteller angefordert werden. 

In den vorigen Kapiteln hast du gesehen, wie Literaturdaten in 
EndNote aufgenommen werden, etwa durch manuelle Eingabe 
oder Export aus einem Katalog. Das folgende Schema zeigt dir, 
wie aus „Rohdaten“ durch Auswahl eines Zitierstils Literaturver-

Zitiermethode Zitierstil

Fließtext Harvard

Author-Date

APA 6th

Turabian

Numerisch Vancouver

Numbered

Fußnote Chicago 15th A

MLA
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weise werden. Achte auf die Unterschiede in den Templates des 
jeweiligen Zitierstils.

EndNote erstellt aus den (Roh-)Daten und in Abhängigkeit vom 
jeweiligen Zitierstil ein In-Text-Zitat und am Ende des Dokuments 
das Literaturverzeichnis. Dabei kann sich die Ausgabe für jeden 
Referenztyp (Reference Type) unterscheiden (siehe Kapitel 1 ab 
Seite 17).

Je nach Stil werden jetzt die einzelnen Daten in der definierten 
Reihenfolge und Formatierung ausgegeben.

Harvard gibt bspw. in der Literaturliste das Erscheinungsjahr 
direkt nach dem Autor aus. Vancouver hingegen gibt das 
Erscheinungsjahr erst am Ende der Literaturangabe aus. 

Das heißt, die Ausgabe der Daten hängt von den Daten, dem 
Referenztyp und vom verwendeten Stil ab. Im Folgenden lernst 
du einige wichtige Stile kennen.

In der Abbildung oben handelt es sich um eine Monografie (Refe-
renztyp: Book). Aufsätze in Zeitschriften oder in Sammelbänden, 
elektronische Dokumente, E-Books und andere Literatur- und 
Dokumenttypen werden innerhalb eines Zitierstils über die 
Templates genau definiert, so dass die Ausgabe der EndNote-
Rohdaten referenztypspezifisch erfolgen kann. Weitere Details 
dazu, wie Zitierstile geändert werden und was man über Temp-
lates wissen sollte, findest du in Kapitel 6 ab Seite 123.
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Du musst keine eigenen Zitierstile erstellen. Die Auswahl an 
mitgelieferten Stilen ist sehr umfangreich. Es werden 4.500 
Zitierstile mitgeliefert, aber bei der Standardinstallation nur die 
hundert wichtigsten installiert. Möchtest du weitere Zitierstile 
installieren, folge den Anleitungen im Anhang unter Custom 
Installation auf Seite 199. 

Folgende vier Zitierstile werden als Favoriten angezeigt:

Annotated - alphabetische Autor-Datum-Bibliografie mit Abstracts ermög-
licht die Ausgabe der Referenzen mit Inhaltsangaben oder selbst 
erstellten Auswertungen

Author-Date - alphabetische Autor-Datum-Bibliografie sortiert die Referenzen 
nach Autor und Erscheinungsjahr in Anlehnung an den Harvard-
Zitierstil
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Numbered - nummerierte Bibliografie mit nummerierten Literaturverweisen 
im Fließtext in Anlehnung an den im naturwissenschaftlich-medi-
zinischen Bereich üblichen Vancouver-Zitierstil

Show All Fields - Liste mit Referenzen, so wie sie in die Datenbank eingegeben 
wurden. Es werden alle belegten Datenbankfelder und ihre 
Bezeichnung ausgegeben. Dieser Output Style ist insbesondere 
für Kontroll- und Übersichtsarbeiten an der eigenen Datenbank 
geeignet, z.B. über die Preview-Funktion

Zu den voreingestellten Favoriten können weitere mitgelieferte 
Zitierstile (Output Styles) im Style Manager aktiviert werden. Den 
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Style Manager findest du unter Edit > Output Styles > Open 
Style Manager.... 

Im Style Manager kannst du diejenigen Stile markieren, die im 
Drop-Down-Menü zur Schnellauswahl als Favoriten erscheinen 
sollen. Du kannst über den Button Style Info / Preview eine 
Vorschau des Zitierstils anzeigen lassen. Durch Anklicken der 
Leiste Category werden die Zitierstile alphabetisch nach 
Fächern geordnet, was dir das Auffinden und die Auswahl des 
passenden Zitierstils erleichtert.
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Im folgenden Video 4.1 siehst du, wie man einen Zitierstil im Style 
Manager auswählt und ihn zu den Favoriten hinzufügt.

Video 4.1: Einen Zitierstil im Style Manager auswählen und zu den Favoriten hinzu-

fügen

Solltest du keinen geeigneten Zitierstil finden, liegt es möglicher-
weise daran, dass du ihn bei der Programminstallation nicht akti-
viert hast. Schau dir dazu zunächst die Installationsanleitung im 
Anhang an. Falls der gesuchte Zitierstil erst kürzlich zur Style 
Liste hinzugefügt wurde, kannst du nach ihm auf der Homepage 
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von EndNote suchen, zu der du über den Button Get More on the 
Web... gelangst (siehe Screenshot oben). Dort stehen circa 4500 
Zitierstile unterschiedlichster Disziplinen zur Verfügung. Du 
kannst auch direkt bei Adept Scientific nach dem gesuchten 
Zitierstil fragen (siehe unter Support und weitere Informationsma-
terialien auf Seite 197). Darüber hinaus lassen sich vorhandene 
Zitierstile auch modifizieren und somit den eigenen Anforde-
rungen anpassen. Weitere Informationen zu Zitierstilen findest 
du in Kapitel 6 ab Seite 123.

Verknüpfung mit Textverarbeitungsprogrammen
Um die gewünschten Zitierstile nutzen zu können, ist es eine 
Voraussetzung, dass eine Verknüpfung zwischen EndNote und 
dem Textverarbeitungsprogramm besteht und die benutzten 
Zitierstile installiert sind. Diese Verknüpfung ist über ein Add-in, 
die so genannte CWYW-Funktion (Cite While You Write) zu 
mehreren Textverarbeitungsprogrammen (Microsoft Word, Open 
Office für Windows, Pages für Mac) gewährleistet. 

Wenn du also auf zwei Rechnern an einem Word-Dokument 
arbeiten möchtest, achte darauf, dass immer dieselbe zugehö-
rige EndNote-Datenbank geöffnet ist und die verwendeten Zitier-
stile auf jedem Rechner installiert sind. Fehlt ein Zitierstil, musst 
du ihn in den Output Styles-Ordner von EndNote einfügen. Du 
findest diesen Ordner in deiner EndNote-Installation unter dem 
Namen „Styles“ (siehe auch Kapitel 6 im Abschnitt Zusätzliche 
Zitierstile herunterladen auf Seite 124). 

Mehr Informationen zum Austausch von EndNote-Datenbanken 
und Word-Dokumenten findest du in Kapitel 8 ab Seite 171.

In den folgenden Abschnitten steht die Arbeit mit Microsoft Word 
im Vordergrund.

Zitieren in Microsoft Word
Um das Zitieren zu ermöglichen, ist in EndNote das Tool Cite 
While You Write (CWYW) integriert. Dieses Tool erscheint in 
Microsoft Word nach der EndNote-Installation in Form eines 
Reiters (siehe Screenshots unten). Falls dieser Reiter nicht 
geladen wird, obwohl du EndNote installiert hast, folge den 
ausführlichen Anleitungen zur Einrichtung des CWYW-Tools im 
Abschnitt „Manuelle Anbindung an Microsoft Word“ in der Instal-
lations- und Konfigurationsanleitung unter http://
www.endnote.de/instwin (Windows) und http://www.endnote.de/
instmac (Mac).)
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Im Folgenden siehst du eine Schritt für Schritt Anleitung zum 
Zitieren in Microsoft Word 2010.

Schritt 1

Cursor an die Stelle setzen, an der das Zitat eingefügt werden 
soll.

Merke: Wenn das Zitat in der Fußnote erscheinen soll, dann 
musst du in Microsoft Word zunächst eine Fußnote einfügen und 
den Cursor in der Fußnote platzieren.

Schritt 2

In der EndNote-Symbolleiste auf Find Citation(s) klicken. Bei 
diesem Schritt muss die EndNote-Datenbank, aus der die Refe-
renz übernommen werden soll, geöffnet sein.
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Schritt 3

Es erscheint ein Fenster, in dem du nach Referenzen aus der 
geöffneten Datenbank mittels Stichwörtern, Autorennamen, 
Publikationsjahren usw. suchen kannst.

Schritt 4

Nachdem du die gewünschten Referenz(en) markiert hast, 
klickst du auf Insert. Daraufhin erscheint je nach gewählter Zitier-
methode der Literaturverweis. 

Achte darauf, dass du bei einem Zitierstil, der mit Fußnoten 
arbeitet, zunächst in Word an gewünschter Stelle eine Fußnote 
einfügen musst (Strg+Alt+F), in die dann im nächsten Schritt 
der Literaturverweis platziert wird. Benutze beim Zitieren in 
Fußnoten einen passenden Zitierstil, z.B. MLA. Am Ende des 
Dokuments wird automatisch ein Literaturverzeichnis erstellt 
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bzw. aktualisiert, sofern dies im jeweiligen Fußnoten-Zitierstil in 
EndNote festgelegt ist.

Merke: Alternativ kann eine Referenz auch über die Funktion 
Insert Citation direkt aus EndNote an der Cursor-Position in das 
Word-Dokument eingefügt werden. Dazu wechselst du in die 
EndNote-Datenbank, selektierst die entsprechende(n) Refe-
renz(en) und klickst auf den Button Insert Citation. Auf diese 
Weise kannst du deine Gruppenstruktur optimal nutzen.

Schritt 5

Der Literaturverweis wird in dem Zitierstil dargestellt, den du in 
Word im Zitierstil-Dropdown-Menü ausgewählt hast. Falls du 
nachträglich einen anderen Zitierstil wählen möchtest, musst du 
in Word in der EndNote-Symbolleiste aus dem Zitierstil-Drop-
down-Menü den gewünschten Zitierstil auswählen. Achte darauf, 
dass dabei deine EndNote-Datenbank geöffnet ist.

Nach dem Einfügen von Referenzen in Microsoft Word bzw. bei 
einem Klick auf den Button Update Citations and Bibliography
in einem Word-Dokument mit bereits eingefügten Referenzen 
erscheint in EndNote eine automatische Gruppe, in der dieje-
nigen Referenzen angezeigt werden, die im jeweiligen Word-
Dokument verwendet werden. Der Gruppenname entspricht dem 
Dateinamen des Word-Dokuments. In der Gruppe werden nur 
diejenigen Referenzen angezeigt, die mit der geöffneten 
EndNote-Datenbank in das Word-Dokument eingefügt wurden. 
Referenzen, die aus anderen Datenbanken stammen, werden 
nicht angezeigt.
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Bei der Bearbeitung von Zitaten im Text sind Besonderheiten zu 
beachten, die im Folgenden dargestellt werden.

Zitate im Text bearbeiten und löschen

Referenzen und 
Literaturliste editieren 
und aktualisieren

Bei den eingefügten Referenzen handelt es sich um „aktive 
Elemente‟ oder im Fachjargon „Feldfunktionen‟. Diese Feldfunk-
tionen können nicht wie gewöhnlicher Text in Microsoft Word 
geändert werden. Sie sind verknüpft mit der EndNote-Daten-
bank, aus der du den jeweiligen Literaturverweis exportiert hast. 
Wenn du also merkst, dass der Autor oder Titel falsch 
geschrieben wurde, musst du entsprechende Korrekturen in 
deiner EndNote-Datenbank vornehmen. Hierzu klickst Du auf 
das zu korrigierende Zitat im Text und klickt auf Edit Library 
Reference(s). Dadurch wird die entsprechende Referenz in 
EndNote zur Bearbeitung geöffnet. Nach dem Abspeichern der 
Veränderungen in der Datenbank kannst du eine Aktualisierung 
des Dokuments durchführen, indem du in Word 2003 in der 
EndNote-Symbolleiste auf Format Bibliography und OK klickst; 
ab der Word-Version 2007 genügt ein Klick auf Update Citations 
and Bibliography.

Referenzen editieren 
(Edit & Manage 
Citation(s))

In einigen Disziplinen ist es notwendig, bei wörtlichen Zitaten die 
Seitenzahl im Text anzuführen, z.B. (Maier 2010: S. 198). Bei 
indirekten Zitaten sind ggf. Zusätze wie „Vgl.‟ (vergleiche) oder 
„siehe auch... ‟ notwendig. Da diese Angaben nicht per Hand in 
die Referenz (graue Felder) geschrieben werden können, gibt es 
zu diesem Zweck die Funktion Edit & Manage Citation(s). 
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Du kannst einzelne Referenzen editieren, indem du die jeweilige 
Referenz im Word-Dokument zunächst auswählst und dann auf 
Edit & Manage Citation(s) in der EndNote-Symbolleiste klickst. 

Es erscheint ein neues Fenster (siehe Screenshot unten), in dem 
du die gewünschten Änderungen vornehmen kannst. Du kannst 
hier einstellen, ob der Autor oder das Jahr angezeigt werden soll 
oder nicht (Exclude Author bzw. Year). Das kann dann nützlich 
sein, wenn du mehrere Werke eines Autors zitierst, z.B. (Maier 
2005: S. 123; 2007: S. 12; 2010: S. 198). 

Unter den Punkten „Prefix“ und „Suffix“ kannst du Text einfügen, 
der vor oder nach der Literaturangabe stehen soll, wie zum 
Beispiel „Vgl.“ und weitere Kommentare. 

Bei „Pages“ kannst du auch die Seiten angeben, die du speziell 
in diesem Dokument zitierst. Allerdings wird das standardmäßig 
nur mit bestimmten Zitierstilen angezeigt, beispielsweise APA 
6th. Dies ist ein weit verbreiteter Stil aus der Psychologie der 
American Psychological Association. Er zeigt entsprechend der 
englischen Zitiergepflogenheiten ein „p.“ als Abkürzung für 
„page“ an. Möchtest du die deutsche Abkürzung „S.“ für Seite 
haben, musst du den Zitierstil anpassen. 
Orientiere dich dabei am Zitierstil APA 6th. Wie du im Screenshot 
siehst, wurde im Pages-Eingabefeld nur die Zahl „22“ ohne „S.“ 
angegeben. Im Word-Dokument erscheint trotzdem die volle 
Angabe (S. 22), weil dies im Zitierstil (Output Style) entsprechend 
definiert ist. Mehr dazu erfährst du in Kapitel 6 ab Seite 123.
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Merke: Mit Hilfe von Leerzeichen kannst du zwischen dem Inhalt 
des Prefix- oder eines anderen Feldes und dem Autornamen/ 
Jahr einen Abstand setzen. Leerzeichen können sowohl an den 
Anfang als auch ans Ende gesetzt werden.

Referenz erweitern 
(Insert Citation)

Manchmal kann es wichtig sein, einen bestimmten Gedanken 
durch mehrere Autoren zu belegen. Wenn du nachträglich zu 
einem Literaturverweis eine zusätzliche Referenz hinzufügen 
möchtest, wählst du im Text den zu ergänzenden Literaturver-
weis aus, klickst auf Edit Citation(s) und unter Edit Reference auf 
Insert Citation.
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Referenzen entfernen 
(Remove Citation)

Lösche Referenzen immer über die Funktion Edit & Manage 
Citation(s). Referenzen sind Feldfunktionen und können daher 
nicht per Hand bearbeitet werden. Mittels Remove Citation
kannst du einzelne Referenzen löschen. Nur so ist das Löschen 
einer einzelnen Referenz aus einem Sammelzitat möglich.

Merke: Literaturverweise im Word-Dokument können nicht wie 
gewöhnlicher Text verändert werden! Ändere die Angaben 
entweder in deiner EndNote-Datenbank oder editiere den Litera-
turverweis über Edit & Manage Citation(s) in der EndNote-
Symbolleiste. 

Im folgenden Video 4.2 siehst du, wie aus Microsoft Word heraus 
die EndNote-Datenbank durchsucht werden kann, wie Refe-
renzen als Zitat übernommen werden, ein einzelnes Zitat bear-
beitet und der Zitierstil geändert werden kann.
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Video 4.2: Referenzen als Zitat in Microsoft Word übernehmen, ein einzelnes Zitat 

bearbeiten und den Zitierstil ändern

Formatieren des 
Literaturverzeichnisses

Das automatisch erstellte Literaturverzeichnis lässt sich nicht wie 
gewöhnlicher Text formatieren. Um die Schriftart, die Überschrift 
sowie die Zeilenabstände des Literaturverzeichnisses zu modifi-
zieren, gehst du wie folgt vor.

Schritt 1

Im Word-Dokument in der EndNote-Symbolleiste das Fenster 
Bibliography Preferences öffnen.
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Schritt 2

In diesem Fenster den Reiter Layout auswählen. Nun kannst du 
festlegen, welche Schriftart und Schriftgröße und welche Über-
schrift verwendet werden sollen. Darüber hinaus kannst du die 
Abstände zwischen den Referenzen einstellen. 

Schritt 3

Wenn du auf OK klickst, wird das Literaturverzeichnis entspre-
chend deinen Einstellungen aktualisiert. 

Instant formatting bei 
längeren Dokumenten 
abschalten

Je umfangreicher ein Word-Dokument wird, umso länger kann 
das Einfügen einer formatierten Referenz dauern. Bei wirklich 
umfangreichen Dokumenten, beispielsweise einem Buch mit 
vielen Abbildungen, kann es sinnvoll sein, die automatische 
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Formatierung (Instant Formatting) von neu eingefügten Refe-
renzen auszuschalten. Gehe dazu wie folgt vor.

Schritt 1

 Öffne zunächst die Bibliography Preferences. 

Schritt 2

Wähle nun den Reiter Instant Formatting aus und klicke auf den 
Button Turn Off. Bestätige die Auswahl mit OK.
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Schritt 3

Neue Referenzen werden nun unformatiert eingefügt. Du 
erkennst das an der geschweiften Klammer und der Angabe der 
Record Number (#).

Schritt 4

Um die eingefügten Referenzen zu formatieren und das Literatur-
verzeichnis zu aktualisieren, klicke in der EndNote-Symbolleiste 
auf Update Citations and Bibliography. Die EndNote-Daten-
bank muss dabei geöffnet sein, damit die entsprechenden biblio-
grafischen Angaben aus der Datenbank geholt werden können.

Merke: Führe am Ende der Arbeit an einem Word-Dokument 
immer den Befehl Update Citations and Bibliography aus. 
Solltest du in der EndNote-Datenbank den Autornamen oder das 
Jahr verändern und erst dann ein Update innerhalb des Word-
Dokuments durchführen, kann es dazu führen, dass unforma-
tierte Referenzen keiner Referenz in EndNote zugeordnet 
werden können. 
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Statischer Export von Literaturverzeichnissen aus 
EndNote

Im vorigen Abschnitt ging es um die Erstellung einer dynami-
schen Bibliografie in Microsoft Word. Sie ist deshalb dynamisch, 
weil sie über Feldfunktionen in Verbindung mit deiner EndNote-
Datenbank steht und bei deren Änderung automatisch aktuali-
siert wird.

Im Gegensatz zu einer dynamischen Bibliografie kann man auch 
direkt aus EndNote statische Bibliografien ausgeben. Diese 
können etwa dann nützlich sein, wenn man auf die Schnelle eine 
vorläufige Literaturliste zur Besprechung mit dem Professor 
erstellen möchte oder die verwendete Literatur in eine Power-
Point-Präsentation einfügen möchte. Eine statische Literaturliste 
zeichnet sich dadurch aus, dass sie keine Feldfunktionen hat und 
somit nicht mit der EndNote-Datenbank verknüpft ist.

Es gibt vier Möglichkeiten, um statische Literaturlisten zu 
erstellen.

Zwischenablage 
(Clipboard)

Zunächst markierst du die benötigten Referenzen in deiner 
EndNote-Datenbank. Um mehrere Referenzen zu markieren, 
musst du die Strg-Taste gedrückt halten. Über den Shortcut 
Strg+K kannst du die markierten Referenzen in die Zwischenab-
lage kopieren. Sie werden in dem Zitierstil kopiert, den du vorher 
in EndNote ausgewählt hast. Anschließend kannst du den Inhalt 
der Zwischenablage in einem beliebigen Programm einfügen, 
z.B. in einer E-Mail, in PowerPoint u.a
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Drucken (Print) Statt die markierten Referenzen in die Zwischenablage zu 
kopieren, kannst du sie auch über File > Print gleich ausdrucken. 
Wenn auf deinem Rechner ein virtueller PDF-Drucker installiert 
ist, kannst du die Literaturliste als PDF drucken. Die Referenzen 
werden in dem Zitierstil gedruckt, den du vorher in EndNote 
ausgewählt hast.

Export als Text-, Word- 
oder HTML-Datei

Mit der Export-Funktion, die du über File > Export... aufrufen 
kannst, lassen sich Literaturlisten sowohl im Textformat (*.txt und 
im Wordformat *.rtf) als auch im HTML-Format erstellen. Wie bei 
der Shortcut- und Drucken-Methode kannst du auch beim Export 
die jeweils markierten Referenzen exportieren. Aktiviere dazu im 
Exportfenster die Einstellung Export Selected References. Wenn 
du deine gesamte Bibliografie oder eine bestimmte Gruppe 
exportieren möchtest, reicht es, wenn du die entsprechende 
Gruppe im linken Navigationsfeld auswählst und dann auf Export 
klickst. Du musst in dem Fall die einzelnen Referenzen nicht 
mehr extra markieren.
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Nach Datenbankfeldern 
geordneter Export 
(Subject Bibliography)

Die Subject Bibliography fasst Abfrage und Ausgabe zusammen. 
Somit kannst du Literaturlisten nach unterschiedlichen Daten-
bankfeldern zusammenstellen lassen. Solche Datenbankfelder 
können alle Felder von EndNote sein, z.B. Autorname, Erschei-
nungsjahr oder Schlagwort. Du kannst dir auf diese Weise etwa 
eine Übersicht über Referenzen, die du mit bestimmten Schlag-
wörtern versehen hast, erstellen lassen. Gehe dazu wie folgt vor: 
Wähle zuerst die Gruppe aus, deren Referenzen berücksichtigt 
werden sollen. Wenn du deine gesamte Bibliografie nach 
bestimmten Datenbankfeldern filtern möchtest, wählst du konse-
quenterweise „All References‟ aus. Im nächsten Schritt klickst du 
auf Tools > Subject Bibliography. 
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Es öffnet sich ein Fenster, in dem du die Datenbankfelder fest-
legst, aus denen du bestimmte Begriffe wählen möchtest. Es 
können eines oder mehrere Datenbankfelder gewählt werden. 

Wenn du auf OK klickst, bekommst du eine Liste mit Begriffen 
angezeigt, die in der ausgewählten Gruppe diesem Datenbank-
feld zugeordnet wurden. Du kannst aus dieser Liste diejenigen 
Begriffe wählen, die in der exportierten Literaturliste als Ober-
punkte erscheinen sollen. In der Spalte # Records siehst du die 
Anzahl der einschlägigen Referenzen.
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Mit einem Klick auf OK wird dir eine Vorschau der Literaturliste 
angezeigt. Du kannst nun den Zitierstil festlegen, in dem die Lite-
raturliste ausgegeben werden soll. 

In diesem Video 4.3 siehst du, wie eine nach Themen geordnete 
Literaturliste erstellt wird.
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Video 4.3: Eine nach Themen geordnete Literaturliste erstellen

ZUSAMMENFASSUNG In diesem Kapitel hast du gelernt,

 Was eine wissenschaftliche Arbeit ausmacht

 Was Zitiermethoden und Zitierstile in EndNote sind

 Zwischen statischen und dynamischen Literaturverzeich-
nissen zu unterscheiden

 Literaturverzeichnisse in unterschiedlichen Formaten aus 
EndNote zu exportieren oder zu drucken

 EndNote in Kombination mit Microsoft Word zu verwenden

Übung: 

1) Öffne die Beispieldatenbank Paleo.enl/
Sample_Library_X4.enl. Du findest sie im Samples-Ordner 
(in der Regel unter C:/Programme/EndNote/Samples). 
Erstelle ein statisches Literaturverzeichnis im Textformat 
mit Referenzen der Zeitschrift „Journal of Paleontology‟. 
Tipp: Zeitschriften werden im Datenbankfeld „Secondary 
Title‟ geführt.

2) Öffne nun ein neues Worddokument und tippe einen Test-
satz ein. Füge aus der Beispieldatenbank folgenden Litera-
turverweis ein: (Chang 2002; Edwards 1997). 

3) Füge am Ende eines weiteren Testsatzes folgenden Litera-
turverweis ein und ergänze ihn um die Seitenangabe: 
(Alvarez 1984: S. 719)
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Kapitel 5 – Online-Datenbanken benutzen

LERNZIELE In diesem Kapitel lernst du,

 Die Struktur bibliografischer Online-Datenbanken kennen

 Recherchestrategien für eine effiziente und effektive Aufsatz-
suche anzuwenden

 Bibliografische Informationen aus unterschiedlichen Online-
Datenbanken in EndNote zu importieren

 Online-Datenbanken in EndNote zu integrieren

Situation

Am Ende des Studiums, vielleicht auch schon früher bei Hausar-
beiten, aber sicherlich in wissenschaftlichen Projekten genügt es 
nicht mehr, Grundlagenliteratur aus dem Buchangebot der 
Universitäts- oder Institutsbibliothek zu nutzen. Es wird erwartet, 
dass selbstständig neue Literatur zu einem Thema gefunden 
wird, um den aktuellen Forschungsstand zu ermitteln. 

Hier ist die Nutzung von bibliografischen Datenbanken unerläss-
lich. Dort werden von Fachwissenschaftlern Bücher, aber vor 
allem Aufsätze nach formalen und inhaltlichen Merkmalen 
erfasst. Hervorzuheben sind bei inhaltlichen Merkmalen die 
Schlagwörter, die die Grundlage für eine systematische 
Recherche nach einem Thema bilden. 

Die meisten Online-Datenbanken bieten ähnlich wie Kataloge 
einfache Möglichkeiten zur Übernahme von recherchierten Lite-
raturdaten in EndNote. Allerdings sind der Zugang und die Hand-
habung, aber auch der inhaltliche Nutzen teilweise sehr unter-
schiedlich. 

Hier können einige Grundlagenkenntnisse und Recherchestrate-
gien sehr nützlich sein, um das Aufblähen deiner EndNote-
Datenbank zu vermeiden oder aber überhaupt relevante Literatur 
zu finden. 

Was sind wissenschaftliche Datenbanken? 
In den vorhergehenden Kapiteln hast du gelernt, eine eigene 
EndNote-Datenbank mit EndNote anzulegen, neue Referenzen 
entweder manuell einzugeben oder aus Katalogen zu impor-
tieren, die Datenbankeinträge zu verschlagworten, Referenzen 
je nach Thema in Gruppen zu ordnen und deine EndNote-Daten-
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bank nach Inhalten unterschiedlicher Felder (Autor, Schlagwort 
usw.) zu durchsuchen.

Mit diesen Vorkenntnissen bist du bestens ausgerüstet, um auch 
die Inhalte dieses Kapitels zu verstehen. Hier geht es um die 
Suche nach wissenschaftlichen Artikeln in bibliografischen 
Online-Datenbanken unterschiedlicher Anbieter und den Import 
deiner Rechercheergebnisse in EndNote.

Online-Datenbanken – wie zum Beispiel PubMed, IBSS, MLA, 
Web of Science, Chemical Abstracts, BIOSIS, EMBASE – 
werden wie deine EndNote-Datenbank nach Strukturvorgaben 
erstellt: Dokumente werden nach vorgegebenen Kategorien in 
fest zugewiesenen Datenbankfeldern erfasst, z.B. darf der Autor-
name nur im Autorenfeld erfasst werden. Diese Strukturierung 
wird an der folgenden Grafik veranschaulicht. 

In die Online-Datenbanken werden Aufsätze, Bücher und andere 
Dokumente von Fachwissenschaftlern erfasst und um inhatliche 
Informationen wie Schlagwörter und Abstracts ergänzt. Online-
Datenbanken sind verglichen mit deiner EndNote-Datenbank viel 
umfangreicher. Sie bieten zusätzliche Rechercheinstrumente 
(z.B. Thesaurus, Suchhistorie) und Dienstleistungen (z.B. Profil- 
und Alertdienste) an. Die Inhalte von Online-Datenbanken 
werden von einer Redaktion gepflegt. Der Wert von Fachdaten-
banken liegt darin, dass man systematisch über die von Fachwis-
senschaftlern vergebenen Schlagwörter präzise recherchieren 
kann.
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Da es sehr viele Online-Datenbanken unterschiedlicher Anbieter 
gibt, existieren auch diverse Datenbankoberflächen mit unter-
schiedlichen Funktionalitäten. Du musst dich davon aber nicht 
abschrecken lassen, denn das Gemeinsame aller Datenbanken 
ist ihre Grundstruktur, die vergleichbar mit deiner EndNote-
Datenbank ist. Wenn du diese Gemeinsamkeit erkannt hast, fällt 
dir auch die Nutzung der Online-Datenbanken viel leichter. Du 
weißt zum Beispiel, dass du nach Inhalten gezielt in den entspre-
chenden Feldern suchen kannst: z.B. nach Autor, Titel oder 
Schlagwörtern, wobei Schlagwörter gerade den Inhalt einer 
Publikation einheitlich beschreiben.

Merke: Von Fachwissenschaftlern vergebene Schlagwörter 
beschreiben die Inhalte von Publikationen mit einheitlichen 
Begriffen. Sie sind daher die idealen Instrumente, um gezielt, 
bezogen auf ein Thema, möglichst alle relevanten Quellen zu 
finden.

Es ist wichtig zu wissen, dass die fachwissenschaftlichen Redak-
tionen der Datenbanken teilweise unterschiedliche Schlagwort-
systeme einsetzen. Das hat für dich zur Folge, dass du in 
verschiedenen Datenbanken mit unterschiedlichen Schlagwör-
tern arbeiten musst, die du vorher gegebenenfalls in Erfahrung 
bringen musst. Dabei helfen dir Suchinstrumente wie Index und 
Thesaurus weiter, aber auch einige Recherchestrategien, auf die 
im übernächsten Abschnitt Recherchestrategien ab Seite 100 
eingegangen wird.

Typen von Online-Datenbanken
Der klassische Ansatz zur Typologisierung von Datenbanken 
orientiert sich an der Frage, ob die Datenbank die nachgefragte 
Information an sich enthält (z.B. als elektronischen Volltext) oder 
aber nur Verweise auf Quellen, Institutionen oder Experten, die 
die eigentlich nachgefragte Information liefern können. Demnach 
werden Referenz-, Fakten- und Volltextdatenbanken unter-
schieden. Bevor du dich auf die Informationssuche begibst, 
musst du also zunächst die Frage klären, was genau du suchst 
beziehungsweise welcher Datenbanktyp für dich in Frage 
kommt. Universitätsbibliotheken bieten Zugriffsmöglichkeiten auf 
freie und kostenpflichtige Online-Datenbanken an, ebenso wie 
kurze Informationen über den jeweiligen Datenbanktyp und den 
Inhalt der Datenbank.

Bibliografische 
Referenzdatenbanken

Sie beinhalten eine Zusammenstellung relevanter Referenzinfor-
mationen zu einem bestimmten Themengebiet. Je nach Daten-
bank wird sowohl unselbstständige Literatur (Aufsätze) als auch 
selbstständige Literatur (Bücher) nachgewiesen. Welche Materi-



Kapitel 5 – Online-Datenbanken benutzen

100

alien (Bücher, Zeitschriften, Sammelbände, Kongressbände, 
u. a.) ausgewertet werden, hängt hierbei von der Zielsetzung des 
Herstellers der jeweiligen Datenbank ab.

Faktendatenbanken und 
Lexika

Sie eignen sich für eine Recherche nach Fakten, z.B. Statistiken, 
Urteilen, technischen Normen, biografische Daten, Definitionen 
oder Abkürzungen.

Volltextdatenbanken Für eine Recherche nach Textstellen nutzt man Volltextdaten-
banken. In Volltextdatenbanken sind Publikationen und Aufsätze 
in elektronischen Zeitschriften nachgewiesen.

Merke: Volltextdatenbanken eignen sich für eine gezielte Suche 
nach Textstellen in einem Dokument. Referenzdatenbanken 
ermöglichen demgegenüber eine umfassendere Suche insbe-
sondere nach Literatur zu einem Thema. Bei der Arbeit mit 
EndNote hat man es primär mit Referenzdatenbanken zu tun. 
Es gibt insbesondere im naturwissenschaftlichen Bereich Misch-
typen von Datenbanken, in denen gleichzeitig Referenzinforma-
tionen und Volltexte zusammengefasst sind.

Recherchestrategien
Zum besseren Verständnis der Recherchestrategien solltest du 
dir den Rechercheprozess im folgenden Schema anschauen. Im 
Grunde genommen ist der Rechercheprozess ein Abgleich von 
deinen Suchbegriffen mit den Begriffen der Datenbank-Redak-
tion, was in der folgenden Grafik veranschaulicht wird:

Beispiele: 

IBSS, Sowiport, MLA, Psyndex, PubMed, EBMR, BIOSIS

Beispiele: 

Internationale Titelabkürzungen, Juris, Lexikon der Politik, 
Genesis, Munzinger, Pschyrembel

Beispiele: 

FAZ, Der Spiegel, WISO, LexisNexis, Elektronische Zeit-
schriften wie JSTOR, Early English Books Online
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Merke: Du musst beachten, dass die Kategorienbezeichnungen 
in den einzelnen Datenbanken unterschiedlich sein können. So 
können Schlagwörter in englischsprachigen Datenbanken die 
Bezeichnung „Subject Headings“, „Descriptors“, „Subjects“, 
„MeSH Terms“ oder „Normative Keywords“ haben.

Gerade weil die beiden Begriffssysteme – deines und das der 
jeweiligen Redaktion – voneinander abweichen können, kommt 
der sicheren Handhabung von Suchbegriffen enorme Bedeutung 
beim Rechercheprozess zu. Recherchestrategien, die im 
Folgenden vorgestellt werden, können dir dabei Hilfestellung 
leisten.

Block-Building-Strategie
Das A und O einer möglichst umfassenden und inhaltlich 
präzisen Recherche ist die kreative Suche nach alternativen 
Suchbegriffen, die zu deinem Thema passen. Zur Auswahl der 
Suchbegriffe hilft eine Tabelle, worin die wichtigsten Teilaspekte 
eines Themas herausgearbeitet werden. Die Auswahl der Such-
begriffe, Synonyme, Ober- und Unterbegriffe, Abkürzungen usw. 
ist mit der wichtigste Schritt im Rechercheprozess. In dieser 
Phase kann die Arbeit mit Lexika, Nachschlagewerken und 
Handbüchern ganz sinnvoll sein. Hier siehst du, wie eine solche 
Tabelle mit dem Thema „Mitwirkung von Parteimitgliedern an der 
Erstellung von Parteiprogrammen“ aussehen könnte. Das 
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Thema wird hier in drei Blöcke aufgeteilt (Block-Building). Inner-
halb der einzelnen Blöcke werden die verwandten, allgemei-
neren oder konkreteren Begriffe aufgelistet, die bei einer Suche 
relevant sein können.

Pearl-Finding-Pearl-Growing-Strategie
Wenn du keine geeigneten oder nur wenige Treffer mit deinen 
Suchbegriffen gefunden hast, dann hilft dir bei der Ermittlung 
geeigneter Schlagwörter in einer Datenbank die Pearl-Finding-
Pearl-Growing-Strategie.

A: Perle suchen

Zufallsrecherche / Suche 
in allen Feldern

Nutze zunächst eigene Begriffe für eine Zufallsrecherche über 
Freitext/alle Felder. Im Screenshot wird mit dem Begriff 
„Faulkner, William“ in der Datenbank MLA International Biblio-
graphy (http://www.mla.org) gesucht. Als Suchkriterium wird die 
Einstellung „Select a Field (optional)“ gewählt. Dieses Suchkrite-
rium ermöglicht die Suche in allen Datenbankfeldern. 

Trefferliste sichten Sichte im zweiten Schritt die Trefferliste und wähle inhaltlich 
geeignete Treffer für die Vollanzeige aus.
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Neue Schlagwörter 
ermitteln

Ermittle in der Vollanzeige die für diesen Titel vergebenen 
Schlagwörter.

B: Perle wachsen lassen

Passende Schlagwörter 
auswählen

Nutze die ermittelten passenden Schlagwörter für eine weitere 
Recherche. Achte auf die Auswahl der richtigen Suchkategorie 
(hier z.B. SU Subjects-All). 
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Trefferliste sichten Wähle aus der Liste passende Treffer aus. 

Ermittle in der Vollanzeige gegebenenfalls neue Schlagwörter.

Im folgenden Video 5.1 kannst du die Pearl-Finding-Pearl-
Growing-Strategie an Hand von SOWIPORT nachvollziehen.
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Video 5.1: Pearl-Finding-Pearl-Growing-Strategie in SOWIPORT

Tipp: Über die History-Funktion, die in vielen Online-Daten-
banken angeboten wird, können Rechercheergebnisse nach-
träglich verknüpft werden, was die Umsetzung der Block-
Building-Strategie ermöglicht. 
Über die Thesaurus-Funktion können ergänzende Recherche-
begriffe ermittelt werden.

Suchinstrumente nutzen
Die meisten Datenbanken bieten Werkzeuge für die Einordnung 
des Suchbegriffs in den thematischen Kontext:

• Suchbegriff wird mit kontrolliertem Wortschatz der Datenbank 
abgeglichen (Index-Funktion)

• Suchbegriff wird in einen strukturierten, hierarchischen 
Begriffskontext eingeordnet (Thesaurus-Funktion)

• erkundige dich über weitere Suchinstrumente in der jeweiligen 
Datenbank

Import von Referenzen in EndNote
Um die Rechercheergebnisse in EndNote zu übernehmen, gibt 
es vier Importmöglichkeiten. 

• Direkter Export (Direct Export) aus der Online-Datenbank 
heraus. Dies geschieht über eine Textdatei (Format: *.enw 
oder *.ris), die automatisch (bei entsprechender PC-Einstel-
lung) mit EndNote geöffnet wird (ein Beispiel zum direkten 
Export findest du in Kapitel 2 im Abschnitt Import von Treffern 
aus lokalen Online-Katalogen auf Seite 40). 
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• PDF-Import in EndNote. Du kannst ein oder mehrere PDF-
Files in die EndNote-Datenbank importieren. Dabei durch-
sucht EndNote die PDF nach einem DOI (Digital Object Iden-
tifier in der Form „DOI 10.1098/rspb.2002.2233“). Anhand 
dieser eindeutigen Nummer kann EndNote die bibliografi-
schen Daten, z.B. für einen Artikel, aus dem Internet laden und 
zusammen mit der PDF-Datei in der EndNote Datenbank 
abspeichern. Die PDF-Dateien werden bei diesem Vorgang 
gleich in den DATA-Ordner kopiert.  

• Import einer Textdatei aus der Online-Datenbank heraus. 
Beim Import aus einer Textdatei werden die Ergebnisse einer 
Recherche in einer Online-Datenbank in einer Textdatei 
(Format: *.txt, *.enw, *.ris) gespeichert und anschließend mit 
dem entsprechenden Importfilter in EndNote importiert. 
Importfilter sind bereits vorinstalliert.

• Direkte Suche in der jeweiligen Online-Datenbank aus 
EndNote heraus (Online Search). Über 4.100 Online-Daten-
banken können direkt aus EndNote durchsucht werden. 
Passende Suchergebnisse können gleich in die EndNote-
Datenbank übernommen werden. Genau wie beim Direct 
Export werden auch bei dieser Art des Imports Dubletten nicht 
automatisch erkannt, so dass eine nachträgliche Dubletten-
kontrolle notwendig ist. Andererseits bietet die direkte Suche 
aus EndNote heraus den Vorteil, dass man die gewohnte 
EndNote-Suchmaske verwenden kann. Allerdings können die 
datenbankspezifischen Suchinstrumente (Thesaurus, History, 
Alert-Dienste etc.), die die systematische Suche sehr erleich-
tern und die Anwendung von Suchstrategien ermöglichen, 
nicht genutzt werden. 

Letzte drei Möglichkeiten werden in den folgenden Abschnitten 
ausführlicher behandelt. 

Referenzen über eine Textdatei in EndNote importieren
Wie du bereits weißt, können sich Benutzeroberflächen von 
Online-Datenbanken stark voneinander unterscheiden. An 
dieser Stelle werden wir daher keine bestimmte Datenbank 
vorstellen. Erkundige dich auf den Seiten der für dich in Frage 
kommenden Online-Datenbanken, ob und welche Exportmög-
lichkeiten angeboten werden. Hinweise auf Exportmöglichkeiten 
und die Vorgehensweise findet man oft in den FAQs oder auf den 
Hilfeseiten.

Tipp: Nutze die Google-Suche (Datenbankname + EndNote), 
um möglichst schnell auf entsprechende Hilfeseiten zu gelangen.
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Um bibliografische Angaben aus Online-Datenbanken erfolg-
reich in EndNote zu importieren, musst du Folgendes beachten.

Textdatei mit Feldnamen Bibliografische Daten müssen als Textdatei (neben *.txt sind 
auch *.ris- und *.enw- Dateien Textdateien) mit Feldnamen 
exportiert werden. Im folgenden Screenshot siehst du zur Veran-
schaulichung eine Textdatei ohne Feldnamen und eine mit.

Nicht in jeder Online-Datenbank ist allein aus den Optionen 
ersichtlich, welches Exportformat das richtige ist. Das richtige 
Format erkennst du daran, dass die bibliografischen Angaben 
den jeweiligen Feldnamen zugeordnet sind, so wie dies im Fall 
von PubMed im Format „MEDLINE“ der Fall ist. 

Nur wenn Feldnamen vorhanden sind, kann EndNote beim 
Import die Inhalte der Textdatei den entsprechenden Datenbank-
feldern/Kategorien zuordnen und sie somit strukturieren. 

Exportformat beachten Feldnamen variieren je nach Exportformat. Im Screenshot siehst 
du Feldnamen des EndNote- und des RIS-Formats anhand eines 
Buchs gegenübergestellt.
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Importfilter auswählen Beim manuellen Import muss in EndNote der zum Exportformat 
der Online-Datenbank passende Importfilter ausgewählt werden. 
Dadurch kann EndNote erkennen, in welchem Format eine Refe-
renz vorliegt und kann die Inhalte den entsprechenden Daten-
bankfeldern von EndNote zuordnen.

Import durchführen Nachdem du die bibliografischen Daten im richtigen Format 
abgespeichert oder heruntergeladen hast, kommt der eigentliche 
Import in EndNote. Hier sind die wichtigsten Schritte.

• Öffne deine EndNote-Datenbank.

• Wähle im Menü File den Befehl Import und File....

• Wähle über den Button Choose File die exportierte Textdatei 
aus. Wähle einen passenden Importfilter aus. In unserem 
Beispiel wäre dies „PubMed (NLM)“. Wenn du gleich eine 
Dublettenprüfung durchführen lassen möchtest (empfehlens-
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wert!), musst du unter Duplicates die Option Discard Dupli-
cates auswählen.

• Klicke auf Import, um die bibliografischen Daten zu impor-
tieren.

• Die importierten Referenzen werden daraufhin in der tempo-
rären Gruppe „Imported References‟ angezeigt. Diese Gruppe 
verschwindet, sobald deine EndNote-Datenbank geschlossen 
wird. Die importierten Treffer bleiben selbstverständlich 
erhalten, es sei denn du löschst sie aus dieser Gruppe. 
Solange die importierten Referenzen in der Gruppe „Imported 
References‟ zu sehen sind, ist es die beste Gelegenheit, sie 
zu verschlagworten und bestimmten Gruppen zuzuweisen 
(siehe dazu Kapitel 3 ab Seite 51).

Merke: Überprüfe nach dem Import, ob die Inhalte der Refe-
renzen auch den richtigen Datenbankfeldern von EndNote zuge-
ordnet wurden und der Referenztyp korrekt übernommen wurde. 
Gegebenenfalls musst du weitere manuelle Korrekturen 
vornehmen.

Hilfreich ist dabei die Preview-Funktion im unteren Navigations-
bereich. Um in der Vorschau die Inhalte aller Felder anzeigen zu 
lassen, wählst du aus dem Zitierstil-Menü die Option Show All 
Fields aus.
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Im folgenden Video 5.2 kannst du den Import einer Textdatei in 
EndNote aus PubMed nachvollziehen.

Video 5.2: Import einer Textdatei in EndNote

Import von Referenzen über PDFs mit DOI-Angaben
Bibliografische Angaben können auch mittels PDF-Dateien in die 
EndNote-Datenbank importiert werden. Voraussetzung dabei ist, 
dass im PDF-Dokument eine DOI angegeben ist. DOI ist eine 
eindeutige Identifikationsnummer, die zum Speicherort und den 
bibliografischen Angaben des Dokuments führt (siehe auch http:/
/www.doi.org). Sie befindet sich meistens auf der ersten Seite 
des PDF-Dokuments. Hier ist ein Ausschnitt aus einem PDF-
Dokument:
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Um eine PDF zu importieren, gehst du ähnlich vor, wie im vorigen 
Abschnitt beschrieben. Zunächst rufst du über File > Import > 
File.../Folder... das Importfenster auf. Du kannst sowohl 
einzelne PDF-Dateien als auch einen ganzen Ordner (und seine 
Unterordner) mit mehreren PDF-Dateien importieren.

Im Importfenster bestimmst du über Choose zunächst die PDF-
Datei. Unter Import Option wählst du „PDF“ aus. Wenn du gleich 
eine Dublettenkontrolle durchführen lassen möchtest, wählst du 
unter Duplicates die Option Discard Duplicates aus. Anschlie-
ßend klickst du auf Import 

Merke: Damit EndNote die zu einer DOI gehörenden bibliografi-
schen Angaben einer PDF importieren kann, muss eine Internet-
verbindung bestehen.

Es erscheint zunächst ein kleines Fenster, in dem du über den 
Importfortschritt informiert wirst. Bei erfolgreichem Import siehst 
du in der temporären Gruppe „Imported References“ die neu 
importierte(n) Referenz(en) mitsamt Anhängen.
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Im folgenden Video 5.3 siehst du, wie Referenzen aus lokal 
gespeicherten PDF-Dokumenten mit DOI-Angaben erstellt 
werden.

Video 5.3: Erstellen von Referenzen mithilfe von DOI-Angaben

Recherche in Online-Datenbanken aus EndNote heraus
Manche Online-Datenbanken und viele Bibliothekskataloge 
lassen sich über so genannte „Connection Files‟ in EndNote 
einbinden, so dass direkt aus EndNote in ihnen gesucht werden 
kann. Connection Files enthalten jeweils Schablonen (Temp-
lates), mittels derer eine referenztypenspezifische Verwendung 
der Datenbankfelderinhalte möglich ist. Connection Files regeln 
die korrekte Zuordnung der über die integrierte Online Search 
gefundenen Daten zu entsprechenden Datenbankfeldern. 
„Connection Files‟ für eine Vielzahl von Online-Datenbanken 
sind im Programmumfang von EndNote bereits enthalten. Es 
können aber auch neue „Connection Files“ hinzugefügt werden.

Die Suche aus EndNote heraus ist bequem, weil für die 
Recherche in diversen Online-Datenbanken eine einheitliche 
Recherchemaske genutzt wird. Man muss sich nicht mit unter-
schiedlichen datenbankspezifischen Suchfenstern befassen und 
kann sehr viele Referenzen bequem übernehmen. Der Nachteil 
besteht darin, dass man nicht so spezifisch suchen kann und 
Suchinstrumente wie etwa „Refining“ zum Verfeinern der Such-
anfrage verborgen bleiben. Nutze die Online Search, wenn du 
genau weißt, nach welchen Begriffen du recherchieren willst.
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Anzeigemodi in EndNote EndNote hat drei unterschiedliche Anzeigemodi: Integrated 
Library & Online Search Mode, Local Library Mode und Online 
Search Mode (im Bild von links nach rechts).

Wenn du eine Online-Recherche durchführen möchtest, sind 
zwei Anzeigemodi von Bedeutung:

• Im Integrated Library & Online Search Mode wird das Such-
ergebnis der Online-Recherche sofort in die geöffnete 
EndNote-Datenbank übernommen. Nicht benötigte Treffer 
müssen einzeln gelöscht werden. Beachte, dass dieser 
Modus bei großen Treffermengen zu zeitraubenden Löschar-
beiten führen kann. Er ist daher für die Online Search nicht zu 
empfehlen.

• Im Online Search Mode werden die gefundenen Referenzen 
zunächst in eine temporäre Gruppe heruntergeladen. Hier 
kannst du die passenden Treffer sichten und dann 
entscheiden, ob du sie in deine EndNote-Datenbank über-
nehmen möchtest. Dies kann dir im Gegensatz zum Integrated 
Library & Online Search Mode viel Zeit ersparen, weshalb 
dieser Anzeigemodus für die Online Search empfehlenswert 
ist. 
Im Screenshot siehst du den Ablauf: 

– Zuerst im Online Search Mode nach passenden Treffern 
suchen. Nutze dabei die Preview-Funktion mit dem Zitierstil 
Annotated.

– Passende Treffer markieren und über den Button Copy to 
Local Library in deine EndNote-Datenbank übernehmen.
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– Danach in den Integrated Library & Online Search Mode
wechseln. Eine Übersicht soeben übertragener Referenzen 
siehst du in der temporären Gruppe „Copied References“. 

Nun ist die beste Gelegenheit, um die Referenzen auf Rich-
tigkeit zu prüfen, sie zu verschlagworten und passenden 
Gruppen zuzuordnen.

Der Local Library Mode ist für die Online-Recherche irrelevant, 
da in diesem Modus nur lokal in deiner EndNote-Datenbank 
gearbeitet wird.

Verbindung zu einer Online-Datenbank herstellen
Der erste Schritt bei der Recherche in einer Online-Datenbank 
besteht darin, eine Verbindung zu dieser Datenbank herzu-
stellen.

• Starte EndNote und wähle aus dem Menü Tools den Befehl 
Online Search aus. 
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Es öffnet sich ein Fenster mit verfügbaren Online-Datenbanken. 

• Wähle aus der Liste die gewünschte Datenbank aus und klicke 
auf Choose. Durch die Auswahl des „Connection File“ hast du 
nun mit EndNote eine Verbindung zur Online-Datenbank 
hergestellt. Wenn aus irgendwelchen Gründen die Verbindung 
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nicht hergestellt werden kann, schließt EndNote die Verbin-
dung und du erhältst eine Fehlermeldung. Sollte die Verbin-
dung nicht funktionieren, liegt es häufig an einem Proxy oder 
einer Firewall, die die Verbindung zu der Datenbank verhin-
dert. Gehe dann auf die jeweilige Webseite und nutze die 
Exportmöglichkeiten, um Daten in EndNote zu übernehmen.

Nach einem erfolgreichen Verbindungsaufbau siehst du im 
unteren Teil der Programmoberfläche die EndNote-Suchmaske, 
über die du in der gewählten Online-Datenbank recherchieren 
kannst. Die Suchmaske trägt in ihrer Bezeichnung den Namen 
der Datenbank. Du kannst jetzt mit der Suche beginnen.

Zusätzliche Connection 
Files

Wenn Du bei der Installation von EndNote die Standardinstalla-
tion gewählt hast (Option: Typical Installation), werden die 100 
wichtigsten Connection Files installiert. Das sind Dateien 
(Endung: *.enz), die im EndNote-Ordner „Connections“ gespei-
chert werden und dafür sorgen, dass EndNote die Verbindung zu 
Online-Datenbanken und Katalogen herstellen kann und die 
bibliografischen Angaben daraus richtigen Datenbankfeldern 
zugeordnet werden. Installations- und Konfigurationsanleitungen 
findest du unter http://www.endnote.de/instwin (Windows) und 
http://www.endnote.de/instmac (Mac).

Unter Edit > Connection Files > Open Connection Manager > 
Get more on the Web... lassen sich weitere Connection Files 
herunterladen. 
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Um sie zu installieren, genügt es, wenn du die heruntergeladene 
*.enz-Datei per Doppelklick mit EndNote öffnest und dort unter 
File > Save as... unter einem neuen Namen abspeicherst.

Recherche in einer Online-Datenbank
Die Online-Recherche führst du wie folgt durch:

Schritt 1

Wähle zunächst das Suchkriterium aus, nach dem du suchen 
möchtest, z.B. Autor oder ein bestimmtes Schlagwort. Achte 
darauf, dass sich die Bezeichnungen der Suchkriterien je nach 
Online-Datenbank unterscheiden können. So heißen die Schlag-
wörter in manchen Online-Datenbanken „Descriptors‟, „MeSH 
Terms‟, „Subject Headings‟ oder „Keywords‟. 
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Schritt 2

Gib nun in das oberste Eingabefeld des Suchfensters deine 
Suchanfrage ein. Beachte dabei, welche Sprache die jeweilige 
Online-Datenbank verwendet. 

Schritt 3

Wenn du auf den Button Search klickst, sendet EndNote die 
Suchanfrage an die Online-Datenbank und du erhältst ein Menü 
mit der Anzahl der gefundenen Treffer.

Tipp: Bei zu vielen Treffern kannst du die Suche an dieser Stelle 
mit Cancel abbrechen und sie mit den Booleschen Operatoren 
„And‟, „Not‟ und „Or‟, die sich links von den Suchkriterienfeldern 
befinden (mehr zu Booleschen Operatoren in Kapitel 3 > Boole-
sche Operatoren nutzen ab Seite 68) sowie mit weiteren Suchbe-
griffen einschränken. Falls dir keine Begriffe einfallen, kannst du 
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folgendermaßen verfahren: Ersetze im eingeblendeten Menü die 
Trefferzahl durch 30, um nur die ersten 30 Treffer anzeigen zu 
lassen. Nutze nun die Preview-Funktion mit der Zitierstil-Option 
Show All Fields, um bei passenden Treffern zusätzliche Schlag-
wörter (Keywords) zu ermitteln, mit denen du die nächste Such-
anfrage einschränken könntest. (Abstracts der jeweiligen Treffer 
kannst du dir über den Zitierstil Annotated anzeigen lassen.)

Tipp: Denk auch daran, dass gerade bei thematischen Suchen 
die Webseite der jeweiligen Datenbank mit den umfangreichen 
Rechercheinstrumenten (Thesaurus, Index, Refining usw.), die 
dir die Suche erleichtern, empfehlenswert ist.

Schritt 4

Wenn du mit der Anzahl der Treffer zufrieden bist, kannst du sie 
dir über den Befehl OK anzeigen lassen. Je nach dem, welche 
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Ansicht du gewählt hast, werden die Datensätze entweder direkt 
in die geöffnete Datenbank importiert (Integrated Library & 
Online Search Mode) oder erscheinen zunächst in einer tempo-
rären Datenbank, aus der du die passenden Treffer auswählen 
und in deine Datenbank einfügen lassen kannst (Online Search 
Mode). Dies geschieht über den Button Copy to Local Library.

Schritt 5

Sobald du im Online Search Mode passende Treffer aus der 
Trefferliste in deine EndNote-Datenbank verschoben hast, 
kannst du in den „Local Library Mode‟ oder „Integrated Library & 
Online Search Mode“ wechseln. Du findest die aktuellen Refe-
renzen in der temporären Gruppe „Copied References‟. Jetzt ist 
die beste Gelegenheit, um die Referenzen auf Richtigkeit zu 
prüfen, sie zu verschlagworten und passenden Gruppen zuzu-
weisen.

Wenn du die Suche im Integrated Library & Online Search Mode 
durchgeführt hast, kannst du, ohne die Ansicht zu wechseln, die 
Referenzen gleich auf Richtigkeit prüfen, verschlagworten und 
eingruppieren.

Tipp: Trotz aller Vorteile, die eine Recherche aus EndNote 
heraus bietet, kann es sinnvoll sein, direkt in den Datenbanken 
zu suchen, da nur dort Suchinstrumente angeboten werden, die 
das Auffinden von geeigneten Suchbegriffen erleichtern 
(Thesaurus- und die Index-Funktion). Große Treffermengen 
können nach unterschiedlichsten Kriterien eingeschränkt werden 
(Sprache, Adressatenkreis u.a.). Über die Suchhistorie können 
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die Ergebnisse mehrerer Recherchen miteinander kombiniert 
werden.

Im folgenden Video 5.4 siehst du eine Recherche in der Daten-
bank PubMed im Online Search Mode direkt aus EndNote 
heraus.

Video 5.4: Recherche in der Datenbank PubMed im Online Search Mode

ZUSAMMENFASSUNG In diesem Kapitel hast du gelernt,

 Wie bibliografische Online-Datenbanken aufgebaut sind

Übung: 

1) Rufe die Suchmaske von PubMed auf (http://
www.ncbi.nlm.nih.gov/pubmed/). Starte eine erweiterte 
Suchanfrage (Advanced Search) mit den MeSH Terms 
„diabetes type 2“ und „diet therapy“. Beide Begriffe sind 
zusammengesetzte Begriffe und müssen daher mit Anfüh-
rungszeichen geschrieben werden. Nutze als Suchkriterium 
die Freitextsuche („All Fields“). (Ein Schulungsvideo zur 
Durchführung dieser Recherche findest du unter: http://
fitmed.uni-hd.de im Kapitel 5 > PubMed > Einstieg in die 
PubMed-Recherche.) 
Exportiere die ersten drei Treffer, indem du sie markierst 
und dann auf Send to: > File klickst. Speichere die drei 
markierten Referenzen im „MEDLINE‟-Format ab. 

2) Importiere nun die gespeicherte Textdatei in deine 
EndNote-Datenbank. Achte darauf, dass der richtige 
Importfilter für PubMed gewählt wird: „PubMed (NLM)“.




Kapitel 5 – Online-Datenbanken benutzen

122

 Recherchestrategien für eine effiziente und effektive Aufsatz-
suche anzuwenden

 Bibliografische Informationen aus unterschiedlichen Online-
Datenbanken in EndNote zu importieren 

 Aus EndNote heraus in Online-Datenbanken zu recherchieren
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Kapitel 6 – Zitierstile ändern

LERNZIELE In diesem Kapitel lernst du,

 Zitierstile zu importieren, zu modifizieren und neu zu erstellen

 Regeln und Ausnahmen für Schablonen (Templates) kennen

 Vorhandene Referenztypen (Reference Types) zu modifi-
zieren und neue zu erstellen

Situation

Bei wissenschaftlichen Publikationen, aber auch von einigen 
Dozenten werden häufig spezielle Zitieranforderungen gestellt, 
wenn etwa bestimmte Merkmale in der Quellenangabe (z.B. 
ISBN-Nummer oder Auflagenbezeichnungen) gefordert werden. 
Hier liegt die besondere Stärke von EndNote. Es werden sehr 
umfassende Möglichkeiten zur Veränderung bzw. Anpassung 
von Zitierstilen geboten.  

Zitierstile hinzufügen und modifizieren
In einem Zitierstil wird festgelegt, wie die Inhalte der Datenbank-
felder bei bestimmten Referenztypen zu ordnen und zu forma-
tieren sind. Du kannst über einen Output Style-Editor festlegen, 
wie Zitate im Fließtext, das Literaturverzeichnis und die 
Fußnoten auszugeben sind. Dabei gibt es vielzählige Einstel-
lungsmöglichkeiten bezogen auf die Ausgabe von Zwischenzei-
chen, die Schriftart, Ausgabe mehrerer Autoren, Einrückungen, 
Sortiermöglichkeiten. Teilweise müssen hier mehrere Funkti-
onen miteinander kombiniert werden. Bevor du anfängst, einen 
Zitierstil zu ändern oder neu zu erstellen, solltest du das vorhan-
dene Angebot an Zitierstilen nutzen.

EndNote bietet mehr als 4.500 bibliografische Zitierstile (Output 
Styles) an. Um die Systemleistung nicht zu bremsen, werden bei 
einer Standardinstallation die 100 wichtigsten Zitierstile aktiviert. 
Eine Liste mit aktivierten Zitierstilen findest du unter Edit > 
Output Styles > Open Style Manager.
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Sollte der benötigte Zitierstil nicht vorhanden sein, hast du 
mehrere Möglichkeiten:

• Du kannst zusätzliche Zitierstile aktivieren (siehe im Anhang > 
Custom Installation ab Seite 199) oder herunterladen

• Du kannst vorhandene Zitierstile den Anforderungen entspre-
chend modifizieren

• Du kannst einen neuen Zitierstil erstellen

Tipp: Statt der Erstellung eines neuen Zitierstils, solltest du einen 
Zitierstil modifizieren, der dem von dir gewünschten Zitierstil am 
ähnlichsten ist. Die Modifikation eines vorhandenen Zitierstils ist 
empfehlenswert, da sich gegenüber der Erstellung eines neuen 
Zitierstils viel Zeit sparen lässt. Vor allen Dingen fällt es leichter, 
sich in die Einstellungsmöglichkeiten, die die Darstellung der 
Referenzen im Literaturverzeichnis steuern, einzuarbeiten.

Zusätzliche Zitierstile herunterladen 
Zum Herunterladen von zusätzlichen Zitierstilen klickst du im 
Style Manager auf den Button Get More on the Web.... 
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Auf der EndNote-Website kannst du den Style Finder 
verwenden, um den benötigten Zitierstil zu finden. 

Speicherort für neue 
Zitierstile

Um den heruntergeladenen Zitierstil zu installieren, kopierst du 
ihn in den Zitierstilordner („Styles‟), der sich unter 
C:\Programme\EndNote X4\Styles befindet. Falls das Kopieren 
in den Ordner auf Grund der PC-Konfiguration nicht möglich ist, 
prüfe den möglichen Speicherort der Output Styles unter Edit > 
Preferences > Folder Locations > Style Folder. Der Spei-
cherort kann auf diese Weise auch geändert werden. Nach 
einem Programmneustart ist die Installation abgeschlossen.
Eine noch schnellere Möglichkeit der Installation besteht darin, 
den heruntergeladenen Zitierstil per Doppelklick mit EndNote zu 
öffnen und dann unter File > Save as... unter einem neuen 
Namen abzuspeichern.
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Tipp: Bevorzugte Zitierstile lassen sich im Style Manager durch 
Markieren zu den Favoriten hinzufügen; diese erscheinen dann 
im Drop-Down-Menü direkt in der EndNote-Werkzeugleiste und 
im Style-Menü von Cite While You Write im Textverarbeitungs-
programm.

Vorhandene Zitierstile modifizieren 
Wenn du einen vorhandenen Zitierstil für einen bestimmten 
Zweck oder für spezielle Zitieranforderungen anpassen möchtest 
(z.B. Ausgabe der zitierten Seite(n) mit der Abkürzung „S.“ oder 
„p.“ am Anfang), suche einen Zitierstil (Output Style), der deinen 
Anforderungen am ehesten entspricht. 

Im folgenden Beispiel wurde der Zitierstil Harvard für die Anfor-
derungen eines Instituts z.B. um Abstract-Angaben ergänzt:

Beispiele: 

Bohl, Thorsten. 2008. Wissenschaftliches Arbeiten im 
Studium der Pädagogik. Weinheim: Beltz. <http://d-nb.info/
98874368X/04: Stand 7.11.2010>

Der Schwerpunkt liegt hier in der Arbeit mit Texten und in dem 
Prozess der Erstellung einer schriftlichen Arbeit, der Analyse 
von Lehrveranstaltungen, der Vorbereitung auf Prüfungen. Im 
Anhang finden sich nützliche Formulare z.B. zur Beurteilung 
von Internetdokumenten oder zur Erarbeitung eines Begriffs-
felds.
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Im Style Manager kannst du dir zu den vorhandenen Zitierstilen 
eine Vorschau anzeigen lassen. Klicke dazu auf den Button 
Style Info/Preview. Wenn du einen passenden Zitierstil 
gefunden hast, klicke auf Edit, um diesen Zitierstil anzupassen. 
Es öffnet sich ein neues Fenster, in dem du die Änderungen 
vornehmen kannst. In der folgenden Grafik siehst du die Abfolge 
der Arbeitsschritte, in der ein vorhandener Output Style bear-
beitet werden kann. Im vierten Schritt wird exemplarisch das 
Template angezeigt, über das die Ausgabe des Literaturver-
zeichnisses gesteuert wird. Auf die speziellen Regeln wird in 
diesem Kapitel ausführlich eingegangen.

Merke: Achte darauf, den zu modifizierenden Zitierstil vor den 
Änderungen unter einem neuen Namen abzuspeichern, damit du 
den ursprünglichen Zitierstil für eine mögliche weitere Anpas-
sung verwenden kannst. Klicke dazu auf File > Save As.... 
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Beachte, dass der Zitierstil auf allen Rechnern installiert sein 
muss, von denen du einen Literaturexport im entsprechenden 
Zitierstil durchführen möchtest.

Im Output Style-Editor siehst du auf der linken Seite einen Navi-
gationsbereich mit zahlreichen Gliederungspunkten. Für die 
Erstellung oder Modifikation eines Zitierstils sind folgende 
Bereiche besonders wichtig: Citations, Bibliography und Foot-
notes.

In jedem dieser drei Bereiche findest du den Abschnitt „Temp-
lates“. Dort stellst du ein, welche Informationen einer Referenz 
wie in der Ausgabe zusammengesetzt werden sollen. Andere 
Abschnitte beinhalten weitere Einstellungen der Zitatausgabe. 
Du kannst einstellen, wie mehrere Autoren aufgelistet werden 
und ab wievielen Autoren mit „et al.“ oder „u.a.“ abgekürzt 
werden soll (Author Lists); ob der Vorname ausgeschrieben oder 
abgekürzt wird (Author Name); ob der Titel in Großbuchstaben 
geschrieben werden soll, unabhängig davon, wie du ihn in der 
jeweiligen Referenz eingegeben hast (Title Capitalization). 
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Verwendest du eine Fußnoten-Zitiermethode (z.B. MLA), dann 
muss der Citations-Bereich, genauer gesagt dessen Template, 
das normalerweise die Ausgabe des Zitats im Fließtext steuert, 
leer bleiben. Bei dieser Zitiermethode sind besondere Steue-
rungsmöglichkeiten zu beachten.

Neuen Zitierstil erstellen
Hier ist eine Schritt für Schritt Anleitung zur Erstellung eines 
eigenen Zitierstils. 

Schritt 1

Klicke unter Edit > Output Style auf New Style. 

Schritt 2

Um die Ausgabe des Literaturverweises im Fließtext zu ändern, 
wähle unter dem Gliederungspunkt Citations den Menüpunkt 
Templates aus. Lege zuerst fest, wie der Literaturverweis im 
Fließtext erscheinen soll, z.B. (Müller, 2009). Mit Hilfe des Drop-
Down-Menüs Insert Field kannst du nun passende Felder, aber 
auch Formatierungsfunktionen (z.B. Tabulatoren, einen neuen 
Absatz u.a.) einfügen. Achte dabei auf die richtige Zeichenset-
zung und die Leerzeichen. Das Template für das obige Beispiel 
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würde demnach so aussehen: (Author|,♦Year). (Informationen zu 
den Sonderzeichen erhältst du in den folgenden Abschnitten)

Um eine Seitenangabe, die unter Edit & Manage Ciatation(s)
eingegeben wird, im Word-Dokument im gewünschten Format 
auszugeben, musst du im Zitierstil das Feld „Cited Pages“ und 
die gewünschten Textzusätze („S.“ oder „p.“) einfügen. Wenn du 
eine deutschsprachige Bibliografie erstellst, dann setze ein „S.“ 
davor. Orientiere dich dabei am Zitierstil APA 6th und beachte die 
in folgenden Abschnitten dargestellten Regeln. (Mehr zur 
Ausgabe der Seitenangabe in einem Word-Dokument findest du 
in Kapitel 4 im Abschnitt Zitate im Text bearbeiten und löschen 
ab Seite 83.)

Unter „Multiple citation separator“ stellst du das Zeichen ein, 
dass mehrere Literaturangaben innerhalb eines Zitats trennen 
soll, z.B. (Müller, 2009; Korte, 2011)

Merke: Wenn deine Literaturverweise in Fußnoten erscheinen 
sollen, dann musst du die Kategorie „Citations‟ leer lassen. 
Wichtig sind dann die Kategorien „Bibliography‟ und „Footnotes‟, 
wobei unter „Bibliography‟ die Ausgabe der Literaturverweise im 
Literaturverzeichnis und unter „Footnotes‟ die Ausgabe in den 
Fußnoten geregelt ist, besonders die Angabe wiederkehrender 
Quellen (Footnotes > Repeated Citations).

Schritt 3

Im nächsten Schritt geht es darum, die Ausgabe des Literaturver-
weises im Literaturverzeichnis, das am Ende des Dokuments 
oder des jeweiligen Abschnitts erscheinen soll, festzulegen. 
Hierbei spielt es eine Rolle, um welchen Referenztyp (Reference 
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Type) es sich handelt (zu Referenztypen siehe Kapitel 1 ab 
Seite 17). Je nach dem, ob es sich um eine Monografie oder 
einen Zeitschriftenaufsatz handelt, werden bestimmte bibliografi-
sche Informationen benötigt und im Literaturverweis angezeigt. 
Welche Informationen das sind und wie sie voneinander getrennt 
werden sollen, legst du unter Bibliography > Templates fest. 

Wichtig ist, dass der Referenztyp „Generic“ unbedingt ausgefüllt 
sein muss. Er legt fest, wie eine Referenz ausgegeben wird, 
deren Referenztyp nicht explizit im verwendeten Zitierstil 
beschrieben ist. Wenn du beispielsweise einen Eintrag in deiner 
Bibliografie als „Electronic Article“ kategorisiert hast, gleichzeitig 
aber im Zitierstil keine Regeln für „Electronic Article“ festgelegt 
hast, dann wird, wenn du die Referenz etwa in Microsoft Word 
einfügst, diese nach den Regeln von „Generic“ ausgegeben.

Bei „Generic‟ sollten die wichtigsten Angaben übernommen 
werden, also Autor, Jahr, Titel, Verlag und Publikationsort. 
„Generic‟ entspricht somit der Form nach einer Monografie. Eine 
„Generic‟-Schablone (Template) könnte so aussehen: 
Author.·(Year).·Title.·Place·Published,·Publisher.

Schritt 4

Nun sollte für weitere relevante Referenztypen – insbesondere 
Journal Article, Book, Edited Book, Book Section, Web Page, 
Electronic Article – ein eigenes Template angelegt werden.
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Schritt 5

Wenn du mit dem Eintragen fertig bist, vergiss nicht, den Zitierstil 
unter File > Save zu speichern. 

Schritt 6

Sinnvoll wäre es nun, den neu erstellten Zitierstil mit Hilfe deiner 
Bibliografie zu testen und gegebenenfalls Änderungen vorzu-
nehmen. Nutze dazu entweder die Preview-Funktion in EndNote 
oder ein Word-Dokument mit eingefügten Referenzen.

Regeln für Schablonen (Templates) in den Zitierstilen 
(Output Styles)

Bei der Erstellung neuer oder der Modifikation vorhandener 
Zitierstile bzw. ihrer Templates ist es wichtig, einige grundle-
gende Regeln zu kennen, nach denen EndNote die Templates 
„liest‟ und entsprechend im Textverarbeitungsprogramm 
darstellt. Diese Regeln heißen Abhängigkeitsregeln (rules of 
dependence). Ein „Template‟ ist eine Vorlage, in der unter 
anderem die Anordnung der Datenbankfelder in der späteren 
Ausgabe festgelegt wird.

Basic dependence

Regel 1 Die erste Regel besagt, dass jeder Text oder jedes Interpunkti-
onszeichen (zu denen auch Leerzeichen gehören), das direkt an 
einen Datenbankfeldnamen angrenzt, auch von diesem 
abhängig ist. Das bedeutet, dass die Zeichen nur ausgegeben 
werden, wenn auch das Feld ausgegeben wird (bedingte 
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Ausgabe). Dies ist wiederum nur dann der Fall, wenn Information 
im Datenbankfeld vorhanden ist.

Wird eine Angabe, z.B. Jahr, weggelassen, so werden auch die 
mit diesem Feld verknüpften Zeichen nicht ausgegeben, was du 
in der folgenden Grafik sehen kannst.

Das vorangehende Feld hat höhere Priorität als das 
folgende

Regel 2 Falls beliebige Zeichen ohne Trennung durch Leerzeichen 
zwischen zwei Feldern auftauchen, sind diese von dem ersten 
Feld abhängig.
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„Volume:Issue“ gibt wie im Screenshot zu sehen ist „9:4“ aus.

Wenn keine Angabe für „Issue“ vorhanden ist, wird „9:“ ausge-
geben.

Wenn nur für Issue ein Eintrag vorhanden ist, wird „4“ ausge-
geben.
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In diesem Fall merkt man schon, dass der Doppelpunkt nur ange-
zeigt werden sollte, wenn auch etwas dahinter kommt. Hier 
kommt das Formatierungszeichen der erzwungenen Trennung 
ins Spiel, welches die Verknüpfung mit dem vorangegangenen 
Feld (Volume) auflöst und die Bindung an die Ausgabe des 
folgenden Felds (Issue) ermöglicht. Darauf wird im nächsten 
Abschnitt eingegangen.

Das erste Leerzeichen ist von dem Feld davor 
abhängig. Alle weiteren sind unabhängig

Regel 3 Das erste Leerzeichen nach einem Feld wird nur ausgegeben, 
wenn dieses Feld selbst auch ausgegeben wird, wobei zwischen 
diesem Feld und dem ersten Leerzeichen auch weitere Zeichen 
stehen können, z.B. Komma oder Doppelpunkt. Falls hinter 
diesem Leerzeichen weitere folgen, werden diese immer ausge-
geben, da sie von keinem Feld abhängig sind.

Bei der Schablone „Author,·Title‟ wird, wenn nur der Titel 
vorhanden ist, „Performing Symbolic Politics“ ausgegeben. 

Wenn in die Schablone ein weiteres Leerzeichen eingefügt wird 
(Author,··Title), dann wird auch in der Ausgabe ein weiteres 
Leerzeichen erscheinen: „·Performing Symbolic Politics“. Das 
Leerzeichen vor dem Titel wird auch dann ausgegeben, wenn die 
Felder Author und Title leer sind 
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Anders formuliert: Steht ein Zeichen getrennt von der vorherge-
henden und der folgenden Feldangabe durch ein Leerzeichen 
getrennt, so wird dieses Zeichen immer ausgegeben.

Eigenständiger Text erscheint immer in der Litera-
turangabe

Regel 4 Jeder Text, der nicht von einem Feld abhängig ist, wird immer 
ausgegeben. Text ist dann unabhängig, wenn er durch mindes-
tens ein Leerzeichen von Feldbezeichnern getrennt ist.

In folgender Schablone ist das in: unabhängig: „Title.·in:·Journal‟

Daher erscheint es auch, wenn kein Zeitschriftentitel vorhanden 
ist: W. Shakespeare, Performing Symbolic Politics. in:. 

Besondere Formatierungszeichen für Schablonen 
(Templates)

Für mehr Flexibilität und Präzision in deinem Zitierstil stellt 
EndNote besondere Formatierungszeichen zur Verfügung. 



Kapitel 6 – Zitierstile ändern

137

Zusammenhängenden Text verknüpfen (Link Adja-
cent Text)
Wenn du in deinem Zitierstil „Edition·Aufl.‟ eingibst und „Edition‟ 
von der Abkürzung „Aufl.‟ lediglich durch ein normales Leerzei-
chen trennst, dann wird später bei der Ausgabe immer die Abkür-
zung „Aufl.‟ erscheinen, unabhängig davon, ob im Datenbankfeld 
„Edition‟ etwas steht oder nicht.

Um dies zu verhindern, musst du die Abkürzung „Aufl.‟ abhängig 
vom Inhalt des Datenbankfelds „Edition‟ machen. Dies geschieht 
mittels eines „geschützten Leerzeichens‟ (non-breaking space). 
Ein solches Leerzeichen verknüpft zwei Elemente zu einer logi-
schen Einheit. Auf diese Weise wird jeder Text im Zitierstil, der 
an ein bestimmtes Datenbankfeld gekoppelt ist, ausgeblendet, 
sobald das Datenbankfeld leer ist. Ein „geschütztes Leerzeichen‟ 
kannst du in die Schablone (Template) einfügen, indem du unter 
Insert Field auf Link Adjacent Text klickst oder die Tastenkom-
bination Strg+Alt+Leertaste betätigst. Das Leerzeichen 
erscheint als ein kleiner Diamant. In unserem Beispiel würde das 
Ergebnis dann so aussehen: Edition.♦Aufl. 

Das geschützte Leerzeichen wird bei der Ausgabe in ein 
normales Leerzeichen umgewandelt. Die Verwendung dieses 
Zeichens ist besonders in folgenden Fällen sinnvoll:

Edition♦Aufl.

Band♦Volume

Editor♦Hrsg.
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p^pp♦Pages

Automatische Singular/Plural-Erkennung
Im vorigen Abschnitt tauchte im letzten Beispiel das Caret-
Zeichen (^) auf. Dieses Zeichen dient der Unterscheidung von 
Singular- und Plural-Angaben. Einige, insbesondere englisch-
sprachige Zeitschriften, verwenden einen Zitierstil, in dem bei 
bestimmten Angaben zwischen Singular und Plural unter-
schieden wird. So muss beispielsweise bei mehreren Herausge-
bern statt „Ed.‟ für „Editor‟ die Pluralform „Eds.‟ für „Editors‟ 
angegeben werden. Selbiges gilt für die Seitenangabe: „p‟ bzw 
„pp‟.

Mit Hilfe des Caret-Zeichens erkennt EndNote, welche Angabe 
es im Singular und welche im Plural verwenden soll. Dabei ist es 
wichtig zu beachten, dass die Singularform immer vor und die 
Pluralform nach dem Caret-Zeichen stehen muss. Die eingege-
benen Singular/Plural-Formen müssen mittels eines 
„geschützten Leerzeichens‟(♦) an ein Datenbankfeld gekoppelt 
werden.

Dieses Zeichen steht für die Datenbankfelder Author, Secondary 
Author, Tertiary Author, Subsidiary Author, Pages und Cited 
Pages zur Verfügung. 

Erzwungene Trennung
Falls der eingefügte Text nicht vom angrenzenden Feld abhängig 
sein soll (Regel 1), wird der senkrechte Balken ( | ) verwendet, 
um eine Trennung zu erzwingen. Du findest das Zeichen unter 
Insert Fields > Forced Separation, oder auf deiner Tastatur, 
meist neben dem Y.

Beispiele: 

Bei einem Zitat im Fließtext sollen die zitierten Seiten ange-
geben werden: (Müller, 2010: S. 27-29). Vor den Seitenzahlen 
soll ein „S.“ stehen. Das Datenbankfeld für zitierte Seiten hat 
den Feldnamen „Cited Pages“. Im Template des Zitierstils wird 
daher folgendes eingegeben:
(Author,·|Year|,♦S.♦Cited Pages|)
Das Diamantzeichen vor „Cited Pages“ verknüpft das entspre-
chende Datenbankfeld mit „S.“, wobei dieses wiederum über 
ein weiteres Diamantzeichen mit dem davor stehenden 
Komma verknüpft ist. Das hat zur Folge, dass das Komma und 
„S.“ nur dann ausgegeben werden, wenn im Datenbankfeld 
„Cited Pages“ ein Wert eingegeben wird. Die Ausgabe dieser 
Zeichen erfolgt also nur dann, wenn tatsächlich Seitenan-
gaben gemacht werden.
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Soll beispielsweise bei Zeitschriftenaufsätzen die Bandnummer 
durch einen Punkt von der Nummer der Zeitschrift getrennt sein, 
letzteres aber nicht immer vorhanden sein, so wird das im Temp-
late wie folgt dargestellt: Journal·Volume|.Issue|·(Year)

So wird der Punkt nach der Bandnummer abhängig von der 
Nummer der Zeitschrift und das Leerzeichen zwischen Issue und 
(Year) immer ausgegeben (Regel 3).

Referenztypen modifizieren und neue erstellen
EndNote stellt in der Version X4 insgesamt 48 Referenztypen 
(Reference Types) zur Verfügung. Hier ist ein kleiner Ausschnitt:

Zur Erinnerung: Referenztypen (Reference Types) entsprechen 
bestimmten Literaturarten bzw. Dokumenttypen. Importierte bzw. 
manuell eingegebene bibliografische Angaben werden in 
EndNote einem bestimmten Referenztyp zugeordnet. Wie du im 
vorherigen Abschnitt gesehen hast, hängt von dieser Zuordnung 
ab, nach welchen Regeln die aufgenommenen bibliografischen 
Angaben mit Hilfe eines Zitierstils (Output Style) in einem Text-
verarbeitungsprogramm oder direkt aus EndNote ausgegeben 
werden. Im Zitierstil ist nämlich definiert, wie die Inhalte der 
Datenbankfelder bei bestimmten Referenztypen zu ordnen und 
zu formatieren sind.

Einer der 48 Referenztypen hat den Namen „Generic“. 

Dieser Referenztyp hat die maximale Anzahl an ausfüllbaren 
Datenbankfeldern, nämlich 54. In der Grafik siehst du einige 
dieser Felder: 
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Die Bezeichnungen dieser Datenbankfelder (z.B. Author, Secon-
dary Author, Place Published u.a.) sind beim Generic-Refe-
renztyp nicht veränderbar, weil diese Informationen benötigt 
werden, um bibliografische Daten, etwa aus Online-Katalogen 
korrekt einzelnen Datenbankfeldern zuordnen zu können; dies 
unabhängig davon, wie die Datenbankfelder letztlich benannt 
sind. 

Bei den 44 weiteren Referenztypen sind die Datenbankfelder 
entsprechend dem jeweiligen Literatur- bzw. Dokumenttyp 
voreingestellt und benannt. Du findest die Referenztyp-Einstel-
lungen über Edit > Preferences... > Reference Types > Modify 
Reference Types... . Die Benennungen der Datenbankfelder 
sollten grundsätzlich nicht geändert werden, da dies zu Prob-
lemen beim Datenaustausch (z.B. innerhalb einer Forschungs-
gruppe) führen könnte. 

Es gibt aber acht „Custom“-Datenbankfelder, die für eigene 
Zwecke verwendet werden können. So können damit spezielle 
Zusatzinformationen in eigens dafür zugewiesene Datenbank-
felder eingepflegt und bei Bedarf durch Anpassung des Zitierstils 
ausgegeben werden. Damit ein Custom-Feld im Referenzeinga-
befenster angezeigt wird, musst du ihm in den Referenztyp-
Einstellungen einen Datenbankfeldnamen zuweisen. Achte 
darauf, dass die Aktivierung dieses Felds referenztypenabhängig 
ist, so dass die Aktivierung in jedem (gewünschten) Referenztyp 
erfolgen muss. Wenn eine Beschriftung für alle Referenztypen 
gelten soll, muss man auf Apply to all Reference Types nach 
jeder Änderung eines Feldes klicken.
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Drei Referenztypen sind noch leer (Unused1, Unused2 und 
Unused3) und können den eigenen Bedürfnissen entsprechend 
angepasst werden. 

Was man über Referenztypen wissen sollte
• Die Referenztyp-Einstellungen, die du über Edit > Prefe-

rences... > Reference Types > Modify Reference Types...
aufrufen kannst, legen fest, welche Datenbankfelder für den 
jeweiligen Referenztyp verfügbar sind und welche nicht.

• Es gibt 48 unterschiedliche Referenztypen, die jeweils bis zu 
54 Datenbankfelder enthalten können.

• Von den 48 Referenztypen sind alle bis auf den „Generic‟-
Referenztyp modifizierbar.

• In den Referenztyp-Einstellungen lassen sich einzelne Daten-
bankfelder hinzufügen, löschen oder umbenennen. Es können 
auch ganze Referenztypen ein- oder ausgeblendet werden. 
Öffne dazu die Referenztyp-Einstellungen (siehe ersten Stich-
punkt) und setze vor die Bezeichnung des auszublendenden 
Referenztyps einen Punkt, z.B. .Film or Broadcast
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• Der Generic-Referenztyp, der in den Einstellungen immer in 
der linken Spalte angezeigt wird, dient als Orientierungshilfe 
zur Modifikation oder Erstellung von Referenztypen. Achte 
darauf, dass Felder, die für Autoren vorgesehen sind, nur für 
Personennamen verwendet werden können. Das gleiche gilt 
für Seitenangaben. Das hat den Grund, dass manche Daten-
bankfelder bestimmte Regeln für ihre Inhalte haben (siehe 
unten unter Spezielle Datenbankfelder ab Seite 143).

• Änderungen in den Referenztyp-Einstellungen betreffen alle 
EndNote-Datenbanken des am Computer angemeldeten 
Nutzers.

• Solltest du deine EndNote-Datenbank auf einem anderen 
Computer öffnen, dann gelten die Referenztyp-Einstellungen 
des jeweiligen Nutzers des Computers. Du kannst allerdings in 
den Referenztyp-Einstellungen eine Kopie der Referenztyp-
Tabelle exportieren und auf dem neuen Rechner importieren. 

Wie verhalten sich Referenztypen zu Zitierstilen 
(Output Styles), Importfiltern (Import Filters) und 
Verbindungsdateien (Connection Files)?

Zitierstile, Importfilter und Verbindungsdateien enthalten jeweils 
Schablonen (Templates), mittels derer eine referenztypenspezi-
fische Verwendung der Datenbankfelderinhalte möglich ist. Bei 
Zitierstilen geht es darum, die Ausgabe der Datenbankfelderin-
halte in einem Textverarbeitungsprogramm oder direkt aus 
EndNote zu regeln; bei den Importfiltern geht es um die korrekte 
Zuordnung der Daten, die mittels einer Textdatei (mit Datenbank-
feldnamen) in die EndNote-Datenbank importiert werden sollen; 
bei den Verbindungsdateien geht es um die korrekte Zuordnung 
der über die integrierte Online Search gefundenen Daten zu 
entsprechenden Datenbankfeldern.
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Wenn du also an irgendeiner Stelle mit der Ausgabe oder der 
Zuordnung der Daten nicht zufrieden bist, dann musst du 
zunächst die Stelle, an der das Problem auftritt, lokalisieren.

Spezielle Datenbankfelder
Wie bereits erwähnt, gibt es in EndNote 54 Datenbankfelder. 
Jedes Datenbankfeld kann für den jeweiligen Referenztyp 
verwendet werden; auch das Datenbankfeld für den Referenz-
typnamen. Es gibt kaum Beschränkungen für den Text, der in 
diese Datenbankfelder in der Bibliografie eingegeben wird. Aller-
dings gibt es einige Felder, die für bestimmte Funktionen reser-
viert sind. Das hattest du bereits im ersten Kapitel gesehen, als 
es darum ging, mehrere Autoren einzugeben. Bei Autoren gilt, 
dass sie nicht in einer Zeile stehen dürfen, da EndNote sonst 
davon ausgeht, dass es ein und derselbe Autor ist. Folgende 
Datenbankfelder weisen besondere Funktionen auf, so dass du 
bei deren (Um-)Benennung in den Referenztyp-Einstellungen 
aufpassen musst.

Authors Fields Die Datenbankfelder Author, Secondary Author, Tertiary Author 
und Subsidiary Author sind für die Eingabe von Autorennamen 
konfiguriert und sollten nicht für andere Angaben verwendet 
werden. Die eingegebene Information wird andernfalls als Name 
interpretiert und entsprechend formatiert, was zu unerwünschten 
Ergebnissen führen kann (für weitere Hinweise zum Autorenfeld 
siehe Kapitel 1 ab Seite 17).

Title Fields Es gibt insgesamt drei Titel-Felder. Im Generic-Referenztyp 
tragen sie die Namen Title, Secondary Title und Tertiary Title. In 
Abhängigkeit vom Referenztyp werden für diese drei Titel-Felder 
unterschiedliche Bezeichnungen vergeben. So heißen diese drei 
Felder beim Referenztyp Book Section: Chapter Title, Book Title 
und Series Title.

Die Journal Term List, die für die Änderung von Zeitschriften-
namen in formatierten Bibliografien hilfreich ist, funktioniert nur 
dann, wenn folgende Zuordnungen vorgenommen werden:

Journal Article-Referenztyp – Journal-Feld

Journal Article-Referenztyp – Alternate Journal-Feld

Electronic Article-Referenztyp – Periodical Title-Feld

Die Felder Journal/Periodical Title und Alternate Journal entspre-
chen den Feldern Secondary Title bzw. Alternate Title.
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Pages Field Das Feld Pages ist das einzige Datenbankfeld, das die Funktion 
Seitenzahl (Page Numbers) zulässt. Diese Funktion erlaubt die 
automatische Änderung der Seitenzahlanzeige für alle Refe-
renzen, z.B. 192-199 oder 192-99. Außerdem lässt das Feld 
Pages die Verwendung des Caret-Zeichens (^) zu, um automa-
tisch zwischen einer oder mehreren Seiten zu unterscheiden und 
etwa in englischsprachigen Texten entsprechend „p‟ oder „pp‟ 
voranzustellen. Diese Funktion wird in anderen Feldern nicht 
unterstützt.

URL Field Das URL-Feld ist das einzige Feld, das den Inhalt des Daten-
bankfelds nach einer gültigen URL durchsucht. Wenn eine URL-
Adresse existiert, lässt sich in der EndNote-Symbolleiste der 
Button Open Link anklicken.

File Attachments Field Das File Attachments Feld wird dazu benötigt, um den Pfad zu 
den Dateien auf deiner Festplatte anzugeben. Innerhalb einer 
Referenz können mehrere Dateiverknüpfungen eingefügt 
werden. Wenn der Pfad zum Speicherort der Datei korrekt ist und 
die Datei existiert, kann die Datei über den Button Open File in 
der EndNote-Symbolleiste geöffnet werden (zum genauen 
Vorgehen siehe Kapitel 7 Abschnitt Elektronische Dokumente 
verwalten auf Seite 159).

Figure Field In diesem Feld wird eine einzelne Grafik (z.B. Tabelle, Diagramm 
Bild etc.), die für die Nutzung in Microsoft Word vorgesehen ist, 
aufbewahrt. Dieses Feld ist standardmäßig Bestandteil aller 
Referenztypen. Das darauf folgende Caption-Feld kann dazu 
genutzt werden, um die Grafik zu beschreiben.

Im folgenden Video 6.1 siehst du, wie im Harvard-Zitierstil die 
Angabe der Auflage ergänzt wird.



Kapitel 6 – Zitierstile ändern

145

Video 6.1: Harvard-Zitierstil modifizieren

ZUSAMMENFASSUNG In diesem Kapitel hast du gelernt,

 Zitierstile zu importieren, zu modifizieren und neu zu erstellen

 Regeln und Ausnahmen für Schablonen (Templates) anzu-
wenden

 Vorhandene Referenztypen (Reference Types) zu modifi-
zieren und neue zu erstellen

Übung: 

Modifiziere den Zitierstil (Output Style) „Author-Date“ dahinge-
hend, dass die folgenden Zitate wie hier angegeben dargestellt 
werden:

Book:
Bierling, S. G. (2005): Die Außenpolitik der Bundesrepublik 
Deutschland: Normen, Akteure, Entscheidungen. 2. Aufl., 
München, Wien: Oldenbourg.
Journal Article:
Barnett, M und R. Duvall (2005): Power in international politics. 
in: International Organization 59/1: S. 39-75.

Sei dir der vier Abhängigkeitsregeln bewusst und nutze gezielt 
besondere Formatierungszeichen für Schablonen.Teste den 
Zitierstil mit unterschiedlichen Referenzen. 
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Kapitel 7 – Referenzen ergänzen & Dokumente verwalten

LERNZIELE In diesem Kapitel lernst du,

 Lokal gespeicherte Dateien (Grafiken, Texte, Videos etc.) zu 
verwalten

 EndNote für die Recherche nach Volltexten zu nutzen

 Inhalt beschreibende und zur Systematisierung geeignete 
Daten (z.B. aus MindMap) zu importieren

 Referenzen mit Exzerpten, Zitaten und sonstigen Notizen 
(z.B. Signaturen) anzureichern

 Referenzen über fortgeschrittene Gruppierungsfunktionen 
(Smart Groups) zu ordnen

Situation

Bei wissenschaftlichen Forschungsprojekten und gemeinsamen 
Publikationen werden umfangreiche Referenzinformationen 
gesammelt, was zu spezifischen Anforderungen an das Informa-
tionsmanagement führt: Entwicklung eines einheitlichen Begriffs- 
und Erschließungssystems; Integration von eigenen Notizen als 
Ergebnis von Literaturauswertungen; Verwaltung von elektroni-
schen Dokumenten; einfache Ergänzung von Referenzinformati-
onen aus Datenbankrecherchen.

Mit zunehmendem Umfang der gesammelten Referenzdaten 
besteht die Gefahr, dass der Überblick über die gesammelten 
Informationen verloren geht. Gerade in Projekten ist es erforder-
lich, die gesammelten Informationen bzw. ausgewerteten Publi-
kationen in eine systematische Beziehung zu den Fragestel-
lungen und konkreten Themen eines Projektes zu bringen. Von 
zentraler Bedeutung ist deshalb die Abstimmung der verwen-
deten Begrifflichkeiten, dies ist insbesondere notwendig, wenn 
mehrere Fächer mit ihren Spezialbegriffen involviert sind und ein 
einheitliches Schlagwortsystem entwickelt werden soll.

Die dabei entwickelten Begrifflichkeiten können als Grundlage für 
eine automatisierte Zuordnung von Rechercheergebnissen 
dienen und ermöglichen eine arbeitsteilige Bearbeitung.

MindMaps mit EndNote nutzen
In einer Forschungsgruppe arbeiten mehrere Wissenschaftler – 
manchmal interdisziplinär – an sehr spezifischen Fragestel-
lungen. In der Regel baut sich jeder seine eigene Literaturdaten-
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bank auf, die im Idealfall ein Spiegelbild des Erkenntnisinter-
esses und des aktuellen Forschungsstands ist. Mit der 
Mindmapping-Technik lässt sich, wie in Kapitel 3  ab Seite 51 
gezeigt, der Arbeitsstand visualisieren und über entsprechende 
Funktionen mit den Term Lists in EndNote abgleichen. Term 
Lists aus Keywords sind Schlagwortlisten, die in EndNote das 
Verschlagworten von neuen Referenzen erleichtern.

In manchen Forschungsgruppen ist es sinnvoll, eine gemein-
same Literaturdatenbank zu führen, damit Forschungsteilnehmer 
während des Arbeitsprozesses parallel Einsicht in die 
Forschungstätigkeit ihrer Kollegen bekommen können. Konkret 
können dabei neue Perspektiven eingenommen und für die 
eigene Fragestellung nützliche Literatur gefunden werden.

Es empfiehlt sich dabei, dass jeder Forschungsteilnehmer am 
Anfang eine MindMap mit einem von allen genutzten MindMap-
Programm aufbaut. Das anschließende Gruppentreffen sollte 
dazu genutzt werden, um die so entstandenen einzelnen Mind-
Maps zu einer gemeinsamen MindMap zusammenzuführen. Im 
unteren Bild siehst du die Skizze einer zusammengeführten 
MindMap der interdisziplinären Forschungsgruppe „Alter und 
Altern“ mit Teilnehmern aus den Disziplinen Philosophie, Litera-
turwissenschaft und Medizingeschichte“.

Nun sollte an Hand der gemeinsamen MindMap innerhalb der 
Forschungsgruppe über die jeweiligen Themen diskutiert und die 
zugehörigen Schlagwörter festgelegt werden. Nachdem man 
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sich so auf ein bestimmtes Vokabular verständigt hat, kann man 
aus der MindMap eine gemeinsame Term List aus Schlagwörtern 
generieren und in EndNote importieren. Die auf diesem Weg 
erstellte Keyword Term List kann als Grundlage für die weitere 
inhaltliche Erschließung von Dokumenten genutzt werden.

Auch die EndNote-Datenbanken der Projektteilnehmer können 
zu einer Datenbank zusammengeführt werden. Die Projektteil-
nehmer können für ihre Themen Gruppen anlegen und die von 
ihnen eingebrachten Referenzen diesen Gruppen zuordnen. 
Dadurch gewinnt man auch einen Überblick über die in den 
Projektteilbereichen bearbeitete Literatur.

MindMaps und 
Keywords Term Lists 
kombinieren

Viele Mindmapping-Programme bieten die Möglichkeit an, 
verwendete Begriffe als Textdokumente zu exportieren. Diese 
Textdokumente können – nach vorheriger Korrektur der Forma-
tierung – in die jeweiligen Term Lists in EndNote importiert 
werden. Auf diese Weise kannst du deine Term Lists immer auf 
dem neusten Stand halten. Natürlich müssen die einzelnen Refe-
renzen weiterhin verschlagwortet werden (siehe dazu Kapitel 3 
Abschnitt Schlagwörter ändern ab Seite 60). Achte darauf, in der 
Textdatei ein Schlagwort pro Zeile einzugeben (aus mehreren 
Begriffen zusammengesetzte Schlagwörter sind möglich). 
Vergiss nicht, nach dem letzten Begriff in der Liste einen Zeilen-
umbruch einzufügen (Enter-Taste). Speichere die Textdatei im 
Unicode-Format (UTF-8) ab, damit alle Sonderzeichen und 
Umlaute korrekt erkannt werden.
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Öffne nun deine EndNote-Datenbank und klicke unter Tools auf 
Define Term Lists....
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Wähle nun als Term List Keywords aus und klicke auf Import 
List.... Zeilenumbrüche im Textdokument trennen die Begriffe 
automatisch voneinander. Es können aber auch unter „Delimi-
ters“ weitere Trennungszeichen eingestellt werden. 

Nach der Auswahl und dem Import der Textdatei klickst du im 
Fenster Term Lists auf den Reiter Terms. Hier siehst du nun 
neben den bisherigen auch die importierten Schlagwörter. Über-
prüfe sie auf korrekte Schreibweise (insbesondere Umlaute und 
ß). Sollten Umlaute nicht korrekt dargestellt werden, überprüfe 
noch einmal, ob du die Textdatei im Format UTF-8 gespeichert 
hast.

Im folgenden Video 7.1 siehst du den Import von Begriffen aus 
einer MindMap-Datei in eine Keywords-Term List:
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Video 7.1: Import von Begriffen aus einer MindMap-Datei in eine Keywords-Term List

Journals Term Lists 
importieren

Manche Zitierrichtlinien verlangen die Angabe des vollen Zeit-
schriftentitels (z.B. Experimental Cell Research), andere 
wiederum erwarten eine Abkürzung des Zeitschriftentitels (z.B. 
Exp. Cell Res.). Journals Term Lists erleichtern dir die Handha-
bung der Zeitschriftentitel. Sie enthalten Listen von Zeitschriften-
titeln und ihren Abkürzungen. Mit einer ausgefüllten Journals 
Terms List kannst du in wenigen Schritten im jeweiligen Zitierstil 
einstellen, welche Form (vollständig oder abgekürzt) verwendet 
werden soll. Hier ist eine Schritt für Schritt Anleitung zum Import 
der vollständigen Journals Terms List aus einem bestimmten 
Fachgebiet sowie zur entsprechenden Einstellung des Zitierstils:

Schritt 1

Öffne in EndNote unter Tools > Open Term Lists > Journals 
Term List.
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Schritt 2

Du siehst im Reiter Terms eine Übersicht der bisher eingetra-
genen Zeitschriftentitel. Nicht jeder Zeitschriftentitel besitzt eine 
Abkürzung. Markiere die gesamte Liste (Strg+A) und klicke auf 
Delete Term.
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Schritt 3

Öffne nun den Reiter List und klicke auf Import List.

Schritt 4

Öffne den Term Lists Ordner. Er befindet sich bei den EndNote-
Programmdateien (C:\Programme\EndNote X4\Terms Lists)

Wähle daraus das gewünschte Fachgebiet aus (z.B. Medical, 
Economics, Chemical, Law, Humanities etc.) und klicke auf 
Öffnen. Daraufhin werden die Zeitschriftentitel und ihre Abkür-
zungen importiert und die Terms List aktualisiert.

Im Reiter Terms siehst du nun die aktualisierte Liste mit Zeit-
schriftentiteln und ihren Abkürzungen.
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Schritt 5

Schließe das Fenster mit Close. Öffne nun die Einstellungen des 
von dir verwendeten Zitierstils (Output Style) unter Edit > Output 
Styles > Edit „Style“. Im Menüpunkt Journal Names kannst du 
die gewünschten Einstellungen vornehmen. 

Speichere die Änderungen am Zitierstil unter File > Save as...
ab. 
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Referenzen ordnen
In der linken Spalte der EndNote-Programmoberfläche siehst du 
ganz oben drei permanente Gruppen: All References, Unfiled 
und Trash.

• All References zeigt alle Referenzen deiner EndNote-Daten-
bank. Sobald du einen Import von bibliografischen Angaben 
durchführst, landen sie automatisch in dieser Gruppe. 

• Unfiled enthält Referenzen, die du noch keiner Gruppe zuge-
ordnet hast. Diese Gruppe kann genutzt werden, um den 
eigenen Arbeitsprozess zu strukturieren. Sie bietet schnell 
eine Übersicht über die noch keinen Gruppen zugeordneten 
Referenzen.

• Trash enthält die gelöschten Referenzen. Sie bleiben in dieser 
Gruppe, bis die Datenbank geschlossen wird. Danach werden 
sie unwiderbringlich gelöscht.

Bei einer Custom Group (siehe Kapitel 3 ab Seite 51) werden 
Referenzen manuell eingruppiert. Sie eignet sich besonders, um 
den eigenen Arbeitsprozess zu strukturieren, z.B. Einrichtung 
einer Custom Group mit der Bezeichnung „auswerten bis 
31.03.2011“. 

Bei einer Smart Group handelt es sich um eine gespeicherte 
Suchanfrage deiner EndNote-Datenbank. Die Suchbegriffe 
bilden die Grundlage für die automatische Zuordnung von 
vorhandenen und neu importierten Referenzen in diese Gruppe. 
Du kannst zum Beispiel festlegen, dass in einer Smart Group nur 
Referenzen mit einem bestimmten Schlagwort, einem 
bestimmten Zeitschriftentitel oder eines festgelegten Publikati-
onsjahrs enthalten sein sollen. Wenn du also später neue biblio-
grafische Angaben in EndNote importierst, werden die Smart 
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Groups bei Erfüllung der vorgegebenen Bedingungen automa-
tisch um diese Referenzen ergänzt. 

Die importierte Referenz bleibt im „Unfiled‟-Ordner, solange du 
sie nicht manuell einer Custom Group zuordnest. Du kannst über 
einen Rechtsklick auf Unfiled > Include Smart Groups nur 
diejenigen Referenzen anzeigen lassen, die weder einer Custom 
Group noch einer Smart Group zugeordnet wurden. 

Neue Smart Group 
erstellen

Am Besten erstellst du eine neue Smart Group über die Such-
maske. Führe eine Suche innerhalb deiner Datenbank durch und 
klicke dann unter Options auf Convert to Smart Group. Der 
Vorteil eines solchen Vorgehens liegt darin, dass du die Treffer 
vorher sichten und somit die Richtigkeit deiner Suchbegriffe fest-
stellen kannst. Zudem kann man hier mit Strg+1 auf die Term 
Lists der Autoren, Keywords und Journals zurückgreifen.

Weitere Informationen zur Suche innerhalb der EndNote-Daten-
bank findest du in Kapitel 3 im Abschnitt Referenzen in der 
Datenbank finden auf Seite 66.

Die Funktion Smart Group kann als ein nützliches Instrument für 
ein arbeitsteiliges Vorgehen in einer Forschungsgruppe genutzt 
werden, was im Folgenden an einem Beispiel verdeutlicht wird. 

So kann im Rahmen eines interdisziplinären Forschungsprojekts 
zum Thema „Alter und Altern“ mehrere Smart Groups einge-
richtet werden, z.B. für den Projektteilbereich „Philosophie und 
Alter“ eine Smart Group basierend auf einer Suchanfrage mit den 
Schlagwörtern („Ewigkeit“ ODER „Endlichkeit“) UND („Alter“), 
was in der folgenden Grafik veranschaulicht wird:
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Eine zweite Smart Group könnte im Projektteilbereich „Medizin-
geschichte und Alter“ mit den Schlagwörtern („Diagnose“ UND 
„Alter“) eingerichtet werden.

Eine dritte Smart Group im Projektteilbereich „Literaturwissen-
schaft und Alter“ wäre mit den Schlagwörtern („Motiv“ UND 
„Alter“) denkbar.

Der konkrete Nutzen liegt darin, dass auch bei einer unpräzisen 
Freitextsuche in einem Katalog mit dem Suchbegriff „Alter“ allein 
die Ergebnisse, die genau die Suchkriterien der Smart Groups 
erfüllen, automatisch den passenden Gruppen zugeordnet 
werden. Ein weiterer Nutzen könnte darin liegen, dass die so 
entstandene Gruppenstruktur sowohl eine kooperative als auch 
eine eigenverantwortliche Bearbeitung von Referenzen ermög-
licht. Die Referenzen können auch um Notizen oder Dateian-
hänge angereichert und gezielt Literaturlisten für die einzelne 
Gruppe erstellt werden.

Bei Combo Groups handelt es sich um eine Kombination von 
bereits existierenden Gruppen in einer Gruppe. Praktisch ist 
diese Gruppenform dann, wenn du mehrere Gruppen in einer 
Gruppe zusammenfassen oder Schnittmengen aus Gruppen 
bilden möchtest.

Im folgenden Video 7.2 siehst du, wie Smart Groups und Combo 
Groups erstellt werden:
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Video 7.2: Fortgeschrittene Gruppenfunktionen: Smart Groups und Combo Groups

Elektronische Dokumente verwalten

Dateianhänge (File 
Attachments)

Neben den bibliografischen Angaben zu einer Referenz kann 
EndNote auch Volltexte als PDF-Dokumente oder beliebige 
andere Dokumente in der Datenbank (mit-)verwalten. Dabei wird 
die PDF Datei entweder mit „relativem" oder „absolutem" Pfad in 
dem Feld File Attachement gespeichert. 

„Relativ‟ meint, dass eine Kopie des Dateianhangs „relativ‟ zur 
Datenbank (*.enl) im *.Data-Ordner gespeichert wird. Bei diesem 
Vorgang wird die PDF-Datei kopiert. Das Original kann somit 
gelöscht werden. „Absolut‟ meint, dass die Datei am ursprüngli-
chen Ort bestehen bleibt und nur der „absolute‟ Pfad dorthin in 
EndNote vermerkt wird. Nachteil ist, dass sich diese bei einer 
Änderung des Pfades (bspw. beim Umzug mit der Datenbank) 
nicht mehr öffnen lässt.

Standardmäßig erstellt EndNote immer eine Kopie im *.Data-
Ordner der jeweiligen Datenbank. Somit kann das Original der 
Datei gelöscht werden. 

Die Speicherung im *.Data-Ordner zusammen mit der Datenbank 
ist auch sinnvoll, da es beispielsweise die einfache Übertragung 
der Datenbank inklusive aller Anhänge auf andere Computer 
ermöglicht. Wie man eine Datenbank kopiert, erfährst in Kapitel 
8 ab Seite 171. 
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Merke: Für Grafiken und andere Dateien, die du mittels Cite-
While-You-Write in ein Word-Dokument einfügen möchtest, wird 
das Datenbankfeld „Figure“ verwendet.

Um eine Datei mit einer Referenz zu verknüpfen, gehst du wie 
folgt vor:

Schritt 1

Wähle eine Referenz aus deiner Bibliografie aus oder öffne die 
Vollanzeige einer Referenz.

Schritt 2

Wähle unter References > File Attachments > Attach File.

Schritt 3

Wähle nun die Datei aus, die mit der jeweiligen Referenz 
verknüpft werden soll.
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Schritt 4

Im unteren Bereich des Dateiauswahlfensters findest du die 
Option: Copy this file to the default file attachments folder 
and create a relative link. Wird diese Option gewählt, fügt 
EndNote eine Kopie der ausgewählten Originaldatei in den PDF-
Ordner (ein Unterordner des *.Data-Ordners) ein und erstellt 
innerhalb der Referenz einen Link auf die Kopie. Der PDF-
Ordner ist Teil der Bibliografie und wird etwa bei der Erstellung 
einer „Compressed Library“ mitkopiert. Wird die obige Option 
nicht ausgewählt, erstellt EndNote einen Link direkt zur Original-
datei. Dateien, die sich außerhalb des *.Data-Ordners befinden, 
werden bei Backups/Compressed Library nicht berücksichtigt.

Schritt 5

Klicke abschließend auf Open.

EndNote fügt in das Datenbankfeld „File Attachment“ ein Icon 
ein, das Auskunft über das Format der eingefügten Datei gibt.
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In dasselbe Datenbankfeld können weitere Dateiverknüpfungen 
eingefügt werden.

Tipp: Es gibt noch einen einfacheren Weg, Dateiverweise einzu-
fügen. Ziehe eine Datei einfach auf die jeweilige Referenz 
(Drag&Drop). Ob die Datei standardmäßig im DATA-Ordner 
gespeichert oder ob auf das Original verlinkt wird, legst du unter 
Preferences > URLs & Links fest. 
Ab der EndNote-Version X4 können auch die Inhalte der PDFs 
durchsucht werden. Lege hierfür in der Suchmaske als Suchkri-
terium „Any Field + PDF“ oder „PDF“ fest und gib ein Stichwort 
ein. Taucht das Stichwort in einem PDF-Dokument auf, wird die 
entsprechende Referenz als Suchergebnis angezeigt. Die Suche 
innerhalb einer PDF-Datei funktioniert nicht bei PDFs, die aus 
Grafiken erstellt wurden, z.B. eingescannte aber nicht in Text 
umgewandelte Dokumente.

Merke: Du kannst aber auch im Nachhinein direkte Links zur 
Originaldatei in relative Links umwandeln, wobei die angehängte 
Datei dabei in den *.Data-Ordner kopiert wird. Das ist für den Fall 
eines Umzugs der Datenbank auf einen anderen Rechner (z.B. 
über die Funktion Compressed Library) empfehlenswert. Klicke 
dazu in der EndNote-Datenbank mit rechter Maustaste auf die 
entsprechende Referenz und wähle unter File Attachments > 
Convert to Relative Links aus.
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Bildzitat (Attach Figure) Es können nicht nur PDF- und andere Dokumente an eine Refe-
renz angehängt werden, sondern auch Grafiken (z.B. Excel-
Tabellen, Bilder, Diagramme etc.). Diese können im Textverar-
beitungsprogramm eingefügt werden, wobei automatisch ein 
Abbildungsverzeichnis erstellt wird.

Nutze für die Verwaltung von Grafiken die Referenztypen 
„Figure“, „Chart“ oder „Table“. Um eine Grafik an eine Referenz 
anzuhängen, öffne das Referenzeingabefenster (Vollanzeige der 
Referenz) und klicke in der Symbolleiste auf den Button Attach 
Figure.

Wähle dann die Grafik, die angehängt werden soll. Die ange-
hängte Grafik befindet sich im Figure-Feld. Ihr Speicherort ist der 
*.Data-Ordner deiner EndNote-Installationsumgebung. Beim 
Erstellen von Datenbankkopien (z.B. Compressed Library) 
werden auch die Figures mitkopiert. 

Um die Grafik in ein Word-Dokument einzufügen, setzt du den 
Cursor an die entsprechende Stelle und klickst unter Insert Cita-
tion auf Find Figure.
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Nachdem du die Grafik über ein Stichwort (z.B. Autor) gefunden 
hast, klickst du auf Insert.

Die Grafik wird daraufhin in das Dokument eingefügt und ein 
Grafikverzeichnis erstellt. 

Empfehlenswert ist die Nutzung der Attach Figure-Funktion, weil 
man die verwendeten Grafiken und Tabellen an einem zentralen 
Ort, nämlich in der EndNote-Datenbank, verwalten kann. 

Ein Nachteil besteht allerdings darin, dass die eingefügten 
Grafiken nicht dynamisch mit der Datenbank verknüpft sind. 
Änderungen in der jeweiligen Referenz in der Datenbank wirken 
sich daher nicht im Word-Dokument aus. Wenn du mit Grafiken 
arbeiten solltest, die sich regelmäßig ändenr (z.B. Tabellen), soll-
test du die entsprechende Funktion von Microsoft Word nutzen. 
Bei Grafiken, die sich nicht ändern, kannst du EndNote nutzen.
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Volltexte finden
Die Funktion „Find Full Text“ sucht nach Volltexten und lädt diese 
in Abhängigkeit der Zeitschriftlizenz der jeweiligen Organisation 
automatisch herunter. Dazu verwendet EndNote die bibliografi-
schen Angaben der jeweiligen Referenz und führt eine Abfrage 
im Internet durch. Gefundene PDFs werden automatisch mit der 
Referenz verknüpft und im .DATA-Ordner gespeichert. Neben 
der entsprechenden Referenz erscheint ein Büroklammer-
Symbol. Bei der Suche nach Volltexten werden unterschiedliche 
Quellen durchsucht:

• Web of Knowledge Full Text Links

• EndNote Web Services

• DOI (Digital Object Identifier)

• PubMed LinkOut

Folgende Schritte helfen dabei, die Anzahl der gefundenen Voll-
texte zu erhöhen:

Schritt 1

Ob man eine Lizenz für die Nutzung einer Zeitschrift hat, wird 
über die IP-Adresse abgeprüft. Um auf die lizenzierten Zeit-
schriften zugreifen zu können, musst du dich mit deinem 
Computer im Universitätsnetzwerk befinden.

Arbeitest du von zu Hause, ist zuerst eine Verbindung zum Netz-
werk der Universität notwendig, bevor EndNote auf die Volltexte 
zugreifen kann. Viele Universitäten bieten sogenannte VPN-
Zugänge (Virtual Private Network) an, die die Einwahl in das 
Uninetz auch von zu Hause ermöglichen. Erkundige dich gege-
benenfalls bei deinem Rechenzentrum nach einem VPN-
Zugang.

Schritt 2

Gib unter Edit > Preferences > Find Full Text die korrekte 
„OpenURL“- und ggf. eine „Authentication“-Adresse an. Erkun-
dige dich am besten bei deiner Universitätsbibliothek, welche 
Adresse jeweils einzugeben ist (bei der Universitätsbibliothek 
Heidelberg ist dies beispielsweise: http://www.redi-bw.de/links/
unihd). 
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Tipp: Nutze alternativ die WorldCat Registry (http://
www.worldcat.org/registry/Institutions), um die gültige 
OpenURL-Adresse in Erfahrung zu bringen. Gib dort deinen 
Studien- oder Forschungsort ein und sichte die Treffer. Im 
Screenshot siehst du die OpenURL-Angabe der Staatsbibliothek 
zu Berlin.

Schritt 3

Erkundige dich bei deiner Bibliothek, ob diese einen Zugang zu 
Web of Knowledge anbietet. Erstelle gegebenenfalls ein kosten-



Kapitel 7 – Referenzen ergänzen & Dokumente verwalten

167

loses persönliches Konto bei Web of Knowledge. Dies wirkt sich 
positiv auf die Anzahl der Volltexttreffer aus.

Schritt 4

Erstelle ein EndNote Web-Konto (siehe Kapitel 9 ab Seite 185). 
EndNote Web unterstützt EndNote bei der PDF-Suche. Es wird 
ständig mit neuen Informationen aktualisiert, so dass EndNote 
schneller und präziser nach Volltexten suchen kann.

Schritt 5

Überprüfe deine Referenzen darauf, ob die DOI (Digital Object 
Identifier) korrekt eingetragen ist. DOIs kann man mit ISBN/
ISSN-Nummern vergleichen. Mit ihnen kann man bibliografische 
Informationen über elektronische Dateien ermitteln (siehe auch 
http://www.doi.org). EndNote verwendet sie auch, um Volltexte 
ausfindig zu machen. 

Suche nach PDF-
Volltexten

Um eine Suche nach PDF-Volltexten zu starten, wählst du 
zunächst diejenigen Referenzen aus, für die der Volltext gesucht 
werden soll. Verwende die Strg-Taste, um mehrere Referenzen 
auszuwählen. Gehe dann auf References > Find Full Text > 
Find Full Text.... In der Navigationsleiste in EndNote erscheint 
daraufhin in der Gruppe „Find Full Text“ die Untergruppe 
„Searching...“. Referenzen, zu denen PDFs gefunden wurden, 
werden in der Gruppe „Found PDF“ angezeigt; Referenzen, zu 
denen keine PDFs gefunden wurden, siehst du in der Gruppe 
„Not found“. Gefundene PDFs werden automatisch als File 
Attachments angehängt und im *.Data-Ordner gespeichert. In 
der Gruppe „Found URL“ siehst du Referenzen, zu denen keine 
PDF-Volltexte gefunden und angehängt werden konnten, jedoch 
eine URL zu der jeweiligen Arbeit bzw. Informationsquelle ange-
hängt wurde.
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Der Suchvorgang kann je nach Anzahl der ausgewählten Refe-
renzen einige Zeit in Anspruch nehmen. Während der Suche 
kann in EndNote weitergearbeitet werden; die Suche findet im 
Hintergrund weiter statt.

ZUSAMMENFASSUNG In diesem Kapitel hast du gelernt,

 EndNote für die Recherche nach Volltexten zu nutzen

Übung: 

1) Lege zwei Smart Groups zu den Themen („cancer“ UND 
„radiography“) sowie („back pain“ UND „radiography“) an.

2) Optimiere dein EndNote für die Volltextsuche. Folge dabei 
den Hinweisen in diesem Kapitel.

3) Wähle dich über Tools > Online Search... bei PubMed 
(NLM) ein und führe eine Suche nach „radiography“ und 
Publikationsjahr 2010 durch. Achte darauf, dass du dich im 
„Online Search Mode“ befindest. Lass dir die ersten 50 
Treffer anzeigen und importiere diese in deine Datenbank. 
Starte nun eine Volltextprüfung für die importierten Treffer. 
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 Lokal gespeicherte Dateien zu verwalten

 Inhalt beschreibende und zur Systematisierung geeignete 
Daten (z.B. aus MindMap) zu importieren

 Referenzen mit Exzerpten, Zitaten und sonstigen Notizen 
(z.B. Signaturen) anzureichern

 Referenzen über fortgeschrittene Gruppierungsfunktionen 
(Smart Groups) zu ordnen
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Kapitel 8 – Daten austauschen und sichern

LERNZIELE In diesem Kapitel lernst du,

 Grundlagen der EDV-technischen Struktur von EndNote-
Datenbanken kennen

 Funktionen zum Austausch von Referenzinformationen mit 
anderen EndNote-Anwendern zu nutzen

 Datensicherungsfunktionen von EndNote zu nutzen

 Funktionen zum gezielten Datenaustausch mit anderen Litera-
turverwaltungsprogrammen zu nutzen

Situation

Im wissenschaftlichen Arbeitsprozess ist der gegenseitige 
Austausch von erfassten Daten von grundlegender Bedeutung. 
Die Effizienz und der Erfolg von Projekten hängen auch davon 
ab, dass die Mitglieder in Forschungsgruppen ihre Ergebnisse 
schnell und zuverlässig austauschen können. 

Sehr häufig werden Literaturangaben im Rahmen eines 
Forschungsprojekts mit zusätzlichen inhaltlichen Zusammenfas-
sungen, Kommentaren oder direkten Verknüpfungen zu elektro-
nischen Dokumenten angereichert. Abhängig von den jeweiligen 
Anforderungen wird erwartet, dass diese Daten ganz oder teil-
weise zwischen Teilnehmern ausgetauscht werden oder für alle 
zugänglich sind. Dafür bietet EndNote ein breites Funktionsspek-
trum. 

Erstellung von Datenbankkopien

Kopie der Datenbank 
(Save a Copy)

Wie du bereits weißt, werden alle Änderungen an der Datenbank 
automatisch gespeichert, ohne dass man extra auf „Speichern‟ 
oder „Speichern unter...‟ klicken muss. Eine Kopie der EndNote-
Datenbank kannst du erstellen, indem du unter File auf Save a 
Copy klickst. Auf diese Weise wird im angegebenen Speicherort 
eine exakte Kopie der Datenbank mitsamt allen Dateianhängen 
erstellt (ENL-Datei und DATA-Ordner mit allen Dateien und 
Grafiken, siehe auch Was ist eine Datenbank? auf Seite 23).
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Die kopierte Datenbank wird nicht automatisch geöffnet, sondern 
steht einfach als Kopie im gewählten Speicherort zur Verfügung. 
Eine Kopie der Datenbank eignet sich insbesondere als Siche-
rungskopie (z.B. vor Updates oder umfangreichen Bearbei-
tungen der EndNote-Datenbank). Wenn du ein Word-Dokument 
an verschiedenen PCs bearbeitest und dazu immer dieselbe 
EndNote-Datenbank nutzt, kannst du über diese Speicherart 
immer den aktuellen Arbeitsstand über portable Speichermedien 
(z.B. USB-Stick) mitnehmen. 

Komprimierte 
Datenbank (Compressed 
Library)

Für Datensicherung oder Austausch entweder der kompletten 
Datenbank oder einzelner Gruppen eignet sich auch die Funktion 
„Compressed Library“. Im Gegensatz zu einer Kopie der Daten-
bank wird bei der Erstellung einer Compressed Library nur eine 
einzige Datei erstellt, nämlich „Dateiname.enlx‟. Du kannst 
wählen, ob die Anhänge ebenfalls gespeichert werden sollen. 
Die *.enlx-Datei beinhaltet sowohl die *.enl-Datei als auch den 
*.Data-Ordner (mehr dazu findest du im Abschnitt Was ist eine 
Datenbank? auf Seite 23). Da es nur eine einzige Datei ist, kann 
man sie schnell per E-Mail versenden, ohne dass man auf 
externe Programme zum Komprimieren (z.B. im *.zip-Format) 
zurückgreifen muss. 

Man erstellt eine Compressed Library, indem man zunächst

• In der geöffneten Datenbank auf File > Compressed Library 
(.enlx)... klickt.

• Es öffnet sich ein Fenster, in dem man die Speichereinstel-
lungen vornimmt. So ist es möglich, die *.enlx-Datei gleich per 
E-Mail zu versenden, die Datenbank mit oder ohne Anhänge 
zu speichern oder nur Referenzen bestimmter Gruppen in 
einer *.enlx-Datei zu speichern.

• Wenn man auf Next klickt, öffnet sich ein Menü, in dem man 
den Speicherort bestimmen kann.
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Merke: Beim Öffnen einer *.enlx-Datei besteht die Gefahr eine 
existierende Datenbank mit gleichem Namen zu überschreiben! 
Speichere die *.enlx-Datei vor dem Öffnen daher in einem geson-
derten Ordner.

Referenzen aus Word-Dokumenten in eine EndNote-
Datenbank importieren

Bei der Erstellung von Zitaten in Word-Dokumenten mit EndNote 
werden im Hintergrund – in einer „reisenden Bibliothek“ (Trave-
ling Library) – die wichtigsten bibliografischen Informationen 
mitgespeichert. Diese Informationen können weitergenutzt 
werden, etwa für den Reimport in eine EndNote-Datenbank. Dies 
kann sinnvoll sein, um ausschließlich die in einem Word-Doku-
ment (z.B. einem Working Paper oder einer Dissertation) zitierten 
Werke in einer neuen EndNote-Datenbank zu erfassen. Für die 
Zusammenarbeit zwischen Wissenschaftlern kann die Traveling 
Library ebenfalls nützlich sein, da sie die beste und einfachste 
Möglichkeit bietet, Daten mit anderen auszutauschen und 
gemeinsam an einem Dokument zu arbeiten. Sie kann auch als 
ein Rettungsinstrument dienen, wenn die ursprüngliche 
EndNote-Datenbank nicht mehr nutzbar oder nicht mehr zur 
Verfügung steht (z.B. bei Virusbefall, Plattencrash etc.). 

Jeder mit EndNote eingefügte Literaturverweis in Microsoft Word 
stellt eine Feldfunktion dar (siehe Kapitel 4 > Zitieren in Microsoft 
Word ab Seite 79). Diese Feldfunktion enthält als Referenzinfor-
mation im Hintergrund die kompletten Angaben der jeweiligen 
Referenz (außer: Notes, Abstract, Figure oder Caption). 

Hier siehst du zum Verständnis den kompletten Inhalt der Feld-
funktion der Literaturangabe „(Maull: 2004)“. Im unteren Bild 
siehst du zuerst die Ausgabe der Literaturangabe im Output Style 
Harvard.
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Um dir den kompletten Inhalt der Feldfunktion anzeigen zu 
lassen, markiere zunächst die Feldfunktion (in unserem Fall: 
„(Maull, 2001)“) klicke dann auf die rechte Maustaste und wähle 
Feldfunktion ein/aus (Achtung: Dies funktioniert nicht bei einge-
schalteter Hyperlink-Funktion und wenn die Angaben innerhalb 
der Feldfunktion zu umfangreich sind, beispielsweise bei zwei 
Zitaten).

Du siehst nun die Rohdaten der Feldfunktion (Traveling Library). 
Darin siehst du auch Informationen, die vorher weder im Fließtext 
noch im Literaturverzeichnis zu sehen waren, wie z.B. die Seiten-
angabe. Diese Informationen wurden auf Grund des gewählten 
Zitierstils nicht ausgegeben.

Diese Angaben befinden sich im Hintergrund des Word-Doku-
ments. Wie du siehst, enthalten diese Angaben den Titel „Außen-
politische Kultur“, obwohl er an dieser Stelle im Word-Dokument 
nicht angezeigt wird. Alle Angaben sind nach Regeln in Anleh-
nung an XML formatiert, z.B. <title>Titelangabe</title>. Du 
kannst und solltest nicht in diesen Quellcode eingreifen. Diese 
Erläuterungen dienen nur dem Verständnis, wie EndNote mit 
Textverarbeitungsprogrammen arbeitet.
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Merke: Die Traveling Library enthält keine Notizen, Abstracts, 
Figures oder Captions.

Wenn du die Daten eines Kollegen in die eigene EndNote-Daten-
bank importieren möchtest oder wenn du bibliografische 
Angaben in einem Word-Dokument korrigieren willst, die du aber 
nicht selbst eingefügt hast und sie deshalb nicht in deiner 
EndNote-Datenbank enthalten sind, kannst du die Referenzen 
aus dem Word-Dokument über die Traveling Library in deine 
EndNote-Datenbank importieren. Dazu musst du folgendes 
machen:

• Öffne ein Word-Dokument mit formatierten Literaturverweisen 
(Feldfunktionen)

• Word 2003: Gehe im Menü Extras auf EndNote X4 und wähle 
Export Traveling Library aus.

• Word 2007 und 2010: Gehe in der EndNote-Symbolleiste in 
der Gruppe Tools auf Export to EndNote und klicke dann auf 
Export Traveling Library. 

• Es öffnet sich ein Fenster, in dem du den Speicherort für die 
Referenzen auswählen kannst. Du kannst entweder eine 
vorhandene Datenbank nutzen oder eine neue erstellen 
lassen.

Merke: Empfehlenswert ist ein Import in eine neue Datenbank. 
Auf diese Weise kannst du die Referenzen noch einmal über-
prüfen, ehe du sie in eine vorhandene Datenbank importierst. 

Im folgenden Video 8.1 siehst du, wie aus einem Word-Doku-
ment, das mit EndNote erstellte Zitate enthält, eine neue 
EndNote-Datenbank generiert wird. Aus dieser Datenbank 
werden ausgewählte Referenzen im RIS-Format exportiert und 
per E-Mail versandt. 
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Video 8.1: Aus einem Word-Dokument, welches mit EndNote erstellte Zitate enthält, 

eine neue EndNote-Datenbank generieren

Mit EndNote erstellte Word-Dokumente in andere 
Textverarbeitungsprogramme übertragen

Wenn das Word-Dokument mit einer neueren Version (Word 
2003, 2007 und 2010) erstellt wurde und auf einem Rechner mit 
einer älteren Version (oder mit einem anderen Textverarbei-
tungsprogramm wie Open Office) verwendet werden soll, musst 
du in folgenden Schritten vorgehen.

Klicke auf Convert to Unformatted Citations. Dadurch wird die 
Referenz in reinen Text umgewandelt, der von jedem Textverar-
beitungsprogramm erkannt wird. Dies ist bei Feldfunktionen nicht 
der Fall.

Merke: Führe den Befehl Convert to Unformatted Citations
nur dann aus, wenn du dazugehörige Referenzen in deiner 
EndNote-Datenbank hast. Beim Ausführen des Befehls Convert 
to Unformatted Citations wird die Information aus der Traveling 
Library gelöscht und kann nur durch entsprechende Angaben 
aus der EndNote-Datenbank zurückgeholt werden.
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Nach dem Speichern des Dokuments im gewünschten Word-/
Open Office-Format werden die Literaturverweise mit dem 
gewählten Output Style wieder formatiert. Nutze dazu den Befehl 
Update Citations and Bibliography in der EndNote-Symbol-
leiste.

Bei diesem Vorgang sucht EndNote in der geöffneten Datenbank 
nach bibliografischen Angaben des Literaturverweises und über-
trägt sie in das Word-Dokument, genauer gesagt, wird mit Hilfe 
dieser bibliografischen Informationen die Traveling Library des 
jeweiligen Zitats generiert.

Abgleich der Zitierstile Beachte außerdem, dass bei jeder Aktualisierung bzw. Neufor-
matierung eines Dokuments auf den jeweils verwendeten Zitier-
stil zugegriffen wird. Soll die Darstellung der Zitate beibehalten 
werden, muss der bei der ursprünglichen Erstellung der Zitate 
verwendete Zitierstil installiert und aktiviert sein. Andernfalls 
werden die Zitate mit einem anderen Zitierstil umformatiert oder 
unformatiert mit aufgelösten Feldfunktionen (siehe oben) darge-
stellt. Hier ist eine vorherige Absprache innerhalb der 
Forschungsgruppe erforderlich. 

Den Speicherort für zusätzliche (z.B. selbst erstellte) Zitierstile 
findest du in EndNote unter Edit > Preferences > Folder Loca-
tions > Style Folder. Der Zitierstil wird installiert, indem du die 
Zitierstildatei (Endung: *.ens) in den entsprechenden Ordner 
kopierst. Weitere Informationen zur Aktivierung und Modifikation 
von Zitierstilen findest du im Anhang unter Custom Installation ab 
Seite 199 und in Kapitel 6 ab Seite 123.
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Einzelne Referenzen zwischen EndNote-Datenbanken 
austauschen

Um bestimmte Referenzen auf einem Rechner zwischen zwei 
EndNote-Datenbanken auszutauschen, gehst du am besten 
folgendermaßen vor. 

Schritt 1

Öffne die beiden EndNote-Datenbanken und platziere sie neben-
einander.

Schritt 2

Markiere nun die Referenzen, die du übertragen möchtest. Nutze 
zur Markierung mehrerer Referenzen die gedrückte Strg-Taste. 
Klicke auf eine markierte Referenz und ziehe mit gedrückter 
Maustaste die Referenzen in die andere Datenbank. Du kannst 
die Referenzen dabei gleich der passenden Gruppe zuordnen, 
indem du sie in die entsprechende Custom Group verschiebst. 
Der Kopiervorgang ist abgeschlossen, sobald du die Maustaste 
loslässt.
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Tipp: Alternativ kannst du Referenzen auch über Copy&Paste
oder Cut&Paste von einer Datenbank in die andere übertragen.

EndNote-Datenbanken in einem lokalen Netzwerk nutzen
EndNote-Datenbanken können als gemeinsame Quelle 
beispielsweise für ein Team auf einem gemeinsamen Laufwerk 
abgelegt werden. Dazu ist es notwendig, einen Schreibschutz zu 
setzen (read-only oder locked Status). Dies bedeutet, dass man 
bei gemeinsamer Nutzung nur lesend auf eine EndNote-Daten-
bank zugreifen kann. Auf diese Weise sind alle Funktionen 
möglich, die die Datenbank nicht verändern, z.B. Recherchen 
durchführen und Zitate in Word-Dokumente übernehmen. Ein 
gemeinsamer Lese- und Schreibzugriff ist über EndNote nicht 
möglich.

Um eine EndNote-Bibliografie mit dem Status „schreibgeschützt‟ 
zu versehen, muss man im Windows Explorer (Mac: Finder) auf 
Eigenschaften der EndNote-Datenbank und des zugehörigen 
DATA-Ordners klicken und die Einstellungen jeweils auf 
„schreibgeschützt‟ setzen. Möglicherweise musst du dich hierfür 
mit dem Systemadministrator in Verbindung setzen.
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Tipp: Für Forschungsgruppen empfiehlt es sich, einer oder zwei 
Personen die Pflege der Datenbank zu übertragen. Die Literatur-
datenbank bleibt dadurch einheitlich und strukturiert. Die 
Vergabe bzw. Aufnahme neuer Schlagwörter obliegt dann den 
jeweiligen Administratoren der Datenbank. Hierfür eignen sich 
Schlagwörter-MindMaps (siehe Kapitel 3 ab Seite 51), die in peri-
odischen Abständen innerhalb der Forschungsgruppe abgegli-
chen werden und in eine gemeinsame MindMap importiert 
werden können. Auf diese Weise hält man nicht nur die Term List 
der EndNote-Datenbank up-to-date, sondern man kann in der 
Forschungsgruppe gleichzeitig anhand der MindMap seine 
jeweilige Forschungsrichtung besprechen.

Für die Pflege der Referenzen empfiehlt sich die Nutzung einer 
schreibgeschützten gemeinsamen EndNote-Datenbank, die der 
Datenbank-Administrator in regelmäßigen Abständen aktuali-
siert. Der Administrator kann über eine Suche in der EndNote-
Datenbank des jeweiligen Forschungsgruppenteilnehmers die 
seit dem letzten Update aktualisierten Referenzen aufrufen, in 
die gemeinsame EndNote-Datenbank importieren und anhand 
der MindMap verschlagworten.
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Datenaustausch mit anderen Literaturverwaltungspro-
grammen

Wenn du bestimmte Referenzen oder die gesamte EndNote-
Datenbank mit jemandem teilen möchtest, der statt EndNote ein 
anderes Literaturverwaltungsprogramm besitzt, gehst du folgen-
dermaßen vor.

Schritt 1

Exportiere ausgewählte Referenzen oder die gesamte Daten-
bank im RIS-Format. Öffne dazu über File > Export... das 
Exportfenster.

Schritt 2

Gib den Dateinamen ein und wähle als Exportformat unter 
Output Style RefMan (RIS) Export aus. Klicke dann auf Spei-
chern.
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Schritt 3

Öffne das jeweilige Literaturverwaltungsprogramm. Folge den 
programmspezifischen Anweisungen für den Import bibliografi-
scher Daten. Achte dabei darauf, als Importfilter/-format RIS 
anzugeben.

ZUSAMMENFASSUNG In diesem Kapitel hast du gelernt, 

 Wie EndNote-Datenbanken EDV-technisch strukturiert sind

 Funktionen zum Austausch von Referenzinformationen mit 
anderen EndNote-Anwendern zu nutzen

 Datensicherungsfunktionen von EndNote zu nutzen

Übung: 

1) Öffne ein Word-Dokument, in dem du bereits Literaturver-
weise mit Hilfe von EndNote eingefügt hast. Exportiere die 
„Traveling Library“ und importiere sie in eine neue EndNote-
Datenbank.

2) Exportiere aus einer vorhandenen EndNote-Datenbank 
bibliografische Daten im RIS-Format. 

3) Importiere die im RIS-Format exportierte Datei in die über 
die Traveling Library erstellte Datenbank.



Kapitel 8 – Daten austauschen und sichern

183

 Funktionen zum gezielten Datenaustausch mit anderen Litera-
turverwaltungsprogrammen zu nutzen



Kapitel 8 – Daten austauschen und sichern

184



Kapitel 9 – Kollaborative Datennutzung mit Endnote Web

185

Kapitel 9 – Kollaborative Datennutzung mit Endnote Web

LERNZIELE In diesem Kapitel lernst du,

 EndNote Web allein und mit anderen zu nutzen

 Lokale Daten in deine EndNote Web Datenbank zu impor-
tieren

 Zugriffsrechte für Gruppen zu vergeben

 EndNote Web mit Microsoft Word zu nutzen

Situation

Wissenschaftler und teilweise auch Studierende bearbeiten 
häufig ein gemeinsames Projekt. Räumliche Distanzen werden 
dabei über das Internet überbrückt. Viel Zeit lässt sich sparen, 
wenn man gemeinsam Informationen erstellen und nutzen kann. 
Aber Studierende und Wissenschaftler sind häufig in mehreren 
Gruppen mit unterschiedlichen Funktionen beteiligt. 

Vor diesem Hintergrund ist es wichtig, dass der Zugriff auf 
gemeinsame Literaturdaten differenziert gesteuert werden kann. 
Es ist nicht sinnvoll und rechtlich problematisch, wenn ein Litera-
turverzeichnis zur „Direkten Demokratie in Deutschland“ in einem 
politikwissenschaftlichen Projektseminar erstellt wird und über 
ein Gruppenmitglied für Studierende anderer Seminare zugäng-
lich wäre. Sowohl aus rechtlichen als auch zeitökonomischen 
Gründen ist es deshalb sinnvoll, dass die Kollaboration steuerbar 
ist. Hier bietet EndNote Web umfangreiche Funktionalitäten, die 
das lokale, PC-basierte EndNote in sinnvoller Weise ergänzen.

Gründe für EndNote Web
Es gibt viele Gründe, die für die Nutzung von EndNote Web spre-
chen. Nicht immer lässt sich ein lokales Netzwerk einrichten, 
manchmal arbeiten die Forschungsgruppenteilnehmer in 
verschiedenen Städten oder müssen viel verreisen. Um auch in 
diesen Fällen die Zusammenarbeit zu gewährleisten, gibt es den 
webbasierten, und dadurch überall verfügbaren Service EndNote 
Web. ISI Web of Knowledge, EndNote und EndNote Web sind so 
konzipiert, dass sie für eine optimierte Forschungstätigkeit 
nahtlos verwendet werden können.

EndNote Web ermöglicht Folgendes:

• Schnelles und leichtes Erfassen von bibliografischen Angaben 
aus verschiedensten Onlinedatenquellen wie PubMed und ISI 
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Web of Knowledge mittels Direktexport, Onlinesuche oder 
Importieren von Textdateien 

• Speichern von bis zu 10.000 Verweisen in einer eigenen kenn-
wortgeschützten Literaturdatenbank, auf die du an jedem 
Computer mit Internetzugang zugreifen kannst

• Gemeinsame Nutzung von Referenzen mit anderen EndNote 
Web-Benutzern zur Vereinfachung der Zusammenarbeit 
(Shared Folders mit gemeinsamem Lese- und Schreibzugriff)

• Leichtes Übertragen von Referenzen in oder aus EndNote-
Desktop

• Toolbar, mit der Webseiten und Referenzen von Webseiten in 
EndNote und EndNote Web per Klick übernommen werden 
können

• Cite While You Write in Microsoft Word zum sofortigen 
Einfügen und Formatieren von Arbeiten

Nachteile von EndNote Web sind die geringere Performanz, 
weniger Funktionen als in der Desktop-Version von EndNote 
(z.B. Find Full Text, PDF Search, DOI usw.) sowie die Speiche-
rung der Daten in den USA (Datenschutzbestimmungen).

Merke: EndNote Web unterstützt in der aktuellen Version nur 
das Hochladen von Metadaten, jedoch nicht von angehängten 
Volltexten (z.B. als PDF).

Registrierung und Installation

Registrierung Bei jeder EndNote-Desktop-Version ist eine kostenlose Zweijah-
reslizenz für die Nutzung von EndNote Web inklusive. Um 
EndNote Web nutzen zu können, musst du dich zunächst regist-
rieren. Hierzu klickst du auf der Seite http://www.myendno-
teweb.com auf den Link Sign Up. Nach der Registrierung 
erhältst du eine eigene kennwortgeschützte EndNote Web-
Datenbank. 

Solltest du bereits beim ISI Web of Knowledge angemeldet sein, 
ist eine Registrierung in EndNote Web nicht mehr erforderlich; 
melde dich mit den selben Anmeldedaten an. 
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Installation von 
Symbolleisten

Um aus EndNote Web in Microsoft Word zitieren zu können, 
benötigst du einige Upgrades, die du unter Download Installers
herunterladen kannst.  

Um die EndNote Web-Symbolleiste in Microsoft Word (Cite While 
You Write) zu aktivieren, klickst du in der EndNote-Symbolleiste 
auf Preferences und wählst in der Registerkarte Application
aus dem Dropdownmenü EndNote Web aus. Auf diese Weise 
kannst du zwischen beiden Symbolleisten wechseln. 
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Sobald du dich nach der Registrierung zum ersten Mal in 
EndNote Web einloggst, erhältst du Zugriff auf das Handbuch 
„Getting Started with EndNote Web“. In drei übersichtlichen 
Abschnitten wird erklärt, wie du mit EndNote Web Referenzen 
sammeln, ordnen und formatieren kannst. Das Handbuch lässt 
sich über den Link Show/Hide Getting Started Guide ein- und 
ausklappen. 

Sammeln von Referenzen

Export aus Web of 
Knowledge

Besonders komfortabel ist die Nutzung von EndNote Web in 
Kombination mit ISI Web of Knowledge. Passende Suchergeb-
nisse kannst du über einen Klick auf Save to EndNote Web
direkt in deiner EndNote Web-Datenbank abspeichern. (Über 
einen Klick auf Save to EndNote werden die Treffer in die 
Desktop-Version übertragen) 
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Falls eines der Suchergebnisse bereits in deiner EndNote Web-
Datenbank vorhanden sein sollte, wird dies in ISI Web of Know-
ledge mit einem EndNote Web-Symbol neben dem jeweiligen 
Treffer kenntlich gemacht.

Onlinesuche Du kannst aber auch direkt in EndNote Web nach Literatur 
suchen. Klicke dazu auf die Registerkarte Collect und anschlie-
ßend auf Online Search. EndNote Web unterstützt die Suche in 
ISI Web of Knowledge-Produkten, PubMed und vielen anderen 
Bibliothekskatalogen und bibliografischen Onlinedatenbanken.
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Manuelles Hinzufügen 
von Referenzen

Referenzen können in EndNote Web auch manuell eingegeben 
werden. Zur Eingabemaske gelangst du über Collect > New 
Reference. Achte dabei auf die Eingaberegeln! (siehe Kapitel 1 
ab Seite 17)

Importieren von 
Referenzen

Darüber hinaus unterstützt EndNote Web den Import von Refe-
renzen mittels einer Textdatei. Klicke dazu auf Collect > Import 
References und wähle die Textdatei sowie den passenden 
Importfilter. Um den Import durchzuführen, klicke anschließend 
auf die Schaltfläche Import.

Referenzen ordnen und mit anderen gemeinsam nutzen

Meine Referenzen (My 
References)

In der Registerkarte My References findest du deine EndNote 
Web-Datenbank. Links oben ist ein Navigationsfenster, mit dem 
du auf eigene Gruppen (My References) und gegebenenfalls auf 
Gruppen, die andere EndNote Web-Nutzer dir freigegeben 
haben (Groups Shared by Others), zugreifen kannst. 
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Die Referenzen innerhalb deiner Datenbank lassen sich alpha-
betisch oder chronologisch sortieren. Klicke dazu auf den Titel 
der jeweiligen Spalte.

Wenn du eine Referenz editieren möchtest, klickst du auf den 
Titel, um zur editierbaren Vollanzeige der Referenz zu gelangen. 

Referenzen werden bestimmten Gruppen zugeordnet, indem 
man neben dem Autor das Kontrollkästchen aktiviert und aus 
dem Dropdownmenü Add to group eine passende Gruppe 
auswählt. Eine Referenz kann in mehreren Gruppen enthalten 
sein. 

Ordnen und 
Zugangsrechte 
verwalten

In der Registerkarte „Organize“ kannst du eigene Gruppen (bis 
zu 500) erstellen, löschen, umbenennen und mit anderen 
EndNote Web-Anwendern gemeinsam nutzen. 

Soll der Inhalt einer bestimmten Gruppe mit anderen EndNote 
Web-Anwendern genutzt werden, aktiviert man unter Organize > 
Manage My Groups neben der entsprechenden Gruppe das 
Kontrollkästchen. Daraufhin erscheint neben dem Gruppen-
namen ein Symbol. 



Kapitel 9 – Kollaborative Datennutzung mit Endnote Web

192

Als nächstes klickst du auf die Schaltfläche Manage Sharing
und dann auf Start Sharing this Group. Es öffnet sich ein 
Fenster, in dem du Zugriffsrechte („Read only“ oder „Read & 
Write“) an Nutzer anhand ihrer E-Mail-Adressen vergeben 
kannst. Zugriffsrechte können nachträglich geändert werden. 

Im folgenden Video 9.1 siehst du, wie neue Ordner erstellt und 
Zugangsrechte für mehrere Personen (Arbeitsgruppe) vergeben 
werden.

Video 9.1: Neue Ordner erstellen und Zugangsrechte für mehrere Personen (Arbeits-

gruppe) vergeben
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Doppelte Einträge Unter Organize > Find Duplicates kann die EndNote Web-
Datenbank nach doppelten Einträgen durchsucht werden. Dabei 
werden die Felder Author, Year, Title und Reference Type mitei-
nander verglichen. 

Um die Einheitlichkeit der Einträge zu gewährleisten und 
doppelten Einträgen vorzubeugen, empfiehlt sich die Übertra-
gung der Pflege der EndNote Web-Datenbank an ein 
Forschungsgruppenmitglied.

Cite While You Write in Microsoft Word
Das Plugin „EndNote Web Cite While You Write“ wird zum sofor-
tigen Einfügen von Referenzen und Formatieren von Zitaten und 
Quellenverzeichnissen in Microsoft Word verwendet. 

Bevor du Referenzen einfügen kannst, musst du im EndNote 
Web eingeloggt sein. Du kannst dich entweder von EndNote aus 
einloggen oder indem du in Microsoft Word auf EndNote Web in 
der Symbolleiste klickst und deine Log-In Daten eingibst.

Das Zitieren aus der EndNote Web-Datenbank in Microsoft Word 
funktioniert genauso wie mit der Desktop-Version von EndNote. 
Siehe dazu Kapitel 4 Abschnitt Zitieren in Microsoft Word ab 
Seite 79.

Verwendung von EndNote Web und EndNote-Desktop
Dokumente, die du mit Hilfe von EndNote Web erstellt hast, sind 
auch mit EndNote-Desktop kompatibel. So kannst du beispiels-
weise ein Dokument mit EndNote-Desktop beginnen und Refe-
renzen aus deiner EndNote Web-Datenbank hinzufügen; dabei 
werden sowohl die Referenzen als auch das Literaturverzeichnis 
sofort formatiert und aktualisiert. 

Auch lassen sich in wenigen Schritten Referenzen zwischen 
EndNote Web und EndNote-Desktop austauschen. Klicke dazu 
in EndNote-Desktop unter Tools auf EndNote Web. Wenn du 
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noch nicht eingeloggt bist, erscheint ein Anmeldefenster. Nach 
erfolgreicher Anmeldung erscheint das Fenster „EndNote Web 
Transfer References“, in dem du die Richtung des Transfers 
(EndNote > EndNote Web oder EndNote Web > EndNote) so wie 
die Auswahl der zu übertragenden Gruppe bestimmen kannst. 
Es können bis zu 10.000 Referenzen gleichzeitig übertragen 
werden.

Unter Web Library Info erhältst du eine kurze Information 
darüber, wie viele Referenzen sich in deiner EndNote Web-
Datenbank befinden. Du kannst in deine EndNote Web-Daten-
bank bis zu 10.000 Referenzen aufnehmen.

Tipp: Weitere Informationen zur Verwendung von EndNote Web 
findest du auf der Seite http://start.endnote.de.

Übung: 

1) Erstelle in EndNote Web Gruppen, die du auch schon in 
deiner EndNote-Datenbank (in EndNote Desktop) hast und 
übertrage aus EndNote heraus die entsprechenden Refe-
renzen in die neu erstellten Gruppen. 

2) Gib eine der Gruppen für die gemeinsame Nutzung frei. Du 
kannst dafür eine fiktive E-Mail verwenden.

3) Aktiviere in Microsoft Word das Tool „EndNote Web Cite 
While You Write“ und füge eine Referenz aus deiner 
EndNote Web-Datenbank ein. Ergänze diese um eine 
Seitenangabe und um eine weitere Referenz. 
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ZUSAMMENFASSUNG In diesem Kapitel hast du gelernt, 

 EndNote Web allein und mit anderen zu nutzen

 Deine EndNote Web Datenbank mit lokalen Daten abzuglei-
chen

 Zugriffsrechte für Gruppen zu vergeben

 EndNote Web mit Microsoft Word zu nutzen
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Support und weitere Informationsmaterialien

Wo gibt es weitere Informationen?
Ein ausführliches englischsprachiges Handbuch zu EndNote X4 
(Windows und Mac) findest du unter http://www.endnotestart.de
> Handbuch

Über diese Website gelangst du außerdem zu den häufigsten 
Fragen zu EndNote und ihren Antworten (FAQs), zu einem 
Shortcut-Poster mit den wichtigsten Tastaturkürzeln zur schnel-
leren Benutzung von EndNote und zu weiteren Schulungs- und 
Informationsmaterialien.

Für noch offene Fragen steht dir der Support unter der Telefon-
nummer +49 (0)69 970 841 15 oder per E-Mail unter 
support@adeptscience.de gerne zur Verfügung.

Informationen: http://www.endnotestart.de

Support: http://support.endnote.de

Training: http://training.endnote.de

Updates: http://www.endnote.de/update
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Anhang

Custom Installation
Die aktuellsten und ausführlicheren Installations- und Konfigura-
tionsanleitungen für Windows und Mac findest du auf den 
folgenden Seiten http://www.endnote.de/InstWin bzw. http://
www.endnote.de/InstMacI. 

Du kannst bereits bei der Installation die für dein Fachgebiet rele-
vanten Zitierstile installieren, wenn du als Installationstyp 
„Custom“ wählst.

Klappe dazu im nächsten Schritt über das Pluszeichen den 
Menüpunkt Additional Styles auf und wähle dein Fachgebiet 
aus. Klicke dann im entsprechenden Dropdown-Menü auf Entire 
feature will be installed on local hard drive.
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Achte bei einer Custom Installation darauf, unter Additional 
Styles die Stile Export und Generic zu installieren.

Auch die Menüpunkte Additional Connections und Additional 
Filters müssen bei einer Custom Installation manuell installiert 
werden. Hier muss das Menü nicht aufgeklappt werden, sondern 
es können alle Connections und Filters installiert werden.

Merke: Zusätzliche Styles, Filters und Connections können auch 
nachträglich installiert werden. Schließe dazu EndNote und rufe 
über Systemsteuerung > Software > EndNote > Ändern
folgendes Menü auf und verfahre dann, wie in den vorherigen 
Screenshots beschrieben.
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Zusätzliche Reference Types

Zusätzliche Reference Types:

Datenbank Aggregated Database

Historischer Text Ancient Text

Kunstwerk Artwork

Audiovisuelle Medien(z.B. 
Film, Video, DVD, CD, Tonkas-
sette)

Audiovisual Material

Gesetzesentwurf, Gesetz Bill

Blog Blog

Rechtsfall, Klage, Prozessun-
terlagen

Case 

Katalog Catalog

Grafik, Tabelle, Diagramm Chart or Table

Altsprachliches, klassisches 
Werk

Classical Work

Computerprogramm Computer Program

Konferenzbeitrag Conference Paper

Konferenzveröffentlichungen Conference Proceedings

Datensammlung Dataset

Elektronischer Aufsatz Electronic Article

Elektronisches Buch Electronic Book

Beitrag in einem elektroni-
schem Sammelband/Aufsatz-
sammlung

Electronic Book Section

Gleichung, Vergleich Equation

Bild, Abbildung Figure

Film, Rundfunksendung Film or Broadcast

Amtsdruckschrift (Veröffentli-
chungen von Regierungen und 
amtlichen Stellen)

Government Document

Bewilligungsschreiben, Verlei-
hungsschreiben

Grant

Verhör Hearing

Gesetz, Verordnung Legal Rule or Regulation
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Datenbankfelder und entsprechende Syntaxregeln
In der folgenden Auflistung siehst du einige wichtige Datenbank-
felder sowie die entsprechenden Syntaxregeln für die Eingabe 
von bibliografischen Informationen. Achte bei den Syntaxregeln 
vor allem auf Reihenfolge und Interpunktion. Unter „Verände-
rungen durch EndNote“ siehst du, ob in den Zitierstileinstel-
lungen (Edit > Output Styles > Edit Output Style…) die 
Ausgabe des Datenbankfeldinhalts zentral verändert werden 
kann. 

Author Bezeichnung. in RefType “Book”: Author

Syntaxregeln (Empfehlung): Nachname, Vorname 

Organisationsname, 

→ ein Name pro Zeile

Veränderung durch EndNote: Ja – Abkürzung der Vornamen; bei 
mehreren Autoren Abkürzung mit “et al.” o.a.

Year Bezeichnung. in RefType “Book”: Year

Artikel in einer Zeitung Magazine Article

Online-Datenbank Online Database

Online-Medienkombinati-
onen(= Werke aus mehreren 
Medien bestehen, z.B. Text, 
Grafik, Audio, Video, Anima-
tion)

Online Multimedia

Pamphlet, Prospekt, 
Broschüre

Pamphlet

Patent Patent

Persönliche Mitteilung Personal Communication

Bericht, Rapport, Rechen-
schaftsbericht, Referat

Report

Veröffentlichungsreihe, Serie Serial

Norm Standard

Statuten, Gesetzesvorschriften Statue

Dissertation, Hochschulschrift Thesis

Unveröffentlichtes Werk Unpublished Work

Zusätzliche Reference Types:
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Syntaxregeln (Empfehlung): 2010, in print

Veränderung durch EndNote: Nein

Title Bezeichnung. in RefType “Book”: Title

Syntaxregeln (Empfehlung): Titel ohne manuelle Zeilenum-
brüche eingeben, keinen Punkt am Ende setzen

Veränderung durch EndNote: Ja – z.B. Titelausgabe in Groß-
buchstaben

Secondary Author Bezeichnung. in RefType “Book”: Editor

Syntaxregeln (Empfehlung): wie „Author“

Veränderung durch EndNote: Ja

Place published Bezeichnung. in RefType “Book”: City

Syntaxregeln (Empfehlung): Achte auf Einheitlichkeit

Veränderung durch EndNote: Nein

Pages Bezeichnung. in RefType “Book”: Pages

Syntaxregeln (Empfehlung): 1443-1449 oder 1442-9

Veränderung durch EndNote: Ja – entweder ausgeschrieben, 
abgekürzt oder erste Seitenzahl

Edition Bezeichnung. in RefType “Book”: Edition

Syntaxregeln (Empfehlung): Achte auf Einheitlichkeit und 
Kongruenz mit dem Zitierstil

Veränderung durch EndNote: Nein
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Zugangsrechte verwalten ....................... 191
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